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 Posting Incoming Invoices Without Invoice 
Verification 
Purpose 
In this process, we demonstrate both standard and fast entry of simple vendor invoices that have 
no PO relationships, together with the offsetting entry to a cost center. At the end of the posting 
procedure, you see how the invoices automatically update the general ledger, accounts payable 
and cost center accounting. 

 
The integration demonstrated in this process, is not exclusive to Financial 
Accounting (FI). You would achieve the same level of integration if your invoice was 
posted via Materials Management (MM). 

You can find more information about this process under  [Page 16]. 

Process Flow 
You can find the data for this process under  [Page 17]. 

1. Displaying the Current G/L Balances (Payables) [Page 18] 

2. Entering Standard FI Invoices [Page 19] 

3. Fast Entry of Incoming Invoices [Page 21] 

4. Displaying Invoices, Changing Payment Terms, and Displaying Change Documents [Page 
23] 

5. Displaying Vendor Balances, Line Items, and Documents [Page 25] 

6. Displaying G/L Balances (Payables) [Page 27] 

7. Displaying G/L Items (Expenses) [Page 28] 

8. Displaying the Effects of Vendor Items on Cost Center Accounting [Page 29] 
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 Additional Process Information 
You use standard entry to enter different vendor invoices. If, however, you need to enter multiple 
invoices from the same vendor, you can use fast entry. if you use fast entry, you enter header 
data, such as company code, document type, currency or the document date once each day. 

 

 

16  April 2001 



 SAP AG Financial Accounting (FI) 

  Data Used During This Process 

 Data Used During This Process 
Field Europe North America Description 

Expense account 476900 476900 Other costs 

Payables account 160000 160000  

Company code 1000 3000  

Currency DEM USD Local currency 

Tax code VN I1 Taxable 

Document type KR KR Vendor invoice 

Document date Today’s date, less 2 
days 

Today’s date, less 2 
days 

Vendor invoice date 

Posting date Date Date  

Vendor 1910 3910  

Cost center 1000 1000  

Controlling area 1000 2000  

Cost center value 1000 1000  
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Displaying the Current G/L Balances (Payables) 
Usage 
Before entering the vendor invoices, you first display the balances of the G/L reconciliation 
accounts for the vendors. After you have posted the invoices, you will display the same account 
again and verify the automatic update of the General Ledger. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Account → 
Display Balances 

Transaction Code FS10N 

2. Enter the following data: 

Field Europe North America 

G/L account 160000 160000 

Company code 1000 3000 

Fiscal year Current year Current year 

3. Choose . 

4. Check the balance of the input month. Make a note of the balance for the current period. 

5. Choose  until the overview tree appears. 
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Entering Standard FI Invoices 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Other → Invoice- General 

Transaction Code F-43 

 
The top half of the screen contains the document header. All data entered here is 
relevant to the entire document. In the lower part of the screen, you enter the 
document items. 

2. On the Enter Vendor Invoice: Header Data screen, enter the following data: 

Field Europe North America 

Document date Today's date less 2 days (vendor 
invoice date) 

Today's date less 2 days (vendor 
invoice date) 

Document type KR KR 

Company code 1000 3000 

Posting date Today’s date Today’s date 

Currency / rate DEM USD 

Reference Invoice number of the vendor (any 
number) 

Invoice number of the vendor (any 
number) 

PstKy (first line item) 31 31 

Account 1910 3910 

3. Choose . 

4. On the Enter Vendor Invoice: Add Vendor Item screen, enter the following data: 

Field Europe North America 

Amount Any Any 

Calculate tax Select Select 

Tax code VN I1 

Payment terms ZB01 ZB01 

PstKy (second line item) 40 40 

Account 476900 476900 

5. Choose . 

6. On the Enter Vendor Invoice: Add G/L Account Item screen, enter the following data: 

Field Europe North America 
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Amount * (is calculated) * (is calculated) 

Cost center 1000 1000 

Text Any Any 

7. Choose . 

The invoice is posted. The system confirms that the document has been posted. 

8. Make a note of the document number. 

9. Choose  until the overview tree appears. 

In the Exit Processing dialog box, choose Yes. 
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Fast Entry of Incoming Invoices 
Usage 
You now use the fast entry function in accounts payable to enter a vendor invoice. You receive 
the same results if you post your invoice using invoice verification. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Other → Invoice/Credit Memo Fast Entry 

Transaction Code FB10 

 
The Invoice/Credit Fast Entry: Header Data screen appears only once each day. If 
you process the same transaction again during the same day, the screen is skipped 
and the input parameters are copied over automatically. To change the initial 
parameters, you would choose . 

2. Enter the following data: 

Field Europe North America 

Company code 1000 3000 

Posting date Today’s date Today’s date 

Document type KR KR 

Currency DEM USD 

Document date Today's date less 2 working days 
(vendor invoice date) 

Today's date less 2 working days 
(vendor invoice date) 

3. Choose Enter invoice/credit memo. 

The Invoice/Credit Fast Entry: Enter Items screen appears. 

4. Enter the following data: 

Field Europe North America 

Reference Invoice number of the vendor Invoice number of the vendor 

Account 1910 3910 

Amount 116 (gross invoice amount, including 
value added tax) 

106 (gross invoice amount, including 
sales tax) 

Tax amount 16 (amount according to invoice) 6 

Offsetting items   

Account 476900 (G/L account) 476900 (G/L account) 

Amount 100 (net invoice amount) 100 (net invoice amount) 
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Tx VN I1 

Cost ctr 1000 1000 

 
If you want to post multiple lines as offsetting entries and it is only the cost center 
that changes, just enter the amount and cost center. The system defaults the 
remaining information automatically. 

If you need more lines as offsetting entries, choose , then choose G/L item fast 
entry. To enter more lines, choose G/L item fast entry. 

5. Choose . 

6. Make a note of the document number. 

7. Choose  until the overview tree appears. 
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Displaying Invoices, Changing Payment Terms, and 
Displaying Change Documents 
Usage 
You now display the invoice you created in the previous process step. You then change the 
payment terms and display the document again with the change history. The change history 
shows you what changes have been made, by whom and when the changes were made. 

 
In this process step, you call up the invoices individually. You need to repeat this 
procedure for each document. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document → 
Display 

Transaction Code FB03 

2. On the Display Document: Initial Screen, enter the following data: 

Field Europe North America 

Document number Enter one of the document numbers 
you noted previously 

Enter one of the document numbers 
you noted previously 

Company code 1000  3000 

Fiscal year Current year Current year 

3. Choose . 

4. On the Document Overview screen, choose . 

In the dialog box, you see information about the user who posted the document, when it 
was posted, and which transaction was used. 

5. Choose . 

6. Double click on the vendor line item (1). 

The Display Document: Item 001 screen appears. 

You are currently in the display mode. To change the payment terms you must switch to 
the change mode. 

7. Choose . 

8. Enter the following data: 

Field Data 

Payt terms Empty 

Days/percent 5 (days) 
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You have now changed the payment terms so that the invoice is due in 5 days. 

9. Choose . 

The R/3 System warns you that the payment terms have been changed.  

10. Choose . 

11. Choose . 

12. Choose . 

13. On the Display Document: Initial Screen choose . 

14. On the Document Overview screen, choose Environment → Document changes. 

The system displays a list of all fields in which changes have been made. Note that your 
changes to the Payment terms field have triggered changes in various other fields. 

15. Double click on the Payment terms line. 

You now see the old and new value of the field. 

16. Double-click on the line once more to call up information about the user who made the 
changes and the time of the change. 

 
Repeat this procedure to change the payment terms for the other document. 

17. Choose  until the overview tree appears. 
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Displaying Vendor Balances, Line Items, and 
Documents 
Usage 
You now display the vendor’s account and the monthly balances. You can then drill down to the 
line items that make up the balances and search for the document you posted earlier. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display Balances 

Transaction Code FK10N 

2. On the Vendor Balance Display screen, enter the following data: 

Field Europe North America 

Vendor 1910 3910 

Company code 1000  3000 

Fiscal year Current year Current year 

3. Choose . 

4. Double-click on the entry in the Balance column for the current period. 

You now see all of the items for this period. The line item status informs you whether the 
items are open or cleared. 

5. Choose . 

The Define Filter Criteria dialog box appears. 

6. In the Field list, select Reference, then choose . 

You have now included Reference in the field criteria. 

7. Choose Copy. 

The Filter Criteria dialog box appears. 

8. In the Reference field, enter the reference number for your vendor, then choose . 

9. Position your cursor on the selected line item. 

10. To display the posted document, choose . 

11. On the Display Document: Item 001 screen, choose . 

To display the reference number in the document header data, choose . 
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If you wish to display the other document, return to the Vendor Line Item Display 
screen, then repeat steps 5 to 10. 

12. Choose  until the overview tree appears. 
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Displaying G/L Balances (Payables) 
Usage 
You now check whether the general ledger has been updated simultaneously with accounts 
payable. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Account → 
Display Balances 

Transaction Code FS10N 

2. Enter the following data: 

Field Europe North America 

G/L account 160000 160000 

Company code 1000 3000 

Fiscal year Current year Current year 

Business area * * 

3. Choose . 

Check the balance of the input month. Compare the amounts before and after the invoice 
entry. 

 
You are not able to drill down to the source documents for this account. This general 
ledger master record has been configured not to record individual line items, 
because the line items can be seen in the individual vendor accounts. 

4. Choose  until the overview tree appears. 
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Displaying G/L Items (Expenses) 
Usage 
You now display the general ledger line items for your expense account directly, without drilling 
down through the monthly balances. If desired, you can still display the monthly balances first as 
described in the previous process step Displaying G/L (Payables) Balances. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Account → 
Display/Change Line Items 

Transaction Code FBL3N 

2. On the G/L Account Line Item Display screen, enter the following data: 

Field Europe North America 

G/L account 476900 476900 

Company code 1000 3000 

Open items Select Select 

Posting date Empty Empty 

Display variant /KOSTELLE /KOSTELLE 

3. Choose . 

In the line item display, you can scroll down to see the line items for each cost center. 

4. Select the Amount in local curr. column, then choose . 

The system displays the totals by period. Scroll down to see the invoice you posted to 
cost center 1000 in the current period. 

5. Choose Settings → Summation levels → Define breakdown. 

The Sum Steps: Specify Breakdown dialog box appears. 

6. Choose Level 3 (cost centers). 

You now see the overall total for each cost center. 

7. Choose  until the overview tree appears. 
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Displaying the Effects of Vendor Items on Cost Center 
Accounting 
Usage 
All of the earlier process steps assumed that you were working in the accounts payable 
department. You now see what the cost center manager sees when an invoice is posted to their 
cost center. You execute a cost center report, and drill down to the source documents in 
accounts payable. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Cost Center Accounting → Information 
System → Reports for Cost Center Accounting → Plan/Actual 
Comparisons → Cost Centers: Actual/Plan/Variance 

Transaction Code S_ALR_87013611 

2. On the Cost Centers: Actual/Plan/Variance: Selection screen, enter the following data: 

Field Europe North America 

Controlling area 1000 2000 

Fiscal year Current year Current year 

From period 001 001 

To period 012 012 

Plan version 0 0 

or value(s) 1000 (cost center) 1000 (cost center) 

3. Choose . 

The system issues a cost center report with a total for each posted cost element. 

4. Double-click on cost element 476900 (miscellaneous costs). 

5. Double-click on Cost Centers: Actual Line Items. 

You now see a list of CO line items for cost center 1000. 

6. Choose  Choose. 

7. Double-click on Primary cost posting. 

8. Double-click on one of your posted documents. 

The Document Overview screen appears. 

9. Choose  until the overview tree appears. 

In the Display Actual Line Items for Cost Centers dialog box, choose Yes. 

In the Exit Report dialog box, choose Yes. 
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If you are asked whether to save an extract, choose No. 
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 Invoicing from Materials Management (MM) 
Purpose 
This scenario demonstrates a standard three-way match. A three-way match is made up of the 
matching of the purchase order line item (including order price and quantity), all goods receipts 
against the purchase order (quantity value), and all invoice receipts (dollar value).  

The scenario begins with the entry of a purchase order for a material. This material is then 
received and you enter the incoming invoice, the payment, and manually cut a check. Each of 
these transactions refers to the initial purchase order so that throughout the entire process you 
reference the purchase order history to track your process. 

You can find more information about this process under  [Page 32]. 

 

Process Flow 
1. Setting the Basic Requirements [Page 33] 

2. Entering a Purchase Order for a Material [Page 34] 

3. Entering a Goods Receipt [Page 36] 

4. Displaying the Goods Receipt in the Purchase Order History [Page 38] 

5. Entering an Incoming Invoice [Page 39] 

6. Displaying the Invoice in the Purchase Order History [Page 41] 

7. Displaying an Account Balance [Page 42] 

8. Entering an Outgoing Payment with Check Processing and Printing [Page 43] 

9. Displaying the Check Information from the Purchase Order History [Page 45] 
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 Data Used During This Process 
Field Europe North America Description 

Currency DEM USD Local currency 

Material V10 V10 Sample material 

Order type NB NB Normal purchase order 

Plant 1000 3000 Sample plant 

Purchasing group 001 001 Sample purchasing group 

Purchasing organization 1000 3000 Purchasing organization 

Storage location 0001 0001 Sample storage location 

Tax code VN I1 Tax code 

Vendor 1006 3920 Sample vendor 
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Setting the Basic Requirements 
Prerequisites 
To ensure a successful demonstration of this scenario, please check that your user ID is set up 
correctly so that you can process invoice items. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Other → Invoice - General 

Transaction Code F-43 

2. On the Enter Vendor Invoice: Header Data screen, choose Settings → Editing Options.  

3. On the Accounting Editing Options screen, choose the Open Items tab page. 

4. Enter the following data: 

Field Europe North America 

Selected items initially active Select Select 

5. Choose . 

The system confirms that the new options have been activated 

6. Choose  until the overview tree appears. 
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Entering a Purchase Order for a Material 
Use 
If you want to execute a 3-way match, the first component of the match is the purchase order. 
Here, you enter as much information as possible regarding the product that you want to 
purchase. No accounting documents are created in this step. However, you can see the 
outstanding commitment against your cash flow. Also, although it is not described in this 
scenario, if you enter an order that is charged against an order or project (as opposed to a 
material) then the purchase order also appears as a commitment on the cost object. The tracking 
of commitments is demonstrated in another scenario. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Create → Vendor/Supplying Plant Known 

Transaction Code ME21N 

2. On the Create Purchase Order screen, enter the following data: 

Field Europe North America 

Vendor 1006 3920 

Make sure that Standard PO is selected. 

Chooset Header if this is not already open. 

3. Choose the Org.data tab page and then enter the following data: 

Field Europe North America 

Purchasing org. 1000 3000 

Purchasing group 001 001 

Company code 1000 (IDES AG)  

4. Choose  Item overview. 

5. Enter the following data in Item overview. 

Field Europe North America 

Item number 10 10 

Material V10 V10 

PO quantity 100 100 

Delivery date Today’s date + 20 Today’s date + 20 

Net price 100 100 

Plant 1000 3000 

Storage location 0001 0001 
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6. Choose . 

The system displays the message Standard PO created under the number .... Note this 
number for future reference. 

7. Choose  until the overview tree appears. 
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Entering a Goods Receipt 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → 
Goods Movement → Goods Receipt → For Purchase Order → PO 
Number Known. 

Transaction Code MIGO 

The system displays the Goods Receipt: Purchase Order - <User> screen. 

2. Enter the following data: 

Field Data 

Purchase order Your purchase order number 

3. Choose . 

The system copies the header data of the purchase order into the header data area of 
the GR document. 

The purchase order items are copied into the item overview. 

The PO number you entered is copied into the Current PO order field, and the PO 
number field is once again ready for input.  

If you click on individual items, the system displays an item data screen, which allows 
you, for example, to change the incoming quantity. 

4. In the header data area of the General tab page, enter the following data: 

Field Data 

Document date Today's date (default) 

Posting date Today's date (default) 

5. Select your item, then choose the Where tab at the bottom of the screen to check your 
organization data. 

6. If required, enter the following data: 

Field Data 

Storage location Warehouse number or description 

7. Flag the OK indicator for your item. 

 
If the OK indicator is not ready-for-input in the item overview area, either close the 
item detail area or select Item OK in the lower part of the item detail. 

8. Then select Post at the top of the screen. 

 
The system confirms the posting and assigns a material document number. Make a 
note of this number. 
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9. Choose . 

You can also display the material document and the corresponding accounting 
document. 

10. From the Inventory Management node, choose Material Document → Display 

11. On the Display Material Document: Initial Screen, enter the following data: 

Field Data 

Material doc. Enter the material document number that you noted earlier. (Use Find 
Material Document [Ext.] to locate the number if you omitted to write it 
down). 

Material doc. year Current year 

12. Choose . 

The system displays the material document. 

13. On the Display Material Document xxx: Overview screen, place your cursor on the material 
document and select Accounting docs.... 

14. The system displays the List of Documents in Accounting dialog box. Select the Accounting 
document number. 

On the Document Overview screen, you see the relevant G/L accounts and values. 

 
The balance of the “Inventory – Raw Materials” account (79000) is thus raised whilst 
a corresponding posting is made from the “Goods Rcvd/Invoice Rcvd” account. 
These postings occur as a result of Customizing settings made in the IDES System. 

15. Choose . 

16. Select  to shut the dialog box. 

17. Choose  until the overview tree appears. 
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Displaying the Goods Receipt in the Purchase Order 
History 
Use 
In purchasing, you can display the purchase order history. This history lets you drill down to all of 
the subsequent documents that stem from the original purchase order. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Display 

Transaction Code ME23N 

2. The system displays the Standard PO ... Created by ... screen. 

Choose  Item details. The system should display your order number at the top of the 
screen. Choose Purchase Order → Other Purch. Order to enter another number.  

3. Choose the Purchase Order History tab page. 

4. Select your material document from the list. 

The system shows the Display Material Document Number - Name screen. 

5. Choose the Doc. info tab page. 

6. Choose  FI docmts. 

7. The system displays the List of Documents in Accounting dialog box. Select the Accounting 
document. 

You reach the Document Overview screen where you see the FI document displayed. 

8. Choose  and  until the overview tree appears. 

 

38  April 2001 



 SAP AG Financial Accounting (FI) 

  Entering an Incoming Invoice 

Entering an Incoming Invoice 
Use 
The final component of your three-way match is the receipt of the vendor’s invoice. The invoice 
requires only a minimal amount of data entry. If the quantities and values match between the 
purchase order, goods receipt and invoice, you can pay the invoice. If there are any 
discrepancies, then the invoice is blocked for payment. Because the invoice increases your 
payables, again you have an impact on accounting to your balance sheet (in accounts payable) 
and in cash management. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Folllow-On Functions → Logistics Invoice Verification 

Transaction Code MIRO 

2. On the Invoice Verification screen, enter the following data: 

Field Data North America 

Document date Today’s date Today’s date 

Posting date Today’s date Today’s date 

Reference Invoice number of the vendor Invoice number of the vendor 

Gross inv. amnt 11.600,00 10.400,00 

Calculate tax Select Select 

Tax code VN I1 

Purchasing document Your purchase order number Your purchase order number 

 
Make sure that the invoice posting date is set to a date after the requested delivery 
date entered on the purchase order in the first procedure. If your invoice date is 
before the requested delivery date, the system automatically blocks the invoice for 
payment. The block ensures that no early payment is made for a product that was 
either shipped or billed early. 

3. Choose . 

 

Confirm any warning messages with . 

The system selects your items and displays them. 

4. Choose . 
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Confirm any dialog boxes. 

Make a note of the invoice document number. 

5. On the Invoice Verification screen, choose Invoice Document → Display. 

6. On the next screen, choose Follow-on documents. 

7. Choose Accounting document to display the FI posting. 

The accounting document consists of the following: 

Credit 1006  Blacks AG (Vendor)   DEM 11.600,-- 

Debit  191100  Goods Rcvd/Invoice DEM 10.000,-- 

Debit  154000  Input tax       1.600,-- 

The Goods Received/Invoice Received account is a clearing account. Each line that is 
posted to this account represents either a line item from the goods receipt or a line item 
from the invoice receipt. The system automatically matches these lines line by line to 
determine your outstanding items. 

The accounts payable entry actually updates both the accounts payable G/L account and 
the subledger (the vendor’s account). 

8. Select  and  until the overview tree appears. 
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Displaying the Invoice in the Purchase Order History 
Use 
In purchasing, you can display the purchase order history. This history lets you drill down to all of 
the subsequent documents that stem from the original purchase order. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Display 

Transaction Code ME23N 

2. The system displays the Standard PO ... Created by ... screen. 

When you select  Item details, the system displays your item details. The system 
should display your order number at the top of the screen. Choose Purchase Order 
→ Other Purch. Order to enter another number.  

3. Choose the Purchase Order History tab page. 

4. Select your invoice number. 

The system shows the Display Invoice/Credit Memo: Line Item List screen. 

5. Choose Follow-on documents. 

6. The system displays the List of Documents in Accounting dialog box. Select the Accounting 
document. 

You reach the Document Overview screen where you see the FI document displayed. 

7. Select  and  until the overview tree appears. 
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Displaying an Account Balance 
Use 
Now that the invoice has been posted, you can display the impact on the vendor’s balance in 
financial accounting. You can also display the individual items that make up that balance. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display Balances 

Transaction Code FK10N 

2. On the Vendor Balance Display screen, enter the following data: 

Field Europe North America 

Vendor 1006 3920 

Company code 1000 3000 

Fiscal year Current year Current year 

3. Choose . 

4. On the Vendor Balance Display screen, double-click on the current period to view the line 
items posted in that period. 

5. To view document details, select the document number of the invoice that you noted earlier. 

6. For details of who entered the document and when, on the Display Document: Line Item 001 
screen, choose . 

7. Choose . 

8. Choose  to display all line items. 

9. On the Display Document: Overview screen, double-click on the goods receipt line of the 
invoice. Here, you can also see the purchase order number. 

10. Choose  until the overview tree appears. 
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Entering an Outgoing Payment with Check Processing 
and Printing 
Use 
In the following procedure, you execute the manual payment of an invoice. This includes clearing 
of the outstanding payable and printing the individual check for the invoice. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Outgoing Payment → Post + Print Forms 

Transaction Code F-58 

 
Be aware that the system only displays the initial screen once per day. If you call up 
this transaction more than once per day, the screen displays the next screen and 
copies the input parameters automatically. To change the original parameters, 
choose Goto → Back. 

2. On the first screen Payment with Printout: Header Data, enter the following data: 

Field Europe North America 

Company code 1000 3000 

Payment method S C 

House bank 1200 3000 

Check lot number No entry 1 

Printer for form Your local printer Your local printer 

Print immediately Select Select 

3. Select Enter payments. 

The system displays the second Payment with Printout: Header Data screen. You can 
enter the following detailed payment information here: 

Field Europe Data 

Document date Today’s date Today’s date 

Document type KZ KZ 

Company code 1000 3000 

Currency/rate DEM USD 

Amount 11.252 10.200 

Value date Today’s date Today’s date 
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Vendor 1006 3920 

4. Choose Process open items. 

 
Assuming that no lines have been activated, mark the invoice you want to pay by 
double-clicking on the gross amount. 

If the system activated more than one item, double-click on the gross amount to 
remove it from the assignment. 

5. Choose . 

6. Make a note of the document number. 

The system confirms that the document was posted for company code 1000. 

7. Choose . 

The system confirms the printing of the check with message “Print job was generated”. 
The check is now printed on your local printer. 

8. Choose  until the overview tree appears. 
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Displaying an Account Balance 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display Balances 

Transaction Code FK10N 

2. On the Vendor Balance Display screen, enter the following data: 

Field Europe North America 

Vendor 1006 3920 

Company code 1000 3000 

Fiscal year Current year Current year 

3. Choose . 

4. On the Vendor Balance Display screen, double-click on the current period to view the line 
items posted in that period. 

5. On the Vendor Balance Display screen, select your previous invoice document number by 
double-clicking on it. 

6. For details of who entered the document and when, on the Display Document: Line Item 001 
screen, choose . 

7. Choose . 

8. Choose  to display all line items. 

9. Choose  until the overview tree appears. 
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 Vendor Down Payment Processing 
Down payments made following down payment request 
In this process you create a purchase order in Materials Management, that is then filled upon 
receipt of a down payment. Once goods receipt is posted, you create the invoice in Materials 
Management invoice verification. Clearing with respect to goods received and goods invoiced is 
performed automatically. 

Because you have already made a down payment, the down payment must be cleared in terms 
of the invoice amount. Then you make the final payment. 

To simplify matters, the down payment request is set for today’s date, just a short time after the 
purchase order. The down payment occurs on the same day. The invoice is entered with a date 
ten days from today’s date, and is paid immediately. 

Select  [Page 47] for more information. 

Process Flow 
Select  [Page 48] to see the data you use during this demo. Then select the first process 
below: 

1. Entering the Purchase Order [Page 49]  

2. Entering the Down Payment Request [Page 50]  

3. Displaying the Vendor Account [Page 52]  

4. Posting the Down Payment [Page 54]  

5. Displaying a Purchase Order [Page 56]  

6. Displaying the Vendor Account [Page 57]  

7. Processing the Goods Receipt for the Purchase Order [Page 59] 

8. Posting an Incoming Invoice in Materials Management [Page 61]  

9. Clearing/Reversing a Down Payment [Page 63]  

10. Displaying the Vendor Account [Page 64]  

11. Displaying a Purchase Order [Page 66]  

12. Posting the Final Payment [Page 67]  

13. Displaying the Vendor Account [Page 69]  
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 Additional Process Information 
Because down payments are very seldom used in the United States, this process will be 
illustrated for a European environment using European data. 

The basic concept this: Your vendor sends you a letter/message requesting that you pay a 
specific down payment amount, and specifying the date by which this amount is to be paid. You 
enter the down payment request in your system and pay the down payment amount at the 
specified time. For you, this represents an outgoing payment. Then, when you post the invoice, 
you clear the down payment with the invoice and thus reduce your payables. You can carry out 
the entire process in accounts receivable accounting where the same functions are available. 

 

 

 

April 2001  47 



Financial Accounting (FI)  SAP AG 

Data Used During This Process 

 Data Used During This Process 
Fields Data Description 

Company code 1000 IDES AG Frankfurt 

Currency DEM Local currency 

Document date Today’s date Today’s date 

Posting date Today’s date Today’s date 

Bank account 113100 Deutsche Bank, domestic 

G/L account 415000 Costs due to external procurement 

Vendor 1006 Blacks AG 

Plant 1000 Hamburg 

Purchasing organization 1000 IDES Germany 

Purchasing group 001 Dietl, B. 

Material  V10 Cylinder head 
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Entering the Purchase Order 
Use 
In this transaction, you will enter a purchase order for cylinder heads from a vendor in Materials 
Management. No financial accounting documents are updated here. The purchasing order is 
important because it is used as a reference for other documents in Materials Management, 
Financial Accounting, and Controlling. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Create → Vendor/Supplying Plant Known 

Transaction Code ME21N 

2. On the Create Purchase Order: Initial Screen, enter the following data: 

Field Data 

Vendor 1006 

Order type Standard purchase order 

“Org.data” tab page, (header data)  

Purchasing org. 1000 IDES Germany 

Purchasing group 001 Dietl. B 

3. Choose . 

4. Select  Item details provided that this is not already selected. 

5. Enter the following data: 

Field Data 

Material v10 

PO quantity 1000  

Delivery date Today’s date +30 days 

Net price 100  

Plant 1000 Hamburg 

Storage location 0001 Warehouse 

6. Choose . 

7. The system displays the purchase order number at the bottom of the screen.  

Make a note of the purchase order number. 

8. Choose  until the overview tree appears. 
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Entering the Down Payment Request 
Use 
You receive a payment request from vendor Blacks AG (vendor 1006) with reference to the 
purchase order number and purchasing date from the purchasing group. Because this request 
constitutes a special general ledger transaction, you have to post it immediately in Financial 
Accounting. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Down Payment → Request 

Transaction Code F-47 

2. On the Down Payment Request: Header Data screen, enter the following data: 

Field Data 

Document date Today’s date 

Company code 1000 

Posting date Today’s date 

Currency/rate DEM 

Reference Any number as a reference 

Doc.header text Down payment request 

Account (Vendor) 1006 

Trg.sp.G/L ind. A (target special G/L indicator: down payment on current assets) 

3. Choose . 

4. On the Down Payment Request: Add Vendor Item screen, enter the following data: 

Field Data 

Amount 11,600.00 

Tax amount 1,600.00 

Tax code VN 

Bus.area 1000 

Due on Today’s date 

Purch.doc. (1st field) Purchase order number you noted earlier 

Purch.doc. (2nd field) 10 

Text Cylinder heads V10 

5. Choose . 
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Confirm any system messages with . 

Note the document number displayed at the bottom of the screen. 

6. Choose  until the overview tree appears. 
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Displaying the Vendor Account 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/Change Line Items 

Transaction Code FBL1n 

2. On the Vendor Line Item Display screen, enter the following data: 

Field Data 

Vendor 1006 

Open items Select 

Noted items Select 

3. Choose . 

4. Under Dynamic selections, enter today’s date in the Posting date field. 

5. Choose . 

You reach the Vendor Line Item Display screen again. 

6. Choose . 

The document you just posted is shown on the Vendor Line Item Display screen.  

7. Place your cursor on the document number and double-click on the document. 

8. On the Display Document: Line Item 001 screen, select . 

The system generates a document that does not affect accounting. In other words, you 
can display line items, but the amount will not be updated in transaction figures. 

It is actually a noted item. The only item the document contains is the down payment 
request from vendor 1006. The reconciliation account is account 196300 (vendor down 
payment requests). 

9. Choose  until the overview tree appears. 
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Posting the Down Payment 
Use 
In this process, we carry out the down payment manually. We could also use a payment program 
here. The payment proposal list would contain the down payment if we entered the vendor in the 
payment parameters. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Down Payment → Down Payment 

Transaction Code F-48 

2. On the Post Vendor Down Payment: Header Data screen, enter the following data: 

Field Data 

Document date Today’s date 

Company code 1000 

Posting date Today’s date 

Reference Your reference number from the first process 

Doc.header text Down payment 

Account (Vendor) 1006 

Special G/L ind A (down payment on current assets) 

Account (bank) 113101 

Amount 11,600.00 

Value date Today’s date 

3. Choose Requests.  

Existing down payment requests for vendor 1006 are displayed on the Post Vendor 
Down Payment: Choose Requests screen.  

4. Select the appropriate request and then choose Create down payments 

5. Bypass any warnings with . 

On the Post Vendor Down Payments: Display Overview screen, an overview of the 
document to be posted is displayed. 

6. Choose . 

The system confirms that a document is posted by displaying the document number in 
the status line 

7. Choose  until the overview tree appears. 
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Displaying the Purchase Order 
Use 
In the following procedure, you return to Materials Management to see the ordering history. You 
will see that a down payment was made. You will see that a down payment was made. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Display 

Transaction Code ME23N 

2. On the Standard PO ... Created by ... screen, enter the number of the purchase order already 
created and select . 

3. Select  Item details provided this is not already selected. 

4. Choose the Purchase Order History tab page. 

Down payments totaling DM 11,600.00 have been made for the order item selected. The 
net amount is displayed because you are in Materials Management. 

5. To display the detail data, place your cursor on the down payment and then choose . 

6. Choose . 

7. Choose  until the overview tree appears. 
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Displaying the Vendor Account 
Use 
A down payment made on a purchase order for goods has to be activated. You will notice that in 
posting a down payment, the system makes a posting automatically on the assets side of the 
balance sheet.  

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/Change Line Items 

Transaction Code FBL1N 

2. On the Vendor Line Item Display screen, enter the following data: 

Field Data 

Vendor 1006 

All items Select 

With special G/L transactions Select 

3. Choose . 

On the Vendor Line Item Display screen, documents pertaining to down payments and 
down payment requests are displayed. The down payment request is identified as a 
cleared item. 

4. Double-click on the down payment document . 

The vendor items are displayed on the Display Document: Line Item ... screen. 
Reconciliation account 159000 is in the G/L field (other down payments made on current 
asset). 

In this case, the vendor reconciliation account is not payables account 160000 (as 
entered in the vendor master record), but account 159000, which is assigned to the 
assets side of the balance sheet (in current assets). 

5. Choose . 

On the Document: Overview screen, the posting is displayed as follows. 

• Credit: Account 113101 (bank account) 

• Debit: Account 1006 (vendor/reconciliation account 159000) 

• Credit: Account 154000 (input tax) 

• Debit: Account 159010 (clearing account for input tax) 

You will clear these postings in a later transaction, after the goods have arrived at the 
warehouse and you have posted the vendor invoice. 

6. Choose  until the overview tree appears. 
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Processing the Goods Receipt for the Purchase Order 
Use 
We will assume that the goods were delivered today. You now have to post the goods receipt in 
Materials Management. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → For Purchase Order → PO Number 
Known 

Transaction Code MIGO 

2. On the Goods Receipt Purchase Order ... screen, enter the following data: 

Field Data 

Document date Today’s date 

Posting date Today’s date 

Doc.header text Goods receipt (defaulted) 

Movement type Purchase order (defaulted) 

Purchase order PO number from the first process 

3. Choose . 

Items belonging to the purchase order entered appear on the Goods Receipt Purchase 
Order: ... screen. In our example, there is only one item per purchase order number. 
Whenever the delivery quantity does not match the purchase order quantity, you have to 
change the value in the “Quantity” field to 1000 (purchase order quantity from the first 
topic). 

4. Select Item OK. 

5. Choose , and then note the document number. 

6. Choose  until the overview tree appears. 

7. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Material 
Document → Display 

Transaction Code MBO3 

8. On the Display Material Document: Initial Screen, you should find that your material 
document number has already been defaulted by the system. If not, then insert the number 
here. Enter the current fiscal year. 

9. Choose . 

The system shows the Display Material Document ... Overview screen. 
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10. Choose Accounting docs... 

11. In the List of Documents in Accounting dialog box, choose the Accounting document. 

The posting is as follows: 

• Debit: Account 300000 (Inventory: Raw materials) 

• Credit: Account 191100 (Goods Recvd/Invoice Recvd) 

The posting to account 191100 is only cleared after the invoice has been posted. 

12. Select  and  until the overview tree appears. 
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Posting an Incoming Invoice in Materials Management 
Use 
To simplify matters, we will assume that the invoice arrived today as well. You now have to post it 
in the system.  

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Invoice Verification → Logistics 
Invoice Verification → Document Entry → Enter Invoice 

Transaction Code MIRO 

2. On the Invoice Verification screen, enter the following details: 

Field Data 

Document date Today‘s date 

Posting date Today‘s date 

Company code IDES AG (defaulted) 

Reference Reference from the first process 

Purchase order PO number from first transaction 

Amount 116,000.00 

Tax amount (1st line) 16,000.00 

Tax ind.  VN 

PO number PO number from first process 

3. Choose . 

The system suggests purchase order data automatically. 

4. On the Invoice Verification screen, select the purchase order item and the choose  
Simulate. 

The system tells you that there are down payments for this purchase order. Choose . 
The system now displays the Enter Invoice: Document Check in DEM screen. You can 
use this screen to check vendors, how many articles were billed, and at what price. 

5. Choose Back. 

6. Select  and note the document number. 

7. Choose  until the overview tree appears. 

8. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Invoice Verification → Logistics 
Invoice Verification → Document Entry → Display Invoice Document 
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Transaction Code MR3M 

9. The system should have automatically defaulted the invoice document number on the 
Display Invoice/Credit Memo: Initial Screen. Enter the current fiscal year. 

10. Choose Follow-on documents. 

11. The system displays the List of Documents in Accounting dialog box. Select the Accounting 
document. 

Select Accounting view. 

Your posting should be as follows: 

• Credit: Account 1006 (vendor/reconciliation account 160000) 

• Debit: Account 191100 (Goods Recvd/Invoice Recvd) 

• Debit: Account 154000 (input tax) 

12. Choose  until the overview tree appears. 

 
At the end of the period, you will have to analyze account 191100 with a program 
and clear items belonging together (goods receipt/invoice receipt). 
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Clearing/Reversing a Down Payment 
Use 
Clearing the down payment with the invoice amount can alternatively be performed in Financial 
Accounting or Materials Management. You have to perform this procedure in order to reverse a 
posting of a down payment on current assets or to reduce a payable by the amount of the down 
payment. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Down Payment → Clearing 

Transaction Code F-54 

2. On the Clear Vendor Down Payment: Header Data screen, enter the following data: 

Field Data 

Document date Today’s date 

Posting date Today’s date 

Reference Reference from the first process 

Doc.header text Down payment clearing 

Account 1006 

Text Clearing down payment/invoice amount 

3. Choose Process down pmnts. 

The item selected is the down payment you entered earlier. 

4. On the Clear Vendor Down Payment: Choose Down Payments screen, select the down 
payment item and then . 

 
If the system asks you to correct the item marked, proceed as outlined below: 

Double-click on the colored item. 

Enter a descriptive text in the designated field. This will allow you to reconstruct this 
transaction at a later time. 

Choose Save to post the document. 

5. Bypass any warning message by selecting . 

Make a note of the document number. 

6. Choose  until the overview tree appears.  
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Displaying the Vendor Account 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/Change Line Items 

Transaction Code FBL1N 

2. On the Vendor Line Item Display screen, enter the following data: 

Field Data 

Vendor 1006 

All items Select 

With special G/L transactions Select 

3. Choose . 

4. Select Reference, then choose Adopt selected item. 

5. Enter the following data: 

Field Data 

Reference Reference from the first process 

6. Choose . 

7. On the Vendor Line Item Display screen, choose . 

8. Carry out the following: 

Field Data 

Normal Items Select 

All accounting documents pertaining to vendor 1006 generated during this process are 
displayed. 

At the top of the list are vendor open items: invoice and down payment made. Both items 
are selected as open items during payment. This reduces the invoice amount by the 
amount of the down payment. 

The down payment as well as the clearing document are to be found under Cleared 
items. They are marked together. The clearing number is in the Clr text column and is 
the same as the clearing document number. 

9. Double-click on the clearing document. 

On the Display Document: Line Item 001 screen, you have an overview of the first line 
items. 

10. Choose . 

Your posting should be as follows: 

• Credit: Account 1006 (vendor/reconciliation account 159000 - down payment on 
current assets) 
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• Debit: Account 1006 (vendor/reconciliation account 160000 - domestic payables) 

• Credit: Account 154000 (input tax) 

• Debit: Account 159010 (clearing account for input tax from down payments made 
on current assets) 

By clearing the down payment, the down payment made is now transfer posted from 
account 159000 (assets side of the balance sheet) to account 160000 (liabilities). As a 
consequence, the total payables amount from the vendor invoice is reduced by the 
amount of the down payment. 

The tax amount is calculated on the total amount of the invoice. This explains why the 
posting for the tax amount calculated on the amount of the down payment is cleared. 

11. Choose  until the overview tree appears. 
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Displaying the Purchase Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Display 

Transaction Code ME23N 

2. Enter the purchase order number if necessary, then choose . 

3. Select  Item details. 

4. Choose the Purchase Order History tab page. 

The list shows the down payments made and under what document number the invoice 
was entered in Materials management. 

5. To view the accounting document, double-click on the invoice document. 

You will be able to see line items for the invoice document again. 

6. Choose  until the overview tree appears. 
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Posting the Final Payment 
Use 
In this transaction, you pay your vendor the amount that is still outstanding. Although you perform 
this transaction manually, you can also make the payment automatically using the payment 
program. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Outgoing Payment → Post 

Transaction Code F-53 

2. On the Post Outgoing Payments: Header Data screen, enter the following data: 

Field Data 

Document date Today’s date +10 days 

Posting date Today’s date +10 days 

Reference Reference from the first process 

Doc.header text Final payment 

Account (bank) 113100 

Amount 100,920.00 

Value date Today’s date +10 days 

Text Final payment invoice no. and reference number from first transaction 

Account (Vendor) 1006 

Automatic search Select 

 
The above amount is made up of the amounts outlined below: 

Invoice amount 116,000.00 

Less cash discount - 3,480.00 

Less down payment: -11,600.00 

3. Choose Process open items.  

4. Bypass any warning messages with . 

5. A list of open items is displayed on the Post Outgoing Payments: Process Open Items 
screen.  

If no items are activated, on the Post Outgoing Payments: Process Open Items screen, 
select the invoice that you wish to pay by clicking on the gross amount. 
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The amount entered and the amount assigned should be equal. Also, the amount in the 
field Not assigned should be zero. 

6. Choose , and then note the document number. 

7. Choose  until the overview tree appears. 
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Displaying the Vendor Account 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/Change Line Items 

Transaction Code FBL1N 

2. On the Vendor Line Item Display screen, enter the following data: 

Field Data 

Vendor 1006 

All items Select 

Normal Items Select 

Special G/L transactions Select 

3. Choose . 

4. Select Reference, then choose Adopt selected item. 

5. On the Dynamic selections part of the screen, enter the following: 

Field Data 

Reference Reference from the first process 

 
You should only define this selection condition if you have been making the same 
entry in the Reference doc. field for each document since beginning this process. 

6. Choose . 

7. Choose . 

All documents that have been generated for vendor 1006 are displayed on the Display 
Vendor Line Items screen. 

8. Double-click on the payment document. This is the one with document type KZ. 

The payment document has open status, as the item will be considered as cleared 10 
days hence. 

9. On the Display Document: Line Item ... screen, choose  to display the line items. 

Your posting should be as follows: 

• Credit:  Account 113101 (Deutsche Bank, domestic) 

• Credit: Account 276000 (cash discount received) 

• Debit: Account 1006 (vendor/reconciliation account 160000) 

• Credit: Account 1006 (vendor/reconciliation account 160000) 

• Credit: Account 154000 (input tax)  
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The amount paid is equal to the invoice amount minus down payment made, minus 3% 
cash discount, since you made your payment within ten days of receiving the invoice. 

10. Choose  until the overview tree appears. 
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 Automatic Payment Transactions 
Vendor line item entry with payment and printing 
In this process, you will complete a payment transaction automatically. 

You should first enter some vendor invoices so that there are enough due payables available in 
the system. In order to reduce the work you need to do, we have created a CATT (Computer 
Aided Test Tool) that generates invoices automatically when activated. 

Secondly, you will create a payment program and enter the parameters necessary for selecting 
the items to be paid. 

Next, you will execute a payment proposal list and check its log. You will find that some items are 
blocked for payment. You will need to update the list in order to remove the block. 

Later, you will start an actual run. Then you will set the print program so that the payment forms 
and accompanying payment advice notes and payment summaries are correctly assigned to the 
payment run. Finally, you will print the payment forms. If you are using North American data, you 
will then need to analyze the check register. 

 
Because of fundamental differences between payment transactions in Europe and in 
North America, parts of the last two steps are only relevant for North America and 
are marked accordingly. 

You can find more information about this process under  [Page 72]. 

Process Flow 
You can find the data for this process under  [Page 73]. 

1. Generating Vendor Invoices [Page 74]  

2. Additional Information [Page 75]  

3. Display List of Open Items [Page 76] 

4. Maintain Payment Program Parameters [Page 78]  

5. Schedule and Edit a Payment Proposal [Page 80]  

6. Schedule Payments [Page 83]  

7. Configure Print Program [Page 84] 

8. Printing Payment Forms and Payment Summaries [Page 87]  

9. List Cleared Items (Europe and North America) and Display Check Information (North 
America Only) [Page 88]  

10. Display Check Register (North America Only) [Page 90]  
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 Additional Process Information 
We have configured the payment program to handle this process. Here we have defined several 
banks of IDES AG as house banks, which pay for the open items according to certain selection 
criteria. Payment methods are preset in vendor master data. We have determined amount limits 
and value dates for the payment methods. All settings can be changed in the Environment pull-
down menu of the payment program. 
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 Data Used During This Process 
Fields Europe North America Description 

CATT ZIDC0336 ZID30819 Program for generating 
open invoices 

Vendor (Material) 1000 (DPC1005) 3000 (100-120)  

Vendor (Material) 1000 (DPC1006)   

Vendor (Material) 1001 (100-430) 3100 (100-130)  

Vendor (Material) 1001 (100-431)   

Vendor (Material) 1003 (100-110) 3715 (1300-320)  

Vendor (Material) 1003 (100-120)   

Vendor (Material) 1005 (100-310) 3725 (M-25)  

Vendor (Material) 1005 (100-400)   

Company code 1000 3000 Model company code 

Currency DEM USD Local currency 

Payment run date Today’s date + 10 days Today’s date + 10 days  

Identification Any 5-character 
identifier 

Any 5-character 
identifier 

 

Pmnt meths S, U C  
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Generating Vendor Invoices 
Prerequisites 
To ensure that due items are available, we have created a CATT which automatically generates 
invoices and goods receipts in Materials Management. 

You can find more information about this process under  [Page 75]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Tools → ABAP Workbench → Test → Test Workbench → CATT Extended

Transaction Code SCAT 

2. On the Computer Aided Test Tool: Initial Screen, enter the following data: 

Field Europe North America 

Test case ZIDC0336 ZID30819 

Functions Select Select 

3. Choose . 

4. On the CATT: Execute Test Case #### screen, enter the following data: 

Settings Europe North America 

Log type W/o W/o 

Processing mode Background Background 

Variants All All 

5. Choose . 

The system displays the message: Document no. #### created. 

 
On the CATT: Execute Test Case #### screen, choose Utilities → Logs to display 
the log. On the CATT - Test Plan Log screen, choose  

The program run can take a while. Then, the system displays a log in the form of a report 
tree. It provides information about the different documents with the accompanied 
numbers that have been generated: Purchase orders and goods receipts of materials, 
invoices. 

6. Choose  until the overview tree appears. 
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 Additional Information 
CATT is an SAP test tool that we also use in IDES for generating data. 

 

You can see the data generated by the CATTs listed below. 

Example for Europe: 

Altogether, 8 invoices from 4 different vendors are generated in this way in the 
background. The invoices are as follows: 

Vendor 1000: 1 invoice for DEM 92,000 (100 pieces of material DPC 1005/PC parts) 1 
invoice for DEM 20,700 (100 pieces of material DPC 1006/PC parts) 

Vendor 1001: 1 invoice for DEM 575 (100 pieces of material 100-430/lantern ring) and 
1 invoice for DEM 230 (100 pieces of material 100-431/washer) 

Vendor 1002: 1 invoice for DEM 11,270 (100 pieces of material 100-130/screw) 1 
invoice for DEM 36,800 (100 pieces of material 100-300/shaft) 

Vendor 1003: 1 invoice for DEM 1,150 (100 pieces of material 100-110/slug) 1 invoice 
for DEM 5,175 (100 pieces of material 100-120/flat gasket) 

Vendor 1005: 1 invoice for DEM 5,520 (100 pieces of material 100-110/slug) 1 invoice 
for DEM 27,600 (100 pieces of material 100-120/flat gasket) 

No goods receipts have been posted for vendor 1005. Therefore, the invoice is initially 
blocked for payment. 

Example for North America: 

Altogether, 4 invoices from 4 different vendors are generated in this way in the 
background. The invoices are as follows: 

Vendor 3000: 1 invoice for USD 1,200 (100 pieces of material 100-120/flat gasket) 

Vendor 3100: 1 invoice for USD 40 (100 pieces of material 100-130/hexagon head 
screw) 

Vendor 3705: 1 invoice for USD 2,000 (100 pieces of material 1300-320/HD handle bar 
without crook lock) 

In this case, the supplier number (3705) is different from the vendor number (3715). This 
does not really affect the process, though. 

Vendor 3725: 1 invoice for USD 99,500 (100 pieces of material M-25/NEC Multisync 
XV15) 

No goods receipts have been posted for vendor 3100. Therefore, the invoice is initially 
blocked for payment. 
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Display List of Open Items 
Use 
The following transaction enables you to look at the invoices in Financial Accounting. Two 
variants have been defined for this transaction: For company code 1000 the variant “accounts 
payable payment program  Europe” (1000, 1001, 1002, 1003, 1005) and for company code 3000 
the variant “accounts payable payment program”  USA (3000, 3100, 3715, 3725). 

Procedure 
7. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/change line items 

Transaction Code FBL1N 

8. On the Vendor Line Item Display screen, choose . 

9. The system displays a dialog box: Select either KRED.EUROPA or KRED.USA and then 
choose . 

You return to the first selection screen. 

10. Choose . 

The system displays the line item list. The system displays additional information 
pertaining to payment conditions for each invoice. The payment date is the latest date by 
which the payment has to be made in order to benefit from the highest level of cash 
discount. 

11. Double-click on the first document of the following vendor to view the vendor line items: 

Field Europe North America 

Vendor 1001 3000 

Where nothing is entered in the Pmnt block field the invoice can be paid. 

 
If the field contains an “R”, this means that another user has already processed the 
document. Choose another document. 

12. From the Display Document: Line Item 001 screen, choose Environment → Original 
Document. 

The system displays an overview of the invoice in Materials Management with 
information on material, quantities, and gross invoice amount. 

13. To display the purchase order history, position your cursor on the purchase order number 
and choose  PO history. 

The system branches to the Order History for Purchase Order #### Item #### screen. 
Both a goods receipt and an invoice receipt have been posted for the purchase order in 
Materials Management. 
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This transaction permits you to document the data that you generated using CATT. 
In the real world, an employee in Materials Management would have created the 
purchase order, the goods receipt, and the invoice receipt. 

14. Choose  until you reach the Vendor Line Item Display screen. 

15. Double click on a line item for the following vendor: 

Field Europe North America 

Vendor 1005 3100 

As in the first example, the system provides you with an overview of the invoice items. 
On this occasion, the letter “R” is in the Pmnt block field. 

This means that the invoice is blocked for payment. The block indicator “R” indicates an 
invoice verification block in Materials Management. A block can be set here for different 
reasons, such as discrepancies between the purchase order quantity and the quantity of 
delivered goods. 

16. On the Display Document: Line Item 001 screen, choose Environment → Original Document. 

The system displays an overview of the invoice in Materials Management with 
information on material, quantities, and gross invoice amount. 

17. Position the cursor on the purchase order number and choose  PO history to display the 
purchase order history. 

In contrast to the first example, only the invoice has been posted here. The ordered 
goods have not yet been delivered. For this reason, the system has blocked the invoice.  

The block can either be removed automatically when the goods receipt has been posted, 
or the indicator can be manually removed by someone working in Financial Accounting 
or Materials Management. 

18. Choose  until the overview tree appears. 
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Maintain Payment Program Parameters 
Use 
You need to identify a payment run with a name. Then you have to determine the company 
codes and vendors for which you want to trigger the payment program. The date of the next 
payment run is also important for deciding whether to pay with cash discount or to pay net. Once 
this has been done, a payment proposal list can be automatically generated according to the 
terms of payment in the documents. 

Procedure 
19. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Periodic 
Processing → Payments 

Transaction Code F110 

20. On the Automatic Payment Transactions: Status screen, enter the following data: 

Field Europe North America 

Run date Today’s date + 10 days Today’s date + 10 days 

Identification Any 5-character identifier Any 5-character identifier 

21. Choose . 

The system displays the status No parameters entered as yet. 

22. Choose the Parameter tab page.  

23. On the Automatic Payment Transactions: Parameters screen, enter the following data: 

Field Europe North America 

Company codes 1000 3000 

Pmnt meths SU (S=Check, U=Transfer) C (Check) 

Next p/date Today’s date + 30 days Today’s date + 30 days 

Vendor (from/to) 1000 to 1005 3000 to 3725 

 
If more than one person has been working with this vendor, more items may be 
selected in the payment proposal list in addition to those seen in the previous 
transaction. 

 
The system checks the due dates of all items for the vendors you selected for 
payment processing. With reference to the date of the next payment run, the system 
decides which items are to be paid so that no discount is lost. 

24. Choose the Additional Log tab page. (This is used to evaluate the payment run). 
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25. Select Due date check, Payment method selection in all cases, and Line items of the 
payment documents.  

26. Enter the following data: 

Field Europe North America 

Vendors from/to 1000 to 1005 3000 to 3725 

27. Choose . 

28. Choose . 

29. Choose the Status tab page. 

On the Automatic Payment Transactions: Status screen, the status is Parameters have 
been entered. 

30. Remain on this screen. 
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Schedule and Edit a Payment Proposal 
Use 
The payment proposal list allows you to execute a test run of your payments. You will be able to 
see which items are planned to be paid, and which are blocked for payment. From this listing, 
you can then block items that were originally planned to be paid and unblock items that were 
originally blocked. When you execute the payment program it will use this proposal as its basis. 

Procedure 
1. On the Automatic Payment Transactions: Status screen, choose  Proposal. 

2. Enter the following data: 

Field Data 

Start date Today’s date 

3. Choose Start immediately. 

4. Choose . 

The status on the Automatic Payment Transactions: Status screen now reads Proposal 
is ready to be started. 

5. Choose  to refresh the status text. The system now displays the status Payment proposal 
has been created. 

6. Choose Proposal. 

The proposal log is used to evaluate the test run. The proposal log helps you determine 
whether there are any problems with any vendor invoice line items. If there are no 
problems, the log also displays proposed posting documents that will be generated in the 
actual payment run.  

7. Locate the documents that you posted in the previous processes. Are they all included in the 
list? If not, can you explain why not? 

The system checks the house bank and the payment method for each document and 
tells you if the payment is possible. If a payment document cannot be generated, the 
system issues error messages. 

 
It may be that the vendors selected in the parameters cannot be cleared. The 
payment proposal list will tell you that the vendor is blocked by another payment 
proposal list. This means that another user is trying to run the process at the same 
time. 

If this is the case, you will first need to delete the generated payment proposal list 
and then the parameters. Wait until the other user has finished with the process, and 
then start again from the beginning. 

8. Choose Job log → Print list. 

9. On the Print Screen List screen, enter the following data: 
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Field Data 

Output device Your printer 

10. Select Print immediately, then choose Continue. 

11. Now go and fetch your printed list from the printer.  

Two of the invoices that you generated using CATT are blocked for payment with the 
block key R (invoice verification). The reason for this is that while invoices were indeed 
posted, no goods receipts have been posted. The blocked invoices are from the following 
vendor: 

Field Europe North America 

Vendor 1005 3100 

 
It is possible that other invoices will be marked with block key R and so cannot be 
paid. These invoices have been entered by other IDES users and are included when 
the payment proposal list is generated. 

12. Choose  until the Automatic Payment Transactions: Status screen appears. 

13. Choose Proposal. 

14. Select All accounting clerks and then choose . 

The list on the Edit Payment Proposal: Payments screen contains two types of lines. 

The majority contains an amount and information about the vendor and the house banks. 
The amount corresponds to the sum total of all the given vendor’s invoices that are paid 
by the given house bank. 

The other lines are exception lines. Exceptions are items which are blocked or contain 
errors and which cannot be cleared of this reason. 

15. Double-click on the exceptions for the following vendor: 

Field Europe North America 

Vendor 1005 3100 

On the Edit Payment Proposal: Open Items screen, the system displays a list of blocked 
invoices. 

16. Select one of the invoices generated in step 1 (last and last but one line in the list) and 
choose Change.  

17. Delete the entry “R” in the Payment block field. Then choose Reallocate. 

18. Enter the following data: 

Field Europe North America 

Pyt meth. S (Check) C (Check) 

House bank 1000 3000 

Account ID (next to House bank) 1000 3000 

19. Confirm your entries with .  
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The system displays the Edit Payment Proposal: Open Items. 

20. Choose . 

21. Choose  until the Automatic Payment Transactions: Status screen appears. 

22. Remain on this screen. 
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Schedule Payments 
Use 
In this step, the system will read your payment proposal and clear the items selected for 
payment. The items are cleared in accounts payable. The payables are reduced accordingly in 
the general ledger. Payments are posted to bank sub-accounts for transfers and checks. 

Procedure 
1. On the Automatic Payment Transactions: Status screen, choose  Pmnt run to schedule 

the payment.  

2. Enter the following data in the dialog box: 

Field Data 

Start date Today’s date 

3. Select Start immediately. 

4. Choose . 

The status now reads Payment run is ready to be started.  

5. Choose  and refresh until status Payment run has been carried out appears. 

6. Choose  Payments to display the payment run log.  

The system displays an overview of the documents that have been posted for each 
vendor. 

7. Choose  until the Automatic Payment Transactions: Status screen appears. 

8. Choose Edit → Payments → Payment list...  

9. Choose  to confirm the program name RFZALI20. 

The system displays the list of paid amounts. 

The list on the Payment List screen provides you with detailed information on the items 
that have been paid and on the selected payment methods. 

The item that you have released is marked with the code 098 (Item was released later). 

10. Choose  until the Automatic Payment Transactions: Status screen appears. 

11. Remain on this screen. 

 

April 2001  83 



Financial Accounting (FI)  SAP AG 

Configure Print Program 

Configure Print Program 
Use 
After posting the payments, you must print the payment media. Since you have specified different 
payment methods in the payment parameters, the print program requires print variants for the 
payment media and the payment advice notes. 

Procedure 
1. On the Automatic Payment Transactions: Status screen, choose the Printout/data medium 

tab page. 

2. On the screen, you see 4 reports for Europe/3 reports for North America. Enter the following 
data: 

Report  Variants (Europe) Variants (North America) 

RFFOAVIS AVIS ADVICE 

RFFOD__S SCHECK Not shown 

RFFOD__U UEBERWEIS Not shown 

RFFOEDI1 Leave blank Leave blank 

RFFOUS_C Not shown CHECK 

Report RFFOEDI1 is ignored for the purposes of this demo. RFFOAVIS can be used to 
print separate payment advice notes if several items are paid at the same time. Based on 
the current system settings, however, no separate payment advice notes will be printed. 
Payment advice notes will be printed with bank transfers. 

Report RFFOD_U is used for printing domestic bank transfers, although only for Europe. 
The checks are printed using report RFFOD_S for Europe, or RFFOUS_C for North 
America.  

3. Now you must actualize the program run date, the payment program name, and the printer in 
the variants. 

Select the variant AVIS (for Europe) or ADVICE (for North America). 

4. Choose Maintain variants.  

5. On the Maintain Variant: Report RFFOAVIS, Variant AVIS (North America: ADVICE) screen, 
enter the following data: 

Field Europe North America 

Program run date Today’s date + 10 days Today’s date + 10 days 

Identification feature The 5-character identifier you 
entered earlier. 

The 5-character identifier you 
entered earlier. 

Paying company code 1000 3000 

Number of sample printouts Leave blank Leave blank 

Messages to printer Name of your printer Name of your printer 
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Print immediately Select Select 

6. Choose . 

 
You will schedule the print program in the next transaction.  Once the program has 
run, the forms are printed immediately. There is no sample printout. However, it is 
usually advisable to save the print request in a spool file and to carry out two sample 
printouts so that the printout is set correctly on the forms (checks, bank transfers). 

7. Choose  until the Automatic Payment Transactions: Printout and DME screen appears. 

8. Select SCHECK for Europe and CHECK for North America. 

9. Choose Maintain variants.  

10. On the Maintain Variant: Report ####, Variant SCHECK (North America: CHECK) screen, 
enter the following data: 

Field Europe North America 

Program run date Today’s date + 10 days Today’s date + 10 days 

Identification feature The 5-character identifier you 
entered earlier. 

The 5-character identifier you 
entered earlier. 

Paying company code 1000 3000 

Payment methods S C 

House bank Leave blank 3000 

Account ID Leave blank 3000 

Check lot number Not shown 2 

Print checks Select Select 

Printer Name of your printer Name of your printer 

Print immediately Select Select 

Print payment summary Select Select 

Printer Name of your printer Name of your printer 

Print immediately Select Select 

No. of items in payment 
summary 

9999 9999 

11. Choose . 

12. Choose  until the Automatic Payment Transactions: Printout and DME screen appears. 

13. Select the variant UEBERWEIS for Germany. (If you are using the data for North America for 
this demo, go straight to the next step). 

14. Choose Maintain variants.  
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15. On the Maintain Variant: Report RFFOD_U, Variant UEBERWEIS screen, enter the following 
data. 

Field Europe 

Program run date Today’s date + 10 days 

Identification feature The 5-character identifier you entered earlier. 

Paying company code 1000 

Payment methods U 

Print payment media Select 

Printer Name of your printer 

Print immediately Select 

Print payment advice notes Select 

Printer Name of your printer 

Print immediately Select 

Print payment summary Select 

Printer Name of your printer 

Print immediately Select 

16. Choose . 

17. Choose  until the Automatic Payment Transactions: Printout and DME screen appears. 

18. Choose . 

19. Remain on this screen. 

 

 

86  April 2001 



 SAP AG Financial Accounting (FI) 

  Printing Payment Forms and Payment Summaries 

Printing Payment Forms and Payment Summaries 
1. On the Automatic Payment Transactions: Printout and DME screen, choose the Status tab 

strip and choose  Printout. 

2. Select Start immediately and enter the Target computer. 

 
To check the identification of the target computer, select the possible entries button 
to the right of the Target computer entry field. The name of the target computer will 
be displayed in the subsequent dialog box. 

3. The payment media are printed with a job. 

4. Choose  to start the job. The print job will start now. 

You will be able to collect your printout from the printer in a couple of minutes. 

5. Choose  until the overview tree appears. 
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List Cleared Items (Europe and North America) and 
Display Check Information (North America Only) 
Use 
The payment program has now run and the open items in financial accounting have been 
cleared. In the next step, you will call up a list of the cleared items. 

Demo for North America: Having printed the checks, you can now display the check information.  
You will analyze the vendor line items and display the check information stored in the line items. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/Change Line Items 

Transaction Code FBL1N 

2. On the Vendor Line Item Display screen, choose . 

3. The system displays a dialog box. Place your cursor on the variant KRED. EUROPA or 

KRED.USA and choose . 

You return to the first selection screen. 

4. Enter the following data: 

Field Data 

Cleared items Select 

Clearing date Today’s date +10 days 

Display variant 1SAP-P 

5. Choose . 

The system displays the line item list. The system displays additional information 
pertaining to payment conditions for each invoice. 

6. Double-click on the first document of the following vendor to display the vendor line item. 

Field Europe North America 

Vendor 1001 3000 

The system displays a document overview for the selected item. 

7. From the Display Document: Line Item ... screen, choose Goto → Other line item. 

8. The Other line item dialog box appears. Enter the following data: 

Field Data 

Item 001 

9. Choose . 
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10. From the Display Document: Line Item 001 screen, choose Environment → Payment usage. 

The system outputs a list of line items cleared with the payment document on the Line 
Items for Payment Document: Basic List screen. 

11. Choose  until the Display Document: Line Item 001 screen appears. 

If you are working in the European environment, the process is now complete. If you 
have been working with the North American company code 3000, proceed with steps 12 
to 21. 

12. Choose Goto → Other line item. 

13. The Other line item dialog box appears. Enter the following data: 

Field Data 

Item 002 

14. Choose . 

15. Choose Environment → Check information.  

The system displays the Display Check Information screen with detailed check 
information.  

16. Choose  Check recipient.... 

The vendor’s address is displayed in a dialog box. 

17. Choose . 

18. Select Check issuer.... 

Here you can see who issued the check and for which run. In this case, you are the 
issuer. 

19. Choose . 

20. Choose  Accompanying docs.... 

The system displays the payment document and the items that were cleared with this 
payment. 

21. Choose  until the overview tree appears. 
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Display Check Register (North America Only) 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Environment 
→ Check Information → Display → Check Register 

Transaction Code FCHN 

2. On the Check Register screen, enter the following data. 

Field North America 

Paying company code 3000 

House bank 3000 

3. Choose the Further selections tab page. 

4. Enter the following data: 

Field North America 

Check issuer Your user name 

5. Choose . 

The check register is displayed. The fourth check that you just issued should be at the 
end of the list. 

6. Choose  until the overview tree appears. 
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 U.S. Jurisdiction Tax Processing 
Purpose 
The main objective of this script is to give examples of what resulting financial documents should 
look like regarding taxes under various posting scenarios in Financial Accounting (FI), Sales and 
Distribution (SD), and Materials Management (MM). This script also includes a brief explanation 
of how taxes were configured for the U.S. in the IDES System. 

For more information about this process, see  [Page 92]. 

Process Flow 
You can find the data for this process under  [Page 93]. 

1. Posting Taxes in FI: Accounts Receivable [Page 94]  

2. Displaying Taxes in FI: Accounts Receivable [Page 96]  

3. Posting Taxes in FI: Accounts Payable [Page 98]  

4. Displaying Taxes in FI: Accounts Payable [Page 100]  

5. Posting Taxes in SD [Page 102]  

6. Displaying Taxes in SD [Page 104]  

7. Posting Taxes in MM [Page 105]  

8. Displaying Taxes in MM [Page 110]  
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 Additional Process Information 
Special Notes 
U.S. taxes have been configured for the US company code in the IDES System only. 

• Tax jurisdiction codes have been set up for every state in the United States. 

• The tax jurisdiction codes have been broken down by state, county, and city. 

Most states have tax jurisdiction codes set up at the state level only; however, some states have 
tax jurisdiction codes set up for several cities. For example, California and Pennsylvania have 
several tax jurisdiction codes. 

Every cost center, plant, and customer record is assigned a tax jurisdiction code. This tax 
jurisdiction code automatically appears as a default value during transaction processing. 

The following tax codes are used for Sales and Distribution and Accounts Receivable: 

S0 Non-taxable 

S1 Taxable 

The following tax codes are used for Materials Management and Accounts Payable: 

I0 Non-taxable 

I1 Taxable 

U0 Interstate tax, non-taxable 

U1 Interstate tax, taxable 

A tax indicator has been set for every customer and every material in the IDES System. This 
means that taxes are calculated automatically. If something comes up with a taxable indicator 
and you do not want the R/3 System to calculate taxes, you can always manually overwrite the 
indicator with a non-taxable indicator. 

If you want taxes to be processed from your own data, see the following instructions: 

• When you create a customer, make sure that you assign a tax jurisdiction code that is 
appropriate for the state where the customer is located. 

• If you create a customer and plan to post SD transactions, make sure that you enter 1 as 
the tax indicator to indicate that the customer is taxable. 

• When you create a material, make sure that you enter 1 as the tax indicator to indicate 
that the material is taxable. 

• When you create a cost center, internal order, or project, make sure that you assign it a 
tax jurisdiction code. 

• If you create your own plant, make sure that you link a tax jurisdiction code to it. 
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 Data Used During This Process 
Field Data 

Company code 3000 

Sales organization 3000 

Distribution channel 01 

Division 01 

Purchasing organization 3000 

Purchasing group 001 

Plant 3000 

Storage location 0001 

Customer 3000 

Vendor 3000 

Vendor 3920 

Revenue (G/L account) 800200 

Revenue (G/L account) 800000 

Sales deductions (G/L account) 889000 

State sales/purchase tax (G/L account) 175001 

City sales/purchase tax (G/L account) 175003 

Expense (G/L account) 476000 

Inventory (G/L account) 300000 

GR/IR (G/L account) 191100 

Cost center 1000 

Material P-103 

Material V10 

Unloading point Dock 1 
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Posting Taxes in FI: Accounts Receivable 
Use 
In this transaction, you post three separate accounts receivable invoices. The invoices will be for 
different values and have different tax codes. The purpose of this exercise is simply to post the 
invoices. (To display the resulting documents and see how tax is posted in each case, see 
Displaying Taxes in FI: Accounts Receivable [Page 96]). 

You post three separate invoices. The first invoice is liable for state sales/purchase tax only. The 
second invoice is liable for state and city sales/purchase tax. No tax at all is posted for the third 
invoice. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
Entry → Other → Invoice - General 

Transaction Code F-22 

2. On the Enter Customer Invoice: Header Data screen, enter the following data: 

Field Data 

Document date Today‘s date 

Document type DR 

Company code 3000 

Currency/rate USD 

PstKy 01 

Account for invoice #1 3000 

Account for invoice #2 3330 

Account for invoice #3 3000 

3. Choose . 

The Enter Customer Invoice: Add Customer Item screen appears. 

4. Enter the following data: 

Field Data 

Amount for invoice #1 106.25 

Amount for invoice #2 107.00 

Amount for invoice #3 100.00 

Bus.area 3000 

Tax amount Leave blank 

Calculate tax Select 

94  April 2001 



 SAP AG Financial Accounting (FI) 

  Posting Taxes in FI: Accounts Receivable 

Tax code for invoice #1 S1 

Tax code for invoice #2 S1 

Tax code for invoice #3 S0 

PstKy 50 

Account (revenue) 800200 

5. Choose . 

The Enter Customer Invoice: Add G/L Account Item screen appears (for revenue items). 
Note that the tax code was taken from the previous screen and the tax jurisdiction code 
appears as a default value from the customer master record.  

6. Enter the following data so the R/3 System can calculate an offsetting value: 

Field Data 

Amount * 

7. Choose . 

The R/3 System displays the Enter Customer Invoice: Header Data screen, and a 
message that the document was posted. 

8. Make a note of the invoice number for later reference. 

9. Repeat steps 2 to 9 for invoices #2 and #3. 

10. Choose  until the overview tree appears. 
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Displaying Taxes in FI: Accounts Receivable 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
→ Display 

Transaction Code FB03 

The Display Document: Initial Screen appears. 

2. Enter the number of invoice #1 in the Document number field. 

3. Choose . 

The Document Overview screen appears. 

Invoice #1: Taxable invoice for receivables – state tax only 
This invoice was posted using tax code S1, which means the item is taxable. Customer 
3000 is linked to tax jurisdiction code IL0011000, which is taxable at the state level only 
at a rate of 6.25%. The displayed document should look as follows: 

 Account Description  

DR 3000 Customer 106.25

CR 800200 Sales revenue (G/L account) 100.00

CR 175001 State sales/purchase tax (G/L account) 6.25

4. Choose . 

5. After displaying invoice #1, repeat the transaction for invoice #2 and #3. 

Invoice #2: Taxable invoice for receivables – State and city tax 

This invoice was also posted using tax code S1. Customer 3330 is linked to tax 
jurisdiction code PA0011000, which is taxable at the state level at a rate of 6.00% and at 
the city level at a rate of 1.00%. The displayed document should look as follows: 

 Account Description  

DR 3330 Customer 107.00

CR 800200 Sales revenue (G/L account) 100.00

CR 175001 State sales/purchase tax (G/L account) 6.00

CR 175003 City sales/purchase tax (G/L account) 1.00

Invoice #3: Non-taxable invoice for receivables 

This invoice was posted using tax code S0, which means the item is not taxable. As a 
result, it does not matter what tax jurisdiction code the customer is linked to. The 
displayed document should look as follows: 

 Account Description  

DR 3000 Customer 100.00

CR 800200 Sales revenues (G/L account) 100.00
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6. Choose  until the overview tree appears. 
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Posting Taxes in FI: Accounts Payable 
Use 
In this procedure, you post four separate accounts payable invoices The invoices all have the 
same value, but contain different tax codes. The purpose of this exercise is simply to post the 
invoices. To display the resulting documents and see how the separate taxes are posted, see 
Displaying Taxes in FI: Accounts Payable [Page 100] . 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document 
Entry → Other → Invoice - General 

Transaction Code F-43 

2. On the Enter Vendor Invoice: Header Data screen, enter the following data: 

Field Data 

Document date Today‘s date 

Document type KR 

Company code 3000 

PstKy 31 

Account 3000 

3. Choose . 

4. On the Enter Vendor Invoice: Add Vendor Item screen, enter the following data: 

Field Data 

Amount 100.00 

Tax amount Leave blank 

Calculate tax Select 

Tax code for invoice #1 I1 

Tax code for invoice #2 I0 

Tax code for invoice #3 U1 

Tax code for invoice #4 U0 

PstKy 40 

Account 476000 

5. Choose . 

The Enter Vendor Invoice: Add G/L Account Item screen appears. Note that the tax code 
was copied from the previous screen. 
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6. Enter the following data: 

Field Data 

Amount * 

Cost center 1000 

7. Choose . 

Note that the jurisdiction code was automatically copied from the cost center. 

8. Choose . 

The R/3 System displays the Enter Vendor Invoice: Header Data screen, and a message 
that the document was posted. 

9. Make a note of the invoice number for later reference. 

10. Repeat steps 3 to 10 for invoices #2 - #4. Confirm the warning after step 5 by choosing . 

11. Choose  until the overview tree appears. 
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Displaying Taxes in FI: Accounts Payable 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document → 
Display 

Transaction Code FB03 

The Display Document: Initial Screen appears. 

2. Enter the number of invoice #1 in the Document number field. After you have displayed 
invoice #1, repeat this procedure for invoices #2 to #4. 

3. Choose . 

The Document Overview screen appears. 

Invoice #1: Payables invoice with tax on sales/purchases 

When you post this invoice, you assume that the invoiced amount of 100.00 already 
includes taxes and the taxes are paid to the vendor. This invoice was posted using tax 
code I1, which means the item is subject to tax on sales/purchases. Cost center 1000 is 
linked to tax jurisdiction code PA0000000, which is taxable at the state level only at a 
rate of 6.00%. The full amount of the invoice, plus taxes, must be paid to the vendor. The 
displayed document should look as follows: 

 Account Description  

CR 3000 Vendor 100.00

DR 476000 Expense (G/L account) 100.00

Although the accounting document does not reflect any taxes being posted, you can see 
that the R/3 System does keep a record of the tax data. Choose  Tax data to display 
this information. 

Choose  in the dialog box. 

Invoice #2: Payables invoice without tax on sales/purchases 

This invoice was posted using tax code I0, which means that no tax is posted. In this 
case, the jurisdiction code is not significant. The displayed document should look as 
follows: 

 Account Description  

CR 3000 Vendor 100.00

DR 476000 Expense (G/L account) 100.00

Although the document looks exactly the same as invoice #1, the tax data shows that no 
taxes applied for this invoice. Choose  Tax data to display this information. 

Invoice #3: Payables invoice with interstate tax on sales/purchases 

This invoice was posted using tax code U1, which means that interstate tax on 
sales/purchases applies. Interstate tax is the responsibility of the person making the 
purchase and is not paid to the vendor. The tax value is calculated at a rate of 6.00%, 
the rate for jurisdiction PA0000000, which is linked to cost center 1000. The displayed 
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document should look as follows: 

 Account Description  

CR 3000 Vendor 100.00

DR 476000 Expense (G/L account) 106.00

CR 175001 State sales/purchase tax (G/L account) 6.00

Invoice #4: Payables invoice without interstate tax on sales/purchases 

This invoice was posted using tax code U0, which means that the item is not liable for 
interstate tax on sales/purchases and so no taxes are calculated or paid. The displayed 
document should look as follows: 

 Account Description  

CR 3000 Vendor 100.00

DR 476000 Expense (G/L account) 100.00

4. Choose  until the overview tree appears. 
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Posting Taxes in SD 
Use 
In this process, you post a customer sales order, deliver the product, and invoice the customer 
You post only one example where the item is taxable. Your results will vary depending on which 
tax indicator you use (S1 or S0) and what jurisdiction your customer is assigned to. (The results 
would be the same as those described in Displaying Taxes in FI: Accounts Receivable [Page 
96]). The purpose of this exercise is simply to demonstrate an example of posting in SD. 

Procedure 
Entering the order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. On the Create Sales Order: Initial Screen, enter the following data: 

Field Data 

Order type OR 

Sales organization 3000 

Distribution channel 10 

Division 00 

3. Choose . 

4. On the Create Standard Order: Overview screen, enter the following data: 

Field Data 

Sold-to party 3000 

Purch.order no. Enter a number of your choice 

Material P-103 

Order quantity 1 

5. Choose . 

A dialog box appears. 

6. Select the following data: 

Field Data 

Partner 3000 

7. Choose . 

8. Make a note of the order number and the requested delivery date. 

9. Choose  until the overview tree appears. 
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Posting the delivery 

Once the order has been posted, you need to deliver the product. 

1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Subsequent 
Functions → Outbound Delivery 

Transaction Code VL01N 

The Create Outbound Delivery with Order Reference screen appears. 

2. Enter the following data: 

Field Data 

Shipping point 3000 

Selection date Requested delivery date from the order you entered 

Order The order number you wrote down 

3. Choose . 

4. On the Create Delivery: Overview screen, choose Subsequent functions → Transfer order. 

5. On the Create Transfer Order for Delivery Note: Initial Screen, enter the following data: 

Field Data 

Warehouse number 300 

Plant 3000 

Process Flow Background 

Adopt picking quantity 2 

6. Choose . 

7. Your delivery is now posted. Make a note of the delivery number. 

8. Choose  until the overview tree appears. 

Posting the invoice 

Now you have to invoice the customer. You will see the taxes posted on the invoice. 

1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Subsequent 
Functions → Billing Document 

Transaction Code VF01 

The R/3 System displays your delivery number as the default value on the Create Billing 
Document screen. 

2. Save your entries and make a note of the document number. 

3. Remain on this screen. 
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Displaying Taxes in SD 
Use 
In this process, you display the billing document that was posted in Posting Taxes in SD [Page 
102]. Tax code S1 was automatically determined from the tax status of the material and the 
customer. Since tax code S1 is a taxable code, the R/3 System copied the tax jurisdiction code of 
the customer, IL0011000, and calculated state taxes at a rate of 6.25%. 

Procedure 
1. On the Create Billing Document screen, choose . 

2. The billing document number is displayed as the default value. Choose  Accounting. 

3. In the dialog box, choose Accounting document. 

The Document Overview screen appears. The accounting document created by billing 
should look as follows: 

 Account Description  

DR 3050 Customer 4,038.56

CR 800000 Sales revenues (G/L account) 3,801.00-

CR 175001 State sales/purchase tax (G/L account) 237.56-

4. To display the tax data, choose  Tax data. 

The tax amount was calculated as follows: 
Material price 3,801.00 

Minus discount 00.00 

Equals taxable value 3,801.00 

Multiplied by tax rate 6.25% 

Equals tax amount 237.56 

The receivable amount was calculated as follows: 
Material price 3,801.00 

Minus discount 00.00 

Plus tax amount 237.56 

Equals receivable amount 4,038.56 

5. Select  and  until the overview tree appears. 
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Posting Taxes in MM 
Use 
In MM, the tax codes appear as default values based on the settings made in Customizing. The 
IDES System is configured so that only purchase orders requiring an account assignment are 
taxable. When a purchase is made for stock or directly for a production order, tax code I0 
appears as a default value. If a purchase is made for a cost center, tax code I1 appears as a 
default value and the tax rate depends on the tax jurisdiction code that is linked to that cost 
center. If you want to have different default values for taxes in some situations, you can overwrite 
the default value in the info record. In this process, you post four different invoices using four 
different tax codes (I1, I0, U1, and U0). It is advisable to write down all numbers provided by the 
R/3 System. 

Procedure 
Entering a purchase order 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Create → Vendor/Supplying Plant Known 

Transaction Code ME21N 

2. On the Create Purchase Order screen, enter the following data: 

Field Data 

Vendor 3920 

Make sure that Standard PO is selected. 

3. Choose  Header. 

4. Choose the Org.data tab page, then enter the following data: 

Field Data 

Purchasing org. 3000 

Purchasing group 001 

Company code 3000 

When you generate invoices #2 to #4, a dialog box may appear, informing you that a 
purchase order already exists for today. In this case, choose New purchase order. 

5. Choose  Item overview. 

6. Enter the following data: 

Field Data 

Item number 10 

Material V10 

PO quantity 1 

Delivery date A few days in the future 
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Net price 100 

Plant 3000 New York 

Storage location Warehouse 0001 

 

A warning may appear. Confirm this warning by choosing . 

7. Select your item, then choose  Item detail. Confirm the warning message about the 
delivery date by choosing . 

The tax code that was selected appears on the Invoice tab page. Each example requires 
a different tax code. 

8. On the Invoice tab page, enter the following data: 

Field Data 

Tax code for invoice #1 I1 

Tax code for invoice #2 I0 

Tax code for invoice #3 U1 

Tax code for invoice #4 U0 

9. Choose . 

10. To view the tax condition record, select your item (by selecting the check box at the 
beginning of the row) and select Taxes 

A dialog box containing the default jurisdiction code appears. 

11. Choose . 

12. Write down the purchase order number.  

Repeat steps 2 to 12 for invoices #2 to #4. 

13. Choose  until the overview tree appears. 

Goods receipt 

1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Follow-On Functions → Goods Receipt 

Transaction Code MB01 

2. On the Goods Receipt for Purchase Order: Initial Screen, enter the following data: 

Field Data 

Movement type 101 

Purchase order The purchase order number you wrote down 

Plant 3000 

Storage location 0001 
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3. Choose . 

4. On the Goods Receipt for PO: Selection Screen... choose . 

5. Repeat steps 2 to 4 for invoices #2 to #4. 

6. Choose  until the overview tree appears. 

Invoice receipt  

1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Follow-On Functions → Logistics Invoice Verification 

Transaction Code MIRO 

2. On the Invoice Verification screen, enter the following data: 

Field Data 

Document date Date according to scheduling agreement 

Posting date Date according to scheduling agreement 

Amount for invoice #1 104.00 

Amount for invoice #2 100.00 

Amount for invoice #3 100.00 

Amount for invoice #4 100.00 

Tax code for invoice #1 I1 A/P sales tax, taxable 

Tax code for invoice #2 I0 A/P sales tax, exempt 

Tax code for invoice #3 U1 A/P use tax, taxable 

Tax code for invoice #4 U0 A/P use tax, exempt 

PO order/scheduling agreement Your purchase order number 

Calculate tax Select 

 
The tax code is not transferred from the purchase order because the R/3 System is 
configured to always use I0 as a default value. 

3. Choose . 

4. Choose . 

A warning message about an exception may appear. Skip this warning by choosing . 
The R/3 System posts your document automatically.  

5. Write down the document number. 

Repeat steps 2 to 6 for invoices #2 to #4. 

6. Choose  until the overview tree appears. 
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Displaying Taxes in MM 
Displaying the goods receipt document 

1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Material 
Document → Display 

Transaction Code MB03 

2. On the Display Material Document: Initial Screen, enter the following data: 

Field Data 

Material doc. Number of a GR document 

Mat. doc. year Current year 

3. Choose . 

4. On the Display Material Document... : Overview screen, choose Accounting documents. 

A dialog box appears in which you can select the document type. 

5. Choose Accounting document. 

The R/3 System displays the goods receipt document on the Document Overview 
screen. 

6. Choose  until the overview tree appears. 

Displaying the invoice receipt document 

1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Invoice Verification → Logistics 
Invoice Verification → Document Entry → Display Invoice Document 

Transaction Code MR3M 

2. On the Display Invoice/Credit Memo: Initial Screen, enter the following data: 

Field Data 

Invoice doc. number Number of IR document 

Fiscal year Current year 

3. Choose . 

4. On the Display Invoice/Credit Memo... Item List screen, choose Follow-on documents. 

5. In the dialog box, choose Accounting document. 

6. Choose  until the overview tree appears. 

Scenario 1: Invoice with sales tax (tax code I1) 

1. Display the goods receipt document. 

In this example, the invoice was for 104.00 and included taxes, which are to be paid to 
the vendor. Notice that the taxable value is reflected in the inventory value The document 
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should look as follows: 

 Account Description  

DR 300000 Inventory (G/L account) 104.00

CR 191100 GR/IR (G/L account) 104.00

2. Display the invoice receipt document. 

The document should look as follows: 

 Account Description  

CR 3920 Vendor 104.00

DR 191100 GR/IR (G/L account) 104.00

3. By choosing Goto → Tax data, you can see which jurisdiction code and which tax rates were 
used.  

Scenario 2: Invoice without sales tax (tax code I0) 

1. Display the goods receipt document. 

In this example, the invoice was for 100.00 and no taxes were included. The document 
should look as follows: 

 Account Description  

DR 300000 Inventory (G/L account) 100.00

CR 191100 GR/IR (G/L account) 100.00

2. Display the invoice receipt document. The document should look as follows: 

 Account Description  

CR 3920 Vendor 100.00

DR 191100 GR/IR (G/L account) 100.00

3. By choosing Goto → Tax data, you can see which jurisdiction code and which tax rates were 
used.  

Scenario 3: Invoice with use tax (tax code U1) 

1. Display the goods receipt document. 

In this example, the invoice is for 100.00. The tax is the responsibility of the person 
making the purchase and is not paid to the vendor. Notice that the taxable value is 
reflected in the inventory value The document should look as follows: 

 Account Description  

DR 300000 Inventory (G/L account) 104.00

CR 191100 GR/IR (G/L account) 104.00

2. Display the invoice receipt document. The document should look as follows: 

 Account Description  

CR 3920 Vendor 100.00

DR 191100 GR/IR (G/L account) 104.00
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CR 175001 State sales/purchase tax (G/L account) 4.00

3. By choosing Goto → Tax data, you can see which jurisdiction code and which tax rates were 
used. 

Scenario 4: Invoice without use tax (tax code U0) 

1. Display the goods receipt document. 

In this example, the invoice was for 100.00 and no taxes were included. The document 
should look as follows: 

 Account Description  

DR 300000 Inventory (G/L account) 100.00

CR 191100 GR/IR (G/L account) 100.00

2. Display the invoice receipt document. The document should look as follows: 

 Account Description  

CR 3920 Vendor 100.00

DR 191100 GR/IR (G/L account) 100.00

3. By choosing Goto → Tax data, you can see which jurisdiction code and which tax rates were 
used. 

4. Choose  until the overview tree appears. 
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 Closing Operations in Accounts Receivable and 
Accounts Payable Accounting 
Purpose 
In this process you will carry out year-end closing in Accounts Receivable and Accounts Payable.  

You will go through the following steps: 

• Generation of account statements: To check posted documents within a period. 

• Generation of balance confirmations: To check the number of receivables and payables. 

• Individual value adjustments using the special general ledger technique. 

• Valuation of open items in foreign currency with expense postings or revenue from exchange 
rate fluctuations. 

• Sorted lists of open items with regrouping of items for changed reconciliation account, 
vendors with a debit balance and customers with a credit balance according to remaining life. 

You can find more information about this process under  [Page 287]. 

 
To avoid output errors, check your print settings before starting this process chain. 

a. To do this, select System → User Profile → Own Data. 

b. In the Maintain User Profile screen, select the tab page Defaults, and make the following 
settings: 

Field Data 

Output device Name of printer you wish to use 

c. Choose . 

d. Choose  until the overview tree appears. 

Process Flow 
You can find the data for this process under  [Page 288]. 

1. Correspondence: Entering an Invoice [Page 289] 

2. Correspondence: Generating Account Statements [Page 291] 

3. Correspondence: Generating Balance Confirmations [Page 294] 

4. Individual Value Adjustments: Entering the Invoice [Page 297] 

5. Making Individual Value Adjustments for Doubtful Receivables [Page 299]  

6. Individual Value Adjustment: Display Customer Line Items [Page 302]  

7. Valuating Open Items in Foreign Currency: Entering an Invoice in Foreign Currency [Page 
303]  
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8. Valuating Open Items in Foreign Currency: Posting Exchange Rate Differences [Page 305]  

9. Valuation of Open Items in Foreign Currency: Display Document [Page 309]  

10. Allocation of Receivables and Payables According to Remaining Life: Enter Invoice [Page 
310]  

11. Allocation of Receivables and Payables According to remaining Life: Execute Program [Page 
312]  

12. Allocation of Receivables and Payables According to Remaining Life: Generate Postings 
[Page 314]  
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 Additional Process Information 
Open items are required for most of these transactions. In order to ensure that there will be open 
items available in the system, you should execute some simple invoices in Accounts Receivable 
or Accounts Payable Accounting before starting the closing program. 

To do this, you will have to enter the following kinds of documents: 

• Customer invoice in local currency for generating account statements and balance 
confirmations 

• Customer invoice in local currency for individual value adjustment 

• Customer invoice in foreign currency for valuation in foreign currency 

• Vendor invoice in foreign currency for valuation in foreign currency 

• Invoice with a remaining life of more than one year for allocation of receivables and 
payables according to remaining life. 

If other open items already exist in the system, they will also be evaluated and possibly transfer 
posted if they meet the selection criteria. 

You create customer and vendor invoices in a single-screen Enjoy transaction. 

For the customer invoice, the system automatically suggests tax code AN (16%) for company 
code 1000 and tax code S1 for company code 3000. 

For the vendor invoice, the system automatically suggests tax code VN for company code 1000 
and tax code I1 for company code 3000. 

In addition, the screen variants (transaction variants) are entered with business area and cost 
center. Relevant here is the G/L account, posting key, document currency amount, cost center or 
business area. 
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 Data Used During This Process 
Fields Europe North America Description 

Company code 1000 3000 Company code 

Chart of accounts INT INT Demo chart of accounts 

Currency DEM USD Local currency 

Reporting year 2000 2000 Demo reporting year (fiscal year) 

Comparison year 1999 1999 Previous year 

 

 

116  April 2001 



 SAP AG Financial Accounting (FI) 

  Correspondence: Entering an Invoice 

Correspondence: Entering an Invoice 
Use 
It is now easier to post invoices thanks to the new Enjoy functions. This simplification consists of 
a single-screen transaction. This means that you can now post customers, vendors and G/L 
accounts on one screen rather than individual screens.  

In this process step you post an invoice for a customer. Afterwards, in the next transaction, you 
can generate account statements. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70;FBL5 

The Customer Invoice Enter screen appears. 

2. Choose Environment → Set Company Code. In the dialog box, enter company code 1000 or 
3000, then choose . 

3. Choose  Tree on. 

4. On the Basic data tab page, enter the following data: 

Field Europe North America 

Customer 1000 3000 

Invoice date Today’s date - 1 month Today’s date - 1 month 

Posting date Today’s date - 1 month Today’s date - 1 month 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate (defaulted) DEM USD 

Calculate tax Select Select 

Tax code (defaulted) AN S1 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 12.000 12.000 

Business area 1000 1000 
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To simplify this process, we have not defined a cost element for account 800200. 
You do not therefore need an additional account assignment. The system does not 
transfer the data to Profit Center Accounting. 

5. Choose . 

Choose  if the system outputs any warning messages concerning the date. 

 
6. The system displays the address of the customer. To display the open items for this 

customer, choose  OIs. 

7. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

8. Choose . 

9. Choose  until the overview tree appears. 
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Correspondence: Generating Account Statements 
Use 
In this process step you generate account statements for IDES customers. The system only 
supplies account statements for those customers whose master data is maintained accordingly.  

You can find more information about this process under  [Page 293]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Print Correspondence → Periodic Account Statements 

Transaction Code F0,27;SP01 

2. On the Periodic Account Statements screen, enter the following data: 

Fields Europe North America 

Company code 1000 3000 

Indicator in master record 2 2 

Key dates for acct statement 1st to last day of the current 
month 

1st to last day of the current 
month 

Correspondence SAP06 (correspondence 
reference) 

SAP06 (correspondence 
reference) 

Delete if finished 8 days 8 days 

Log to printer Name of your printer Name of your printer 

3. Choose . 

The system creates a correspondence request for all customers where the field “Account 
statement” is filled in the customer’s master record, and matches the desired account 
statement (in our example it was a monthly account statement with indicator “2”). 

The system tells you that n periodic account statements were requested.  

4. Confirm this message with . 

5. The system tells you that n correspondence requests were selected. Confirm this message 
with Yes. 

The system generates your print requests and displays the spool number under which 
they are stored. 

6. To see and then print the generated account statements, choose 

System → Services → Output Controller.  

The system supplies your user name and today’s date. 

7. Choose . 

8. In the Output Controller: List of Spool Requests screen, select the spool request that you 
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generated in step 6 (Title “SAP06 .....”). 

9. Choose . 

The first page of the generated account statement is formatted for viewing.  

10. Choose Goto → List Display. 

All invoices for the customer that were posted in the selected period are listed on the 
Print Preview for XXX screen. Payments made in the period are listed as well. The 
balance is calculated at the end of the list. 

11. Choose  until you reach the Output Controller: List of Spool Requests screen again. 

12. Select your spool request, then choose . 

The account statements are then output on your printer. 

13. To update the screen display, choose . When printout is completed, the print file has 
“Compl.” status. 

14. Choose  until the overview tree appears. 
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 Additional Information for Creation of Account 
Statements 
Programs used for correspondence between your accounting department and your customers 
and vendors as well as for purely internal communication all fall into the category of automatic 
correspondence. 

While internal messages and payment notices for a customer are part of day-to-day activities, 
account statements and balance confirmations are typical examples of closing operations. 
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Correspondence: Generating Balance Confirmations 
Use 
In this transaction, you will generate balance confirmations. The system will also automatically 
generate forms for entering a reply for a customer/vendor as well as forms for entering return 
flow to your company.  

You can find more information about this process under  [Page 296]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Print Correspondence → Balance Confirmation → Print 
Letters 

Transaction Code F.17;SP01 

2. On the Customer Balance Confirmation screen, enter the following data: 

Fields Europe North America 

Customer 1000 3000 

Company code 1000 3000 

Reconciliation key date Last day of current period Last day of current period 

Individual customers Select Select 

Zero balances Select Select 

Correspondence sorting K2 (by account number) K2 (by account number) 

Line item sorting P3 (by document date, document 
number) 

P3 (by document date, document 
number) 

Date of issue 5th of the next period 5th of the next period 

Date for reply 30th of the next period 30th of the next period 

Reply to 00001 00001 

Print control Enter your printer settings here Enter your printer settings here 

3. Choose . 

The system creates a balance confirmation for exactly one customer as specified on the 
selection screen. 

Although a balance confirmation is several pages long, only the first page is displayed. 

4. To display the remaining pages, choose Goto → List Display. 

Along with the printout of this balance confirmation, you send your customer a list of their 
open items up to the key date and a reply form. 

5. Choose . 
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6. Choose  twice. 

A check list of accounts for which balance confirmations were generated is displayed. 

7. Choose . 

8. Choose . 

To make the return flow to the balance confirmations just generated more transparent, a 
summarized results table is also displayed at this point. 

9. Choose . 

10. Choose  again. 

On the Customer Balance Confirmation screen, the parameters you selected for the 
program are displayed. 

11. Choose  until the overview tree appears. 

12. Choose System → Services → Output Controller. 

The system supplies your user name and today’s date. 

13. Choose . 

The spool requests you created are displayed on the Output Controller: List of Spool 
Requests screen. 

14. Flag the spool requests, then choose . 

On the Spool: Output Request screen, check the name of the printer and select  until 
all requests have been printed. 

15. Choose  until the overview tree appears. 

 
You can create balance confirmations for vendors using the same procedure. The 
procedure is the same as for customer balances. 
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 Additional Information: Generating Balance 
Confirmations 
Balance confirmations can be generated from the debit or from the credit side. In both cases, for 
form structure type, we make a distinction between balance notification (negative inquiry), 
balance request (open method, request procedure), and balance confirmation (positive inquiry). 

For other situations that may arise, you can undertake a sample selection of customers/vendors 
who need to be informed in addition to selecting particular customers/vendors directly.  The 
scope of the sample is up to you. You may include aspects of external auditing or sample tests of 
your own accounts receivable/payable accounting. 
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Individual Value Adjustments: Entering the Invoice 
Use 
In the following process step, you will post overdue items for a customer so that you can make an 
individual value adjustment in the next transaction. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70 

The Customer Invoice Enter screen appears. 

2. Choose Environment → Set Company Code.  

3. Enter company code 1000 or 3000, then choose . 

 
(As this is an Enjoy transaction, the system suggests a company code for you). Make 
sure that the correct company code is specified when entering the invoice. If 
necessary, change the company code via Environment → Set Company Code. 
(Europe 1000, North America 3000). 

4. Choose  Tree on. 

5. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer 1320 3140 

Invoice date Today’s date - 6 months Today’s date - 6 months 

Posting date Today’s date - 6 months Today’s date - 6 months 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate (defaulted) DEM USD 

Calculate tax Select Select 

Tax code (defaulted) AN S1 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 12.000 12.000 

Business area 1000 1000 
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Choose  if the system outputs any warning messages concerning the date. 

 
To simplify this process, we have not defined a cost element for account 800200. 
You do not therefore need an additional account assignment. The system does not 
transfer the data to Profit Center Accounting. 

6. Choose . 

 
The system displays the address of the customer. To display the open items for this customer or 
the bank details, choose  OIs. 

7. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

8. Choose . 

9. Choose  until the overview tree appears. 
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Making Individual Value Adjustments for Doubtful 
Receivables 
Use 
In the previous transaction you entered a customer invoice. We will assume that the customer 
has not paid the invoice by the end of the year. You doubt whether this receivable will ever be 
paid, so you make a transfer posting for the receivable to an account for individual value 
adjustments. 

You can find more information about this process under  [Page 301]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
Entry → Other → Internal Transfer Posting → Without Clearing 

Transaction Code F-21 

2. On the Enter Transfer Posting: Header Data screen, enter the following data: 

Field Europe North America 

Document date Last day of current period Last day of current period 

Company code 1000 3000 

Posting date Last day of current period Last day of current period 

Currency DEM USD 

PstKy 19 19 

Account 1320 3140 

Sp.G/L E (Special G/L indicator for individual 
value adjustment) 

E (Special G/L indicator for individual 
value adjustment) 

The E indicator tells the system that this is a special general ledger transaction. In other 
words, the amount will not be posted to the customer’s normal reconciliation account but 
to a special account instead. 

The customer’s reconciliation account is 140000. The item you posted in the last 
transaction is also posted to this account. Using individual value adjustment, you will 
transfer post the item from account 140000 (domestic customer receivables) to account 
142000 (individual value adjustments to customer receivables. 

3. Choose . 

The system tells you that the document date is in the future. 

4. Confirm the message with . 

5. On the Enter Customer Document: Add Customer Item screen, enter the following data: 

Field Europe North America 
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Amount 12.000,00 12.000,00 

Due on 30. of the following month 30. of the following month 

Text Value adjustment Value adjustment 

PstKy (G/L account) 40 (Posting key) 40 (Posting key) 

Account (G/L account) 210100 (Expense from individual 
value adjustment) 

210100 (Expense from individual 
value adjustment) 

6. Choose . 

7. On the Enter Customer Document: Create G/L Account Item screen, enter the following data: 

Field Europe North America 

Amount * * 

Tax code A0 (no tax procedure) S0 (no tax procedure) 

Value date Last day of current period Last day of current period 

8. Choose , and then note the document number. 

9. Choose  until the overview tree appears. 
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 Additional Information on Individual Value 
Adjustment for Doubtful Receivables 
Individual value adjustments are posted using the special G/L technique. You can maintain 
receivables separately in a customer and in a receivables account. You can thus look over 
individual value adjustments separately from receivables and keep the adjustments in a special 
reconciliation account. 
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Individual Value Adjustment: Display Customer Line 
Items 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Account → 
Display/Change Line Items 

Transaction FBL5N 

2. On the Customer Line Item Display screen, enter the following data: 

Field Europe North America 

Customer account 1320 3140 

Company code 1000 3000 

Open items Select Select 

Open at key date Last day of current period Last day of current period 

Special G/L transactions Select Select 

Normal Items Select Select 

3. Choose . 

The Customer Line Item Display screen contains a list of customer line items. 

The receivable remains as an open item (untitled). The individual value adjustment is 
stated separately (titled ...Reserve for bad debt). 

4. Double-click on the receivables document. 

The first item in the document is displayed on the Display Document: Line Item 001 
screen. This is the customer item. 

In this case, the general ledger account is 140000 (domestic customer receivables). It is 
displayed in the G/L field in the upper right-hand corner of the screen. 

5. Choose  until you return to the Customer Line Item Display screen  

6. Double-click on the individual value adjustment document. 

The system displays the first item in the document. This is the customer item. 

The general ledger account in this case is 142000 (value adjustment to customer 
receivables). It is displayed in the G/L field in the upper right-hand corner of the screen. 

7. Choose  until the overview tree appears. 
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Valuating Open Items in Foreign Currency: Enter Invoice 
in Foreign Currency 
Use 
In the following transaction, you will post a vendor invoice in foreign currency so that you can 
valuate open items in foreign currency in the next transaction.  

 
You post the invoice directly in Financial Accounting, there is no integration with MM 
(Materials Management). This makes it easier to post backdated invoices. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document Entry → 
Invoice 

Transaction FB60 

The Vendor Invoice Enter screen appears. 

 
2. Choose Environment → Set company code. 

3. Enter company code 1000 or 3000, then choose . 

4. Choose  Tree on. 

5. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Vendor 1560 4940 

Invoice date 15.03.1999 15.03.1999 

Posting date 15.03.1999 15.03.1999 

Company code 1000 (IDES AG Frankfurt) 3000 (IDES US INC New York) 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate USD DEM 

Calculate tax Select Select 

Tax code V9 I0 

Table   

G/L account 415000 415000 

D/C (defaulted) Debit Debit 
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Document currency amount 12.000,- 12.000,- 

Tax code V9 I0 

Cost center 1000 1000 

6. Choose . 

 

The system tells you that your posting is in the past. Confirm with . Business area 
9900 is entered in the table automatically. 

Account 415000 requires an assignment to a CO object, as it is defined as a cost 
element. Therefore you require an additional account assignment, for example cost 
center 1000. 

The system displays the address of the vendor.  

7. Choose  Ols.  

The amount in local currency is displayed in the local currency amount field. Translation 
occurs according to the exchange rate valid at the time of posting. 

Amounts in foreign currency are always translated at the average rate in the IDES 
system. Document currency is the US Dollar. 

8. Choose . 

9. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

10. Choose . 

11. Make a note of the document number. You will need it for the next transaction. 

12. Choose  until the overview tree appears. 
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Valuating Open Items in Foreign Currency: Post 
Exchange Rate Differences 
Use 
In this procedure, you will valuate items in foreign currency at the end of a period in order to post 
expenses or revenues from currency valuation. To simplify the demo, you only run the program 
for an item you have just posted.  That way, other IDES users can also go through the demo with 
their own documents. 

If you ran the program for all open items in foreign currency, then all items posted to accounts 
that have open item management would be valuated. The individual valuation principle 
determines the way valuation is carried out: Only individual items that are still open on the key 
date are considered for valuation. 

Prerequisites 
The demo valuation method that is used for foreign currency valuation of open items functions 
according to the lowest value principle. This means a valuation is only carried out using the 
lowest exchange rate. It might, therefore, be necessary to enter appropriate rates in Customizing 
before you post the vendor invoice. Here is a list of data that we will need for this example: 

Field Europe North America 

Date 15.03.1999 15.03.1999 

Exchange rate type M M 

From DEM DEM 

To USD USD 

Rate 0,54 0,53 

Date Last day of current period Last day of current period 

Exchange rate type M M 

From DEM DEM 

To USD USD 

Rate 0,53 0,54 

You can find more information about this process under  [Page 308]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Periodic 
Processing → Closing → Valuate → Open Items in Foreign Currency 

Transaction Code F0,05 

2. On the Open Item Foreign Currency Valuation screen, enter the following data: 

Field Europe North America 
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Company code 1000 3000 

Key date for OI overview Last day of current period Last day of current period 

Bal.sheet preparation valuatn Select Select 

For. curr. valuation method DEMO DEMO 

“Postings” tab page   

Creating postings Select Select 

Posting date Last day of current period Last day of current period 

Name of batch input session User name User name 

“Selections” tab page   

Select vendors Select Select 

Vendor account number 1560 4940 

Document number Document number from 
previous transaction 

Document number from 
previous transaction 

“Other” tab strip   

Valuation in curr.type 10 10 

3. Choose . 

On the Open Item Foreign Currency Valuation screen, you see a log listing the postings 
that were made. The log is six pages long: 

• 1. Valuation of items in foreign currency of a selected vendor (for the items selected. 

• 2. Valuation of items in foreign currency from a reconciliation account for domestic vendor 
receivables (for the items selected). 

• 3. Valuation of all vendors in a company code (for selected items) 

• 4. Valuation of company code (for selected items). 

• 5. Valuation of all company codes (for selected items) 

• 6. List of postings to be generated and created documents with posting date and document 
number. 

4. Choose . 

5. On the Print Screen List screen, enter the following data: 

Field Europe North America 

Output device Name of your printer Name of your printer 

Print immediately Select Select 

Delete after output Select Select 

6. Choose Continue. The Open Item Foreign Currency Valuation screen appears. 

7. Choose Postings. 

The posting for expense from currency valuation is: 
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Debit → Account 230010 (expense from currency valuation) 

Credit → Account 161099 (foreign vendor receivables (adjustment account). 

 
If you do this procedure in 1998, the exchange rate between DEM and USD changes 
every month, so that a new valuation can be made every month. If you want to see 
this demonstrated, carry out the same procedure again for the same document, but 
this time one month later. 

On the first page of the log, you will notice that the item was valuated again, this time at 
the rate valid on the day of the valuation. 

On the last page, another amount is posted. The system uses the amount posted at the 
last valuation and only posts the difference. 

 
For a valuation that does not affect the balance sheet, all postings are reversed on 
the reversal date. 

8. Choose  until the overview tree appears. 
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 Additional Demo Information 
We entered fictitious exchange rates for 1999 for DEM/USD parity. Proceed as follows to 
maintain the rates yourself: 

1. Call up the transaction as follows: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit Project → SAP Reference 
IMG 

Transaction Code OB08 

2. Choose activity  Enter Exchange Rates. The Display View “Currency Exchange Rates”: 
Overview screen appears. 

3. Choose New Entries. 

4. On the New Entries: Overview of Added Entries screen, enter the following data: 

Field Europe North America 

ExRt M (Multicash) M (Multicash) 

From (currency) DEM DEM 

To (currency) USD USD 

Valid from Any Any 

Rate Any Any 

5. Choose . 

The Prompt for Customizing Request dialog box appears. 

6. Choose . 

7. In the Create Request dialog box, enter the following data: 

Field North America 

Short description Current exchange rate 

8. Choose . 

9. Choose . 

The system informs you that the data was saved. 

10. Choose  until the overview tree appears.  
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Valuation of Open Items in Foreign Currency: Display 
Document 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document → 
Display 

Transaction Code FB03 

2. Enter the document number from page 7 of the log. 

This is the document that was posted after the first foreign currency valuation. 

3. Choose . 

The system displays the document in foreign currency. The amounts have now been 
assigned. 

4. Choose  Choose. 

In the dialog box, choose: 

The amounts are now displayed in the local currency DEM. They correspond to the log 
amount. 

5. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Enter Invoice 
Use 
Invoices can be posted easily. This simplification consists of a single screen transaction. This 
means that you can now post customers, vendors and G/L accounts on one screen.  

In this transaction, you will enter a customer invoice that has a remaining life of more than a year. 
For this reason and also because of EU Guideline 4, the item has to be transfer posted to a 
special account if it is still open at the end of the period. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Prerequisites 
Tax code AN (16%) is automatically defaulted for company code 1000 and S1 for company code 
3000. We have also created a screen variant with a business area to be used as a work 
template. The ready-for-input columns are the G/L account, the posting key, the amount, the 
amount currency, and the business area. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70 

The Customer Invoice Enter screen appears. 

2. Choose Environment → Display document flow. 

3. Enter the version 1000, then choose . 

 

4. Choose . 

5. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer 1174 3176 

Invoice date Today’s date -1 months Today’s date -1 months 

Posting date Today’s date -1 months Today’s date -1 months 

Amount 100.000 (gross amount, 
including sales tax) 

100.000 (gross amount, 
including sales tax) 

Currency / rate (defaulted) DEM USD 
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Calculate tax Select Select 

Tax code (defaulted) AN S1 

Incoming payment   

Payt terms Empty Empty 

Group (first field) 720 days 720 days 

Days (other fields) Empty Empty 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 100.000 100.000 

Business area 1000 1000 

 
To simplify this process, we have not defined a cost element for account 800200, 
which means that you do not need to assign a CO object, for example, an order 
number. You do not therefore need an additional account assignment. The system 
does not transfer the data to Profit Center Accounting. 

6. Choose . 

 
The system displays the address of the customer. If you wanted to display the open items for this 
customer or the bank details, you could choose  OIs or  Bank Details. 

7. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

8. Choose . 

9. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Execute Program 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Closing → Regroup → Receivables/payables 

Transaction Code F101 

2. On the Balance Sheet Supplement – OI – Analysis per_ screen, enter the following data: 

Field Europe North America 

Company code 1000 3000 

Balance sheet key date Last day of current period Last day of current period 

“Selections” tab page    

Customer 1174 3176 

“Postings” tab page   

Carry out postings Select Select 

Batch input session name SAPF101 SAPF101 

Document type DR DR 

Posting date Last day of current period Last day of current period 

Posting period Current period Current period 

3. Choose . 

If any warning messages appear, choose . 

The system displays a log listing which postings were carried out. The log is 5 pages 
long: 

• 1. Valuation of domestic receivables with remaining life of more than one year (for selected 
items) 

• 2. Valuation of all receivables with remaining life of more than one year (for  

selected items) 

• 3. Valuation of all receivables in selected company code with 

remaining life of more than one year (for selected items) 

• 4. Valuation of all company codes (for selected items) 

• 5. List of documents to be generated with posting date and document number and 
specification of batch input session 

 
If you just executed the program for receivables, the system would have evaluated 
receivables with remaining lives of more than one and more than five years. 

140  April 2001 



 SAP AG Financial Accounting (FI) 

 Allocation of Receivables and Payables According to Remaining Life: Execute Program 

4. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Generate Postings 
Use 
The transfer postings to be generated are saved in a batch input session. In the next step you will 
process this session. 

Procedure 
1. Call up the transaction using the menu path as follows: 

Menu Path Choose System → Services → Batch Input → Sessions 

Transaction Code SM35 

2. On the Batch Input: Session Overview screen, choose the  tab page. 

3. Double-click on session SAPF101. 

4. Depending on the status of your session, you can view the session again under the 
appropriate tab page category. 

5. Select your session, then choose . 

6. Choose  Process.  

In the dialog box, select Display errors only, then choose Process.  

The system tells you that processing was completed successfully.  

7. Choose System → Services → Batch Input → Sessions again. 

8. On the Batch Input: Session Overview screen, your session should display the status 
Processed.  

9. Choose  until the overview tree appears. 

10. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
→ Display 

Transaction Code FB03 

The number of the document just posted is entered in the field automatically by the 
system. 

11. Choose . 

The posting appears as follows on the Document Overview screen: 

Credit → Account140020 (domestic customer receivables with remaining life of more 
than one year) 

Debit → Account 140099 (domestic customer receivables) 

12. Choose  until the overview tree appears. 
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To see what happens in Accounts Payable, you can now enter an invoice for a 
vendor on the same model where the remaining life is more than one year. 

Execute the program for allocation again, this time for account type K (vendor). 
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Accounts Receivable (FI-AR) 
1. Closing Operations in Accounts Receivable and Accounts Payable [Page 285] 

2. Dunning Customers [Page 145] 
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 Dunning Customers 
Purpose 
You use dunning to remind your customers that overdue items still need to be paid. The system 
lists the line items and prints dunning notices with the customer’s name and address, a text 
(which you can specify in Customizing), and the list of overdue items. 

In this process, you dun customers who have overdue receivables. 

Prerequisites 
You first create a customer with reference to an existing customer. You then post the overdue 
items (the posting date must be in the past). We have stored dunning procedure 0001 for the 
reference customer. This customer is to be sent dunning notices once every two weeks. 

You can find more information about this process under  [Page 146]. 

Process Flow 
You can find the data for this process under  [Page 147]. 

Creating the Master Data [Page 148]1.  

2. Posting the Overdue Items [Page 150] 

3. Maintaining the Parameters [Page 152] 

4. Scheduling the Dunning Run [Page 154] 

5. Sample Printout [Page 156] 

6. Printing the Dunning Notice [Page 157] 

7. Displaying the Customer Line Items [Page 159] 

8. Displaying the Customer Master Data [Page 160] 

9. Scheduling the Next Dunning Run [Page 161] 
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 Additional Process Information 
The dunning notices are generated automatically using the dunning program. This program 
determines which accounts and which items are to be dunned. It also determines the dunning 
level and creates the dunning notice, based on the relevant dunning level. The program prints the 
dunning notices and updates the dunning data in the overdue items and in the master data of the 
customer being dunned. 

You use a dunning procedure to control the dunning run. You can define as many dunning 
procedures as you require. You can also define multiple dunning levels for each dunning 
procedure. The system selects the dunning texts according to the dunning levels. 
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 Data Used During This Process 
Field Europe North America Description 

Customer Customer with 
reference 1175 

Customer with 
reference 3350 

 

Company code 1000 3000  

Document type DR DR Customer invoice 

Currency DEM USD Local currency 

Business area 1000 1000 Business area 

G/L account 800200 800200 Revenue account 

Identification Any alphanumeric entry Any alphanumeric entry Dunning run 
identification 
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 Displaying the Master Data 
Usage 
In this process step, you create a new customer for the dunning run. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Master 
Records → Create 

Transaction Code FD01 

2. On the Create Customer: Initial Screen, enter the following data: 

Field Europe North America 

Customer 1### (4 figure number between 
1000 and 1999) 

3### (4 figure number between 
3000 and 3999) 

Company code 1000 3000 

Customer (reference) 1175 3350 

Company code (reference) 1000 3000 

3. Choose . 

4. On the Create Customer: General Data screen enter the following data: 

Field Europe North America 

Description Customer Customer 

Search term Any Any 

Street Street Street 

City City City 

Postal code Postal code Postal code 

Country Country Country 

Region Region Region (State, US) 

Depending on the country in which you have created the customer, you will need to enter 
either a sales tax (VAT) registration number or a jurisdiction code (US). 

Europe: 
The sales tax number has the following form: 

Two-character country code + nine-digit number. 

Choose the Control data tab page, then enter the sales tax code in the Tax code 1 field. 

North America: 
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To enter a jurisdiction code, choose , then choose the F4 input help for the tax 
jurisdiction input field. In the dialog box, enter the state code. Choose , then double-
click on one of the codes in the list. 

5. Choose .   

 
You do not need to enter any further information, because the system automatically 
copies the required entries from the master data of the reference customer.  

6. Choose Company code data. 

7. On the Create Customer: Company Code Data screen, choose the Correspondence tab 
page. 

You can now see the dunning information. Dunning procedure 0001 represents a four-
stage dunning process. Dunning notices are sent every two weeks. Do not change the 
dunning settings. 

8. Choose . 

9. Choose  until the overview tree appears.  
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 Posting Overdue Items 
Usage 
You now post the overdue items for your customer. This customer will then be selected in the 
next dunning run. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Prerequisites 
Tax code AN (16%) is automatically defaulted for company code 1000 and S1 for company code 
3000. We have also created a screen variant with a business area to be used as a work 
template. The ready-for-input columns are the G/L account, the posting key, the amount, the 
amount currency, and the business area. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
Entry → Invoice 

FB70 Transaction 

 
If the Enter Company Code dialog box appears, enter your company code, then 
choose . 

2. If the structure tree has not been activated, choose  Tree on, then double-click on the 
screen variant With business area. 

3. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer Your customer Your customer 

Invoice date Today’s date -2 months Today’s date -2 months 

Company code (defaulted) 1000 (IDES AG Frankfurt) 3000 (IDES US INC New York) 

Posting date Today’s date -2 months Today’s date -2 months 

12000 (gross amount, 
including sales tax) 

12000 (gross amount, including 
sales tax) 

Currency / rate (defaulted) DEM USD 

Tax code (defaulted) AN S1 

G/L account 800200 800200 

Amount 
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D/C (defaulted) Credit Credit 

Document currency amount 12000 12000 

Business area 1000 1000 

Calculate tax Select Select 

 
To simplify this process, we have not defined a cost element for account 800200, 
which means that you do not need to assign a CO object, for example, an order 
number. You do not therefore need an additional account assignment. The system 
does not transfer the data to Profit Center Accounting. 

4. Choose . 

If any warning messages appear, choose . 

 
In addition to the payment terms, the system also displays the customer master data. If you 
wanted to display the open items for this customer or the bank details, you could choose  OIs 
or  Bank Details. 

5. Choose  Simulate. 

The Document Overview screen appears. You see the document with the account that 
has been posted to. 

6. Choose . 

The system informs you that the document has been posted in the company code. 

 
You should post at least 2 invoices. The invoices must be at least 6 days overdue in 
order to be dunned. 

7. Choose  and  until the overview tree appears. 
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 Maintaining the Parameters 
Usage 
You use the parameters to control which overdue items the system selects for dunning. In this 
process, you evaluate one customer’s open items, sorted by due date. In practice, however, you 
would define the parameters for multiple customers. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounts Receivable → Periodic Processing → Dunning 

Transaction Code F150 

2. On the Dunning screen, enter the following data: 

Field Europe North America 

Run on Today's date Today's date 

Identification Any alphanumeric entry Any alphanumeric entry 

The run date is used as the basis for clearing the interest on arrears. The identification is 
a six-figure alphanumeric definition of your choice. 

3. Choose .   

The status reads No parameters maintained. 

4. Choose the Parameter tab page. 

5. On the Dunning: Parameters screen, enter the following data: 

Field Europe North America 

Dunning date Today's date Today's date 

Docmnts posted up to Today's date Today's date 

Company code 1000 3000 

Customer account Your customer Your customer 

 
The next time you run this process, choose Edit → Copy and copy the parameters 
from one of your previous dunning runs. 

6. Choose the Additional log tab page. 

7. On the Dunning: Additional Log screen, enter the following data: 

8. Choose . 

9. Choose .   

The system informs you that the dunning run has been saved. 
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10. Choose the Status tab page. 

The status now reads Parameters were maintained. 

11. Remain on this screen.  
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 Scheduling the Dunning Run 
Usage 
You now execute the dunning run. The system analyzes all the open items for the customers you 
selected using the relevant parameters. It then determines whether dunning should be carried 
out for the items and, if appropriate, which dunning level should be used This process step is 
optional. The system has not yet printed any dunning notices, nor has it updated the open items 
or master data. 

Procedure 
1. On the Dunning screen, choose  Schedule. 

2. In the Schedule Selection and Print dialog box, select Start immediately. 

Check that today's date is entered as the start date. 

 
You do not schedule the printing of dunning notices at this stage, because you then 
have the option of editing the log. If you do schedule the printing of dunning notices 
here, all the dunning run data will be deleted after the notice has been printed. 

3. Choose  Schedule. 

The status now reads Dunning selection is running. 

Choose  until you see the status Dunning selection is complete. 

4. Choose  Log. 

You can now check to see which customers have been dunned and analyze the reasons 
why certain customers were excluded from the dunning run. 

The log also provides information about any errors, should they occur. 

5. Choose . 

6. You now check which invoices have been dunned. Choose  Dunning list. 

7. In the Dunning List Variant dialog box, choose . 

The log lists all overdue customer items for which dunning notices have been generated. 
You can see when the individual invoices were posted, and when they were due. 

The system also determines the number of days in arrears. You can also use the list to 
determine which dunning level a customer has reached, and which dunning procedure 
has been maintained in the master record. 

 
If the results of the dunning run are not as you expected, you need to delete the 
dunning run and then maintain the corresponding parameters again. 

8. Choose . 
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In the short term, you can remove an item from the dunning run. This can be useful if you 
have only just been informed that a customer has finally settled the bill. 

9. Choose  Change. 

10. On the FI Dunning screen, choose . 

The system selects all customers with overdue items. Due to the current parameters, you 
only see the open items for one customer. 

 
You could further restrict the selection fields to specific customers, vendors, 
company codes, and so on. 

11. To block the dunning run for a customer, or for specific items, position your cursor on the 
document number, then choose  Change dunning notice or  Change master data. 

Suppose you have just heard from your bank that you will receive payment for the 
invoice on the next working day. You therefore wish to remove this invoice from the 
dunning run. 

12. Choose  Change dunning notice. 

In the Change Dunning Notice dialog box, you can either block an entire dunning level in 
the Dunning Header area, or block an individual document in the Dunning line items 
area. 

13. In the Dunning line items area, use the F4 input help in the Dunning block column to choose 
block indicator A for your document. 

14. Choose Copy. 

15. Choose .   

16. Choose  until the Dunning screen appears. 
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 Sample Printout 
Usage 
You now display a model dunning notice on your screen. You print the dunning notices in the 
next process step. 

Procedure 
1. On the Dunning screen, choose  Sample printout. 

2. The Schedule Sample Printout dialog box appears. 

 
If you have not specified a printer in your user parameters, a dialog box appears. 
Enter the your printer ID, then choose Start immediately. Choose . 

3. Choose Print. 

 
You use the sample printout to check that the dunning template is okay. To change 
the layout, choose Environment → Maintain configuration. When you have changed 
the configuration, choose  Sample printout and confirm that you want to display 
the printout on the screen. Choose  Print. 

4. Choose  until the overview tree appears. 

 
At this stage, neither open items nor master data have been updated with the 
dunning data. It is still possible to delete the dunning proposal, change the 
parameters, and generate the proposal again. 
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 Printing the Dunning Notice 
Usage 
You now print out the dunning notices. Consequently, the system updates the overdue items and 
the master data with the dunning information. 

 
Once you have printed the dunning notices, you can no longer delete the dunning 
information, nor restart the dunning run with changed parameters. 

Procedure 
1. On the Dunning screen, choose  Dunning printout. 

2. In the Schedule Print dialog box, enter the following data: 

Field Europe North America 

Start immediately Select Select 

Output device Name of your printer Name of your printer 

3. Choose  Print. 

The status now reads Dunning printout is scheduled. 

4. Choose , until you see the status Dunning printout is complete. 

The system has now saved the dunning notices in a spool request. 

5. To create a new session, choose . 

6. On the SAP Easy Access screen, choose System → Services → Output controller. 

7. On the Output Controller: Spool Request Selection Screen, choose .  

8. Choose the Spool requests tab page. 

9. Enter the spool request number LIST1S. 

10. Choose the Output requests tab page. 

11. Choose Print. 

The system prints the dunning notices. 

12. Close this session. 

13. Choose  until the overview tree appears.  

 
The dunning level is increased by one for each customer who has been dunned. The 
dunning information is stored in each of the dunned invoices. If no payments are 
received within the next 14 days, you restart the dunning run. You can keep the 
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same name for the dunning run. Enter a new date and copy the parameters from the 
dunning run you have just executed. 
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 Displaying the Customer Line Items 
Usage 
You now call up one of the overdue items to see how the dunning data have been entered. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Account 
→ Display/Change Line Items 

Transaction Code FBL5N 

2. On the Customer Line Item Display screen, enter the following data: 

Field Europe North America 

Customer Your customer Your customer 

Company code 1000 3000 

Open items Select Select 

Display variant 1SAP-D 1SAP-D 

3. Choose .   

The system displays the list of the customer’s open items. This particular display 
contains information about the due date, the number of days in arrears, the dunning 
date, and the dunning level. 

4. Select one of the dunned items by double-clicking on it. 

On the Display Document: Line Item 001 screen, you see the last dunning date is shown 
in the Last dunned field. The dunning level is displayed in the field to the right of this. 

5. Choose  until the overview tree appears.  
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 Displaying the Customer Master Data 
Usage 
Once the dunning run has been executed, the dunning data is saved in the master data. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Master 
Records → Display 

Transaction Code FD03 

2. On the Display Customer: Initial Screen, enter the following data: 

Field Europe North America 

Customer Your customer Your customer 

Company code 1000 3000 

3. Choose . 

The Display Customer: Company Code Data screen appears. 

4. Choose the Correspondence tab page. 

You can see the dunning data in the Last dunned and Dunning level fields. 

5. Choose  until the overview tree appears. 
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 Scheduling the Next Dunning Run 
Usage 
You have executed an entire dunning run in this process. What happens if the customer does not 
settle the invoice, despite having received dunning notices?. 

You generally execute the dunning run on a regular basis (every two weeks in this example). All 
customers selected with the dunning parameters are analyzed by the system according to the 
following criteria: 

1. Has the date of the next run been reached? 

A customer can only be dunned within predefined intervals. The interval is dependent on 
the dunning procedure that is entered in the customer master data. For example, 
dunning procedure 0001 defines that the dunning run can be executed every two weeks. 
A dunning notice can only be sent to the customer when two weeks have elapsed since 
the last dunning notice was sent. Dunning runs which are executed in the meantime do 
not include the overdue items of this customer. 

 

2. When it is time for the customer to be dunned again, the system analyzes all open items. 

Every item that was dunned in the previous run is then assigned to the next dunning 
level. The same occurs in the master data. 
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 Closing Operations in Accounts Receivable and 
Accounts Payable Accounting 
Purpose 
In this process you will carry out year-end closing in Accounts Receivable and Accounts Payable.  

You will go through the following steps: 

• Generation of account statements: To check posted documents within a period. 

• Generation of balance confirmations: To check the number of receivables and payables. 

• Individual value adjustments using the special general ledger technique. 

• Valuation of open items in foreign currency with expense postings or revenue from exchange 
rate fluctuations. 

Sorted lists of open items with regrouping of items for changed reconciliation account, 
vendors with a debit balance and customers with a credit balance according to remaining life. 

• 

You can find more information about this process under  [Page 287]. 

 
To avoid output errors, check your print settings before starting this process chain. 

e. To do this, select System → User Profile → Own Data. 

f. In the Maintain User Profile screen, select the tab page Defaults, and make the following 
settings: 

Field Data 

Output device Name of printer you wish to use 

g. Choose . 

h. Choose  until the overview tree appears. 

Process Flow 
You can find the data for this process under  [Page 288]. 

13. Correspondence: Entering an Invoice [Page 28 ]9  

14. Correspondence: Generating Account Statements [Page 29 ]1  

15. Correspondence: Generating Balance Confirmations [Page 294] 

16. Individual Value Adjustments: Entering the Invoice [Page 29 ]7  

17. Making Individual Value Adjustments for Doubtful Receivables [Page 299]  

Individual Value Adjustment: Display Customer Line Items [Page 30 ]2  18.  

19. Valuating Open Items in Foreign Currency: Entering an Invoice in Foreign Currency [Page 
]  303
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20. Valuating Open Items in Foreign Currency: Posting Exchange Rate Differences [Page 305]  

21. Valuation of Open Items in Foreign Currency: Display Document [Page 309]  

22. Allocation of Receivables and Payables According to Remaining Life: Enter Invoice [Page 
]  310

23. Allocation of Receivables and Payables According to remaining Life: Execute Program [Page 
]  312

24. Allocation of Receivables and Payables According to Remaining Life: Generate Postings 
[Page 314]  
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 Additional Process Information 
Open items are required for most of these transactions. In order to ensure that there will be open 
items available in the system, you should execute some simple invoices in Accounts Receivable 
or Accounts Payable Accounting before starting the closing program. 

To do this, you will have to enter the following kinds of documents: 

• Customer invoice in local currency for generating account statements and balance 
confirmations 

• Customer invoice in local currency for individual value adjustment 

• Customer invoice in foreign currency for valuation in foreign currency 

• Vendor invoice in foreign currency for valuation in foreign currency 

• Invoice with a remaining life of more than one year for allocation of receivables and 
payables according to remaining life. 

If other open items already exist in the system, they will also be evaluated and possibly transfer 
posted if they meet the selection criteria. 

You create customer and vendor invoices in a single-screen Enjoy transaction. 

For the customer invoice, the system automatically suggests tax code AN (16%) for company 
code 1000 and tax code S1 for company code 3000. 

For the vendor invoice, the system automatically suggests tax code VN for company code 1000 
and tax code I1 for company code 3000. 

In addition, the screen variants (transaction variants) are entered with business area and cost 
center. Relevant here is the G/L account, posting key, document currency amount, cost center or 
business area. 
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 Data Used During This Process 
Fields Europe North America Description 

Company code 1000 3000 Company code 

Chart of accounts INT INT Demo chart of accounts 

Currency DEM USD Local currency 

Reporting year 2000 2000 Demo reporting year (fiscal year) 

Comparison year 1999 1999 Previous year 
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Correspondence: Entering an Invoice 
Use 
It is now easier to post invoices thanks to the new Enjoy functions. This simplification consists of 
a single-screen transaction. This means that you can now post customers, vendors and G/L 
accounts on one screen rather than individual screens.  

In this process step you post an invoice for a customer. Afterwards, in the next transaction, you 
can generate account statements. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Procedure 
10. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70;FBL5 

The Customer Invoice Enter screen appears. 

11. Choose Environment → Set Company Code. In the dialog box, enter company code 1000 or 
3000, then choose . 

12. Choose  Tree on. 

13. On the Basic data tab page, enter the following data: 

Field Europe North America 

Customer 1000 3000 

Invoice date Today’s date - 1 month Today’s date - 1 month 

Posting date Today’s date - 1 month Today’s date - 1 month 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate (defaulted) DEM USD 

Calculate tax Select Select 

Tax code (defaulted) AN S1 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 12.000 12.000 

Business area 1000 1000 
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To simplify this process, we have not defined a cost element for account 800200. 
You do not therefore need an additional account assignment. The system does not 
transfer the data to Profit Center Accounting. 

14. Choose . 

Choose  if the system outputs any warning messages concerning the date. 

 
15. The system displays the address of the customer. To display the open items for this 

customer, choose  OIs. 

16. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

17. Choose . 

18. Choose  until the overview tree appears. 
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Correspondence: Generating Account Statements 
Use 
In this process step you generate account statements for IDES customers. The system only 
supplies account statements for those customers whose master data is maintained accordingly.  

You can find more information about this process under  [Page 293]. 

Procedure 
15. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Print Correspondence → Periodic Account Statements 

Transaction Code F0,27;SP01 

16. On the Periodic Account Statements screen, enter the following data: 

North America Fields Europe 

Company code 1000 3000 

Indicator in master record 2 2 

Key dates for acct statement 1st to last day of the current 
month 

1st to last day of the current 
month 

Correspondence SAP06 (correspondence 
reference) 

SAP06 (correspondence 
reference) 

Delete if finished 8 days 8 days 

Log to printer Name of your printer Name of your printer 

17. Choose . 

The system creates a correspondence request for all customers where the field “Account 
statement” is filled in the customer’s master record, and matches the desired account 
statement (in our example it was a monthly account statement with indicator “2”). 

The system tells you that n periodic account statements were requested.  

18. Confirm this message with . 

19. The system tells you that n correspondence requests were selected. Confirm this message 
with Yes. 

The system generates your print requests and displays the spool number under which 
they are stored. 

20. To see and then print the generated account statements, choose 

System → Services → Output Controller.  

The system supplies your user name and today’s date. 

21. Choose . 

22. In the Output Controller: List of Spool Requests screen, select the spool request that you 
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generated in step 6 (Title “SAP06 .....”). 

23. Choose . 

The first page of the generated account statement is formatted for viewing.  

24. Choose Goto → List Display. 

All invoices for the customer that were posted in the selected period are listed on the 
Print Preview for XXX screen. Payments made in the period are listed as well. The 
balance is calculated at the end of the list. 

25. Choose  until you reach the Output Controller: List of Spool Requests screen again. 

26. Select your spool request, then choose . 

The account statements are then output on your printer. 

27. To update the screen display, choose . When printout is completed, the print file has 
“Compl.” status. 

28. Choose  until the overview tree appears. 
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 Additional Information for Creation of Account 
Statements 
Programs used for correspondence between your accounting department and your customers 
and vendors as well as for purely internal communication all fall into the category of automatic 
correspondence. 

While internal messages and payment notices for a customer are part of day-to-day activities, 
account statements and balance confirmations are typical examples of closing operations. 
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Correspondence: Generating Balance Confirmations 
Use 
In this transaction, you will generate balance confirmations. The system will also automatically 
generate forms for entering a reply for a customer/vendor as well as forms for entering return 
flow to your company.  

You can find more information about this process under  [Page 296]. 

Procedure 
16. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Print Correspondence → Balance Confirmation → Print 
Letters 

Transaction Code F.17;SP01 

17. On the Customer Balance Confirmation screen, enter the following data: 

Fields Europe North America 

Customer 1000 3000 

Company code 1000 3000 

Reconciliation key date Last day of current period Last day of current period 

Individual customers Select Select 

Zero balances Select Select 

Correspondence sorting K2 (by account number) K2 (by account number) 

Line item sorting P3 (by document date, document 
number) 

P3 (by document date, document 
number) 

Date of issue 5th of the next period 5th of the next period 

Date for reply 30th of the next period 30th of the next period 

Reply to 00001 00001 

Print control Enter your printer settings here Enter your printer settings here 

18. Choose . 

The system creates a balance confirmation for exactly one customer as specified on the 
selection screen. 

Although a balance confirmation is several pages long, only the first page is displayed. 

19. To display the remaining pages, choose Goto → List Display. 

Along with the printout of this balance confirmation, you send your customer a list of their 
open items up to the key date and a reply form. 

20. Choose . 
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21. Choose  twice. 

A check list of accounts for which balance confirmations were generated is displayed. 

22. Choose . 

23. Choose . 

To make the return flow to the balance confirmations just generated more transparent, a 
summarized results table is also displayed at this point. 

24. Choose . 

25. Choose  again. 

On the Customer Balance Confirmation screen, the parameters you selected for the 
program are displayed. 

26. Choose  until the overview tree appears. 

27. Choose System → Services → Output Controller. 

The system supplies your user name and today’s date. 

28. Choose . 

The spool requests you created are displayed on the Output Controller: List of Spool 
Requests screen. 

29. Flag the spool requests, then choose . 

On the Spool: Output Request screen, check the name of the printer and select  until 
all requests have been printed. 

30. Choose  until the overview tree appears. 

 
You can create balance confirmations for vendors using the same procedure. The 
procedure is the same as for customer balances. 
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 Additional Information: Generating Balance 
Confirmations 
Balance confirmations can be generated from the debit or from the credit side. In both cases, for 
form structure type, we make a distinction between balance notification (negative inquiry), 
balance request (open method, request procedure), and balance confirmation (positive inquiry). 

For other situations that may arise, you can undertake a sample selection of customers/vendors 
who need to be informed in addition to selecting particular customers/vendors directly.  The 
scope of the sample is up to you. You may include aspects of external auditing or sample tests of 
your own accounts receivable/payable accounting. 
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Individual Value Adjustments: Entering the Invoice 
Use 
In the following process step, you will post overdue items for a customer so that you can make an 
individual value adjustment in the next transaction. 

Procedure 
10. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70 

The Customer Invoice Enter screen appears. 

11. Choose Environment → Set Company Code.  

12. Enter company code 1000 or 3000, then choose . 

 
(As this is an Enjoy transaction, the system suggests a company code for you). Make 
sure that the correct company code is specified when entering the invoice. If 
necessary, change the company code via Environment → Set Company Code. 
(Europe 1000, North America 3000). 

13. Choose  Tree on. 

14. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer 1320 3140 

Invoice date Today’s date - 6 months Today’s date - 6 months 

Posting date Today’s date - 6 months Today’s date - 6 months 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate (defaulted) DEM USD 

Calculate tax Select Select 

Tax code (defaulted) AN S1 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 12.000 12.000 

Business area 1000 1000 
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Choose  if the system outputs any warning messages concerning the date. 

 
To simplify this process, we have not defined a cost element for account 800200. 
You do not therefore need an additional account assignment. The system does not 
transfer the data to Profit Center Accounting. 

15. Choose . 

 
The system displays the address of the customer. To display the open items for this customer or 
the bank details, choose  OIs. 

16. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

17. Choose . 

18. Choose  until the overview tree appears. 
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Making Individual Value Adjustments for Doubtful 
Receivables 
Use 
In the previous transaction you entered a customer invoice. We will assume that the customer 
has not paid the invoice by the end of the year. You doubt whether this receivable will ever be 
paid, so you make a transfer posting for the receivable to an account for individual value 
adjustments. 

You can find more information about this process under  [Page 301]. 

Procedure 
10. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
Entry → Other → Internal Transfer Posting → Without Clearing 

Transaction Code F-21 

11. On the Enter Transfer Posting: Header Data screen, enter the following data: 

Field Europe North America 

Document date Last day of current period Last day of current period 

Company code 1000 3000 

Posting date Last day of current period Last day of current period 

Currency DEM USD 

PstKy 19 19 

Account 1320 3140 

Sp.G/L E (Special G/L indicator for individual 
value adjustment) 

E (Special G/L indicator for individual 
value adjustment) 

The E indicator tells the system that this is a special general ledger transaction. In other 
words, the amount will not be posted to the customer’s normal reconciliation account but 
to a special account instead. 

The customer’s reconciliation account is 140000. The item you posted in the last 
transaction is also posted to this account. Using individual value adjustment, you will 
transfer post the item from account 140000 (domestic customer receivables) to account 
142000 (individual value adjustments to customer receivables. 

12. Choose . 

The system tells you that the document date is in the future. 

13. Confirm the message with . 

14. On the Enter Customer Document: Add Customer Item screen, enter the following data: 

Field Europe North America 
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Amount 12.000,00 12.000,00 

Due on 30. of the following month 30. of the following month 

Text Value adjustment Value adjustment 

PstKy (G/L account) 40 (Posting key) 40 (Posting key) 

Account (G/L account) 210100 (Expense from individual 
value adjustment) 

210100 (Expense from individual 
value adjustment) 

15. Choose . 

16. On the Enter Customer Document: Create G/L Account Item screen, enter the following data: 

Field Europe North America 

Amount * * 

Tax code A0 (no tax procedure) S0 (no tax procedure) 

Last day of current period Value date Last day of current period 

17. Choose , and then note the document number. 

18. Choose  until the overview tree appears. 
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 Additional Information on Individual Value 
Adjustment for Doubtful Receivables 
Individual value adjustments are posted using the special G/L technique. You can maintain 
receivables separately in a customer and in a receivables account. You can thus look over 
individual value adjustments separately from receivables and keep the adjustments in a special 
reconciliation account. 
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Individual Value Adjustment: Display Customer Line 
Items 
8. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Account → 
Display/Change Line Items 

Transaction FBL5N 

9. On the Customer Line Item Display screen, enter the following data: 

Field Europe North America 

Customer account 1320 3140 

Company code 1000 3000 

Open items Select Select 

Open at key date Last day of current period Last day of current period 

Select Select 

Normal Items Select Select 

Special G/L transactions 

10. Choose . 

The Customer Line Item Display screen contains a list of customer line items. 

The receivable remains as an open item (untitled). The individual value adjustment is 
stated separately (titled ...Reserve for bad debt). 

11. Double-click on the receivables document. 

The first item in the document is displayed on the Display Document: Line Item 001 
screen. This is the customer item. 

In this case, the general ledger account is 140000 (domestic customer receivables). It is 
displayed in the G/L field in the upper right-hand corner of the screen. 

12. Choose  until you return to the Customer Line Item Display screen  

13. Double-click on the individual value adjustment document. 

The system displays the first item in the document. This is the customer item. 

The general ledger account in this case is 142000 (value adjustment to customer 
receivables). It is displayed in the G/L field in the upper right-hand corner of the screen. 

14. Choose  until the overview tree appears. 
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Valuating Open Items in Foreign Currency: Enter Invoice 
in Foreign Currency 
Use 
In the following transaction, you will post a vendor invoice in foreign currency so that you can 
valuate open items in foreign currency in the next transaction.  

 
You post the invoice directly in Financial Accounting, there is no integration with MM 
(Materials Management). This makes it easier to post backdated invoices. 

Procedure 
13. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document Entry → 
Invoice 

Transaction FB60 

The Vendor Invoice Enter screen appears. 

 
14. Choose Environment → Set company code. 

15. Enter company code 1000 or 3000, then choose . 

16. Choose  Tree on. 

17. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Vendor 1560 4940 

Invoice date 15.03.1999 15.03.1999 

Posting date 15.03.1999 15.03.1999 

Company code 1000 (IDES AG Frankfurt) 3000 (IDES US INC New York) 

12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate USD DEM 

Calculate tax Select Select 

Tax code V9 I0 

Table   

G/L account 415000 415000 

D/C (defaulted) Debit Debit 

Amount 
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Document currency amount 12.000,- 12.000,- 

Tax code V9 I0 

Cost center 1000 1000 

18. Choose . 

 

The system tells you that your posting is in the past. Confirm with . Business area 
9900 is entered in the table automatically. 

Account 415000 requires an assignment to a CO object, as it is defined as a cost 
element. Therefore you require an additional account assignment, for example cost 
center 1000. 

The system displays the address of the vendor.  

19. Choose  Ols.  

The amount in local currency is displayed in the local currency amount field. Translation 
occurs according to the exchange rate valid at the time of posting. 

Amounts in foreign currency are always translated at the average rate in the IDES 
system. Document currency is the US Dollar. 

20. Choose . 

21. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

22. Choose . 

23. Make a note of the document number. You will need it for the next transaction. 

24. Choose  until the overview tree appears. 
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Valuating Open Items in Foreign Currency: Post 
Exchange Rate Differences 
Use 
In this procedure, you will valuate items in foreign currency at the end of a period in order to post 
expenses or revenues from currency valuation. To simplify the demo, you only run the program 
for an item you have just posted.  That way, other IDES users can also go through the demo with 
their own documents. 

If you ran the program for all open items in foreign currency, then all items posted to accounts 
that have open item management would be valuated. The individual valuation principle 
determines the way valuation is carried out: Only individual items that are still open on the key 
date are considered for valuation. 

Prerequisites 
The demo valuation method that is used for foreign currency valuation of open items functions 
according to the lowest value principle. This means a valuation is only carried out using the 
lowest exchange rate. It might, therefore, be necessary to enter appropriate rates in Customizing 
before you post the vendor invoice. Here is a list of data that we will need for this example: 

Field Europe North America 

Date 15.03.1999 15.03.1999 

Exchange rate type M M 

From DEM DEM 

To USD USD 

Rate 0,54 0,53 

Date Last day of current period Last day of current period 

Exchange rate type M M 

From DEM DEM 

To USD USD 

Rate 0,53 0,54 

You can find more information about this process under  [Page 308]. 

Procedure 
9. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Periodic 
Processing → Closing → Valuate → Open Items in Foreign Currency 

Transaction Code F0,05 

10. On the Open Item Foreign Currency Valuation screen, enter the following data: 

Field Europe North America 
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Company code 1000 3000 

Key date for OI overview Last day of current period Last day of current period 

Bal.sheet preparation valuatn Select Select 

For. curr. valuation method DEMO DEMO 

“Postings” tab page   

Creating postings Select Select 

Posting date Last day of current period Last day of current period 

Name of batch input session User name User name 

“Selections” tab page   

Select vendors Select Select 

Vendor account number 1560 4940 

Document number Document number from 
previous transaction 

Document number from 
previous transaction 

“Other” tab strip   

Valuation in curr.type 10 10 

11. Choose . 

On the Open Item Foreign Currency Valuation screen, you see a log listing the postings 
that were made. The log is six pages long: 

• 1. Valuation of items in foreign currency of a selected vendor (for the items selected. 

• 2. Valuation of items in foreign currency from a reconciliation account for domestic vendor 
receivables (for the items selected). 

• 3. Valuation of all vendors in a company code (for selected items) 

• 4. Valuation of company code (for selected items). 

• 5. Valuation of all company codes (for selected items) 

• 6. List of postings to be generated and created documents with posting date and document 
number. 

12. Choose . 

13. On the Print Screen List screen, enter the following data: 

Field Europe North America 

Output device Name of your printer Name of your printer 

Print immediately Select Select 

Delete after output Select Select 

14. Choose Continue. The Open Item Foreign Currency Valuation screen appears. 

15. Choose Postings. 

The posting for expense from currency valuation is: 
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Debit → Account 230010 (expense from currency valuation) 

Credit → Account 161099 (foreign vendor receivables (adjustment account). 

 
If you do this procedure in 1998, the exchange rate between DEM and USD changes 
every month, so that a new valuation can be made every month. If you want to see 
this demonstrated, carry out the same procedure again for the same document, but 
this time one month later. 

On the first page of the log, you will notice that the item was valuated again, this time at 
the rate valid on the day of the valuation. 

On the last page, another amount is posted. The system uses the amount posted at the 
last valuation and only posts the difference. 

 
For a valuation that does not affect the balance sheet, all postings are reversed on 
the reversal date. 

16. Choose  until the overview tree appears. 
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 Additional Demo Information 
We entered fictitious exchange rates for 1999 for DEM/USD parity. Proceed as follows to 
maintain the rates yourself: 

11. Call up the transaction as follows: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit Project → SAP Reference 
IMG 

Transaction Code OB08 

12. Choose activity  Enter Exchange Rates. The Display View “Currency Exchange Rates”: 
Overview screen appears. 

13. Choose New Entries. 

14. On the New Entries: Overview of Added Entries screen, enter the following data: 

Field Europe North America 

ExRt M (Multicash) M (Multicash) 

From (currency) DEM DEM 

To (currency) USD USD 

Valid from Any Any 

Rate Any Any 

15. Choose . 

The Prompt for Customizing Request dialog box appears. 

16. Choose . 

17. In the Create Request dialog box, enter the following data: 

Field North America 

Short description Current exchange rate 

18. Choose . 

19. Choose . 

The system informs you that the data was saved. 

20. Choose  until the overview tree appears.  
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Valuation of Open Items in Foreign Currency: Display 
Document 
6. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document → 
Display 

Transaction Code FB03 

7. Enter the document number from page 7 of the log. 

This is the document that was posted after the first foreign currency valuation. 

8. Choose . 

The system displays the document in foreign currency. The amounts have now been 
assigned. 

9. Choose  Choose. 

In the dialog box, choose: 

The amounts are now displayed in the local currency DEM. They correspond to the log 
amount. 

10. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Enter Invoice 
Use 
Invoices can be posted easily. This simplification consists of a single screen transaction. This 
means that you can now post customers, vendors and G/L accounts on one screen.  

In this transaction, you will enter a customer invoice that has a remaining life of more than a year. 
For this reason and also because of EU Guideline 4, the item has to be transfer posted to a 
special account if it is still open at the end of the period. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Prerequisites 
Tax code AN (16%) is automatically defaulted for company code 1000 and S1 for company code 
3000. We have also created a screen variant with a business area to be used as a work 
template. The ready-for-input columns are the G/L account, the posting key, the amount, the 
amount currency, and the business area. 

Procedure 
10. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70 

The Customer Invoice Enter screen appears. 

11. Choose Environment → Display document flow. 

12. Enter the version 1000, then choose . 

 

13. Choose . 

14. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer 1174 3176 

Invoice date Today’s date -1 months Today’s date -1 months 

Posting date Today’s date -1 months Today’s date -1 months 

Amount 100.000 (gross amount, 
including sales tax) 

100.000 (gross amount, 
including sales tax) 

Currency / rate (defaulted) DEM USD 
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Calculate tax Select Select 

Tax code (defaulted) AN S1 

Incoming payment   

Payt terms Empty Empty 

Group (first field) 720 days 720 days 

Days (other fields) Empty Empty 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 100.000 100.000 

Business area 1000 1000 

 
To simplify this process, we have not defined a cost element for account 800200, 
which means that you do not need to assign a CO object, for example, an order 
number. You do not therefore need an additional account assignment. The system 
does not transfer the data to Profit Center Accounting. 

15. Choose . 

 
The system displays the address of the customer. If you wanted to display the open items for this 
customer or the bank details, you could choose  OIs or  Bank Details. 

16. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

17. Choose . 

18. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Execute Program 
5. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Closing → Regroup → Receivables/payables 

Transaction Code F101 

6. On the Balance Sheet Supplement – OI – Analysis per_ screen, enter the following data: 

Field Europe North America 

1000 3000 

Balance sheet key date Last day of current period Last day of current period 

“Selections” tab page    

3176 

“Postings” tab page   

Carry out postings Select Select 

SAPF101 SAPF101 

Document type DR DR 

Posting date Last day of current period Last day of current period 

Posting period Current period Current period 

Company code 

Customer 1174 

Batch input session name 

7. Choose . 

If any warning messages appear, choose . 

The system displays a log listing which postings were carried out. The log is 5 pages 
long: 

• 1. Valuation of domestic receivables with remaining life of more than one year (for selected 
items) 

• 2. Valuation of all receivables with remaining life of more than one year (for  

selected items) 

• 3. Valuation of all receivables in selected company code with 

remaining life of more than one year (for selected items) 

• 4. Valuation of all company codes (for selected items) 

• 5. List of documents to be generated with posting date and document number and 
specification of batch input session 

 
If you just executed the program for receivables, the system would have evaluated 
receivables with remaining lives of more than one and more than five years. 
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8. Choose  until the overview tree appears. 

 

 

190  April 2001 



 SAP AG Financial Accounting (FI) 

 Allocation of Receivables and Payables According to Remaining Life: Generate Postings 

Allocation of Receivables and Payables According to 
Remaining Life: Generate Postings 
Use 
The transfer postings to be generated are saved in a batch input session. In the next step you will 
process this session. 

Procedure 
13. Call up the transaction using the menu path as follows: 

Menu Path Choose System → Services → Batch Input → Sessions 

Transaction Code SM35 

14. On the Batch Input: Session Overview screen, choose the  tab page. 

15. Double-click on session SAPF101. 

16. Depending on the status of your session, you can view the session again under the 
appropriate tab page category. 

17. Select your session, then choose . 

18. Choose  Process.  

In the dialog box, select Display errors only, then choose Process.  

The system tells you that processing was completed successfully.  

19. Choose System → Services → Batch Input → Sessions again. 

20. On the Batch Input: Session Overview screen, your session should display the status 
Processed.  

21. Choose  until the overview tree appears. 

22. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
→ Display 

Transaction Code FB03 

The number of the document just posted is entered in the field automatically by the 
system. 

23. Choose . 

The posting appears as follows on the Document Overview screen: 

Credit → Account140020 (domestic customer receivables with remaining life of more 
than one year) 

Debit → Account 140099 (domestic customer receivables) 

24. Choose  until the overview tree appears. 
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To see what happens in Accounts Payable, you can now enter an invoice for a 
vendor on the same model where the remaining life is more than one year. 

Execute the program for allocation again, this time for account type K (vendor). 
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Asset Accounting (FI-AA) 
Creating a Fixed Asset [Page 19 ]4  
Goods Issue for Fixed Assets [Page 20 ]3  
Posting a Post-Capitalization [Page 207] 
Intracompany Transfers [Page 21 ]2  
Depreciation Adjustments and Write-Ups [Page 218] 
Investment Support [Page 229] 
Leasing Processing [Page 236] 
Fixed Asset Retirement [Page 25 ]0  
Intercompany Asset Transfers [Page 25 ]6  
Enhancements to Asset Accounting When Using Parallel Currencies in FI [Ext.] 
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 Creating an Fixed Asset 
Purpose 
You create a master record for your new fixed asset before you create the purchase order. The 
purchase order is then assigned to the fixed asset. When you post the goods receipt or invoice 
receipt, the system automatically capitalizes the asset. 

Creating the asset master record before the purchase order may be problematic from an 
organizational perspective. You therefore have the option of initially creating a purchase 
requisition that is not assigned to an account. You can then enter the asset in the purchase order 
generated by the purchase requisition. 

Process Flow 
You can find the data for this process under  [Page 195]. 

1. You first Create an Asset Master Record [Page 196]. 

2. You then Create a Purchase Order [Page 197], which you assign to the new fixed asset. 

Once the ordered PC has been delivered, you can Post the Goods Issue [Page 19 ]9 . 3. 

4. Following the delivery, you are sent the invoice. You Post the Incoming Invoice [Page 200] in 
the system. 

5. In the final process step, you check the value changes on your fixed asset. Choose 
Displaying the Asset in the Asset Explorer [Page 264]. 
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Data Used During This Process 
Fields Data Description 

Asset class 3200 Personal computers 

Company code 1000 IDES AG 

Business area 9900 Corporate/other 

Cost center 4120 IT Service 

Vendor 1000  

Plant 1000 Hamburg 

Storage location 0001  

Purch. organization IDES Germany  

Purchasing group Lux, L  
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Creating the Asset Master Record 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → 
Asset 

Transaction Code AS01 

You must assign one asset class to each asset master record. The asset classes are used to 
structure the fixed assets, as well as to store control parameters and default values for 
depreciation accounting. 

The asset classes are also used to define the accounts that are to be posted to in Financial 
Accounting. Asset class 3200 is for Personal Computers. 

2. Enter the following data: 

Field Data 

Asset class 3200 

Company code 1000 

3. Choose . 

4. Enter the following data: 

Field Data 

Description Any, for example, the name of your PC 

5. Choose the Time-Dependent tab page, then enter the following data: 

Field Data 

Business area 9900 

Cost center 4120 

Plant 1000 

6. Choose . 

7. The system informs you that "Asset ####-0 has been created". #### is the asset number. 
The "0" is the asset sub-number, which you can use to further define the asset structure. 
Make a note of this asset number. 

8. Choose . 
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Creating a Purchase Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Create → Vendor/supplying plant known 

Transaction Code ME21N 

2. Enter the following data: 

Field Data 

Order type Standard purchase order 

Vendor 1000 

3. Choose  Header, then enter the following data: 

Field Data 

Purch. organization IDES Germany 

Purchasing group Lux, L 

4. Choose  Item Overview, then enter the following data: 

Field Data 

Account assignment category A 

Any (Name of your PC) 

PO quantity 1 

OU PC 

Delivery date Four weeks from today's date 

Net price 5000 

Material group 012 

Storage location 0001 

Description 

Plant 1000 

5. Choose  Item details.  

6. On the Account assignment tab page, enter the following data: 

Field Data 

Asset Your asset number 

7. Choose . 

8. The system informs you that "Standard PO #### has been created". Note the purchase order 
number. 

9. Choose . 
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Posting the Goods Receipt 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → For Purchase Order → PO Number 
Known 

Transaction Code MIGO 

2. Enter the following data: 

Field Data 

PO number (3rd field) Your PO number from the previous process step 

3. Choose . 

4. To confirm the goods receipt, select the OK field in item line 1 at the bottom of the screen. 

5. Choose . 

The system informs you that "Material Document #### has been posted". 

6. Choose . 
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Posting the Invoice Receipt 

Menu Path 

Procedure 
1. Call up the transaction as follows: 

Logistics → Materials Management → Invoice Verification → Invoice 
Verification → Document Entry → Enter Invoice 

Transaction Code MRHR 

2. Enter the following data: 

Field Data 

Document date Today‘s date 

Purchase order Your purchase order 

3. Choose . 

 
We assume that the invoiced amount is 500 more than the ordered amount. As input 
tax must be paid in the IDES company code, we need to add the input tax to the total 
amount of 5,500. This gives an amount of 6,380. 

4. Enter the following data: 

Field Data 

Amount 6380 

Calculate tax Select 

Tax code VN (enter twice or delete the second tax indicator) 

5. Choose . 

6. Enter the following data: 

Field Data 

Amount 5500 

Quantity 1 

7. Choose . 

The system issues a warning message Price too high: Tolerance limit exceeded. 

8. Choose . 

9. To skip any other warning messages, choose . 

10. Choose . 
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Result 
The system informs you that the document has been created, but locked for payment. 
Due to the price differences that occurred and the exceeding of the tolerance limit, the 
system sets a block indicator for the active invoice verification. This means that the 
document can only be selected and paid after it has been explicitly released, for 
example, through automatic payment transactions. 
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Displaying the Asset in the Asset Explorer 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

2. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

3. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

4. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

5. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

6. Choose . 
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 Goods Issue for Fixed Assets 
Purpose 
We assume that you still need to withdraw materials from the warehouse for the PC that you 
bought in the IDES process Buying a Fixed Asset [Page 194]. In the integrated system, these 
warehouse stocks can be capitalized directly on the fixed asset. The system automatically 
executes the necessary transfer posting from current assets into fixed assets as a background 
job. 

 Prerequisites
If you have not yet run the IDES process Buying a Fixed Asset, you will first need to execute the 
process step Creating an Asset Master Record [Page 196]. Otherwise, you can continue to work 
with the fixed asset you already created. 

Process Flow 
You can find the data for this process under  [Page 204]. 

1. You first Post the Goods Issue [Page 205]. 

2. You can then check the value changes on your fixed asset. Choose Displaying the Asset in 
the Asset Explorer [Page 264]. 
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Data Used During This Process 
Fields Europe North America Description 

Plant 1200 3200 Plant for the goods issue 
from the warehouse 

0001 0001 Material storage 

Material DPC1003 DPC1003 Sample material 

Transaction type 241 241 Consumption for assets from 
the warehouse 

Asset Your asset number Your asset number  

Storage location 
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Posting the Goods Issue 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Issue 

Transaction Code MB1A 

2. Enter the following data: 

Field Europe North America 

Transaction type 241 241 

Plant 1200 (Dresden) 3200 

Storage location 0001 (material warehouse) 0001 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Asset Your asset number Your asset number 

Material DPC1003 DPC1003 

Quantity 1 1 

UnE PC PC 

5. Choose . 

6. The system informs you that "Material document #### has been posted". Note the number of 
the goods issue. 

7. Choose . 
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Displaying the Asset in the Asset Explorer 
7. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

8. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

9. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

10. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

11. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

12. Choose . 
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 Posting a Post-Capitalization 
Purpose 
In this IDES process, you capitalize an asset for a fiscal year in which the asset was not originally 
capitalized. This posting, however, is to be made for a fiscal year that is already closed. This 
process would generally take place as part of a government tax audit. 

Process Flow 
You can find the data for this process under  [Page 208]. 

1. You first Create an Asset for Post-Capitalization [Page 209]. The capitalization date for this 
asset is the date of the original acquisition. 

2. You then Post the Post-Capitalization [Page 21 ]0 . At this point, you enter the historical 
acquisition value. 

3. To analyze the values of your asset, you Display the Asset History Sheet [Page 227] an. 
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Data Used During This Process 
Fields Europe North America Description 

Asset class 3100 3100 Vehicles 

Company code 1000 3000 IDES AG 

Business area 9900 9900 Corporate/other 

Offsetting account 299000 299000  

Cost center 1220 1220 Vehicles 

Capitalization date 1st July, 3 years ago 1st July, 3 years ago  

Tax jurisdiction code - PA0000000 Tax jurisdiction code 

Sort version 0007 0007  

List assets Select Select  

History sheet version 0001 0001 HGB §268 
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Creating an Asset for Post-Capitalization 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → 
Asset 

Transaction Code AS01 

2. Enter the following data: 

Field Europe North America 

Asset class 3100 (Vehicles) 3100 

Company code 1000 3000 

Post-Capitalization Select Select 

3. Choose . 

4. On the General tab page, enter the following data: 

Field Europe North America 

Description Car trailer Car trailer 

Capitalized on 1st July, 3 years ago 1st July, 3 years ago 

5. Choose . 

In the First acquired on field, the system automatically stores the capitalization date as 
the reference date for the first acquisition posting. 

6. Choose the Time-Dependent tab page, then enter the following data: 

Field Europe North America 

Business area 9900 (Corporate/other) 9900 

Cost center 1220 (Vehicles) 1220 

Tax jurisdiction code - PA0000000 

7. Choose . 

8. Make a note of this asset number. 

9. Choose . 
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Posting the Post-Capitalization 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → Post-
Capitalization 

Transaction Code ABNAN 

2. Enter the following data: 

Field Europe North America 

Asset Your asset number Your asset number 

3. On the Transaction Data tab page, enter the following data: 

Field Europe North America 

Amount posted 5000 5000 

Document date Today‘s date Today‘s date 

Today‘s date 

Original val. date 1st July, 3 years ago 1st July, 3 years ago 

Text Car trailer Car trailer 

Posting date Today‘s date 

4. Choose the Additional Details tab page, then enter the following data: 

Field Europe North America 

Document type AA (Asset posting) AA (Asset posting) 

Offsetting account 299000 299000 

Transaction type 400 (Post-capitalization) 400 (Post-capitalization) 

5. Choose . 

6. The system informs you that the asset transaction has been posted with document number 
####. 

7. Choose . 
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Displaying the Asset History Sheet 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Info System → 
Reports on Asset Accounting → Balance Sheet Explanations → 
International → Asset History Sheet 

Transaction Code S_ALR_87011990 

2. Enter the following data: 

Field Europe North America 

Company code 1000 3000 

Your asset number for the 
evaluation 

Your asset number for the 
evaluation 

Report date 31st Dec. of the current year 31st Dec. of the current year 

Sort version 0007 0007 

List assets Select Select 

History sheet version 0001 0001 

Asset number 

3. Choose . 

The system lists your asset with totals row for the asset class and company code. 

4. To see the depreciation values and transactions, double-click on your asset. 

5. Choose . 
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 Intracompany Transfers 
Purpose 

In this IDES process, we refer to an "old" asset. If someone else has run this process 
before you, it could be that they have already set this asset to zero through a total 
transfer. You therefore need to check the values of the asset, and reverse the asset 
transfer, if required. 

 

Intracompany transfers are required if an asset has been assigned to an incorrect asset class, 
and thereby to the incorrect general ledger account. They are also used if the asset is to be 
assigned to a different business area, or if a part of the asset is to be dismantled and its value 
changes are to be tracked separately. 

The sale of an asset to an affiliated company is referred to as Asset Transfer Between 
Affiliated Companies. 

Prerequisites 

Process Flow
You can find the data for this process under  [Page 213]. 

To check the net book value of the asset Display the Asset in the Asset Explorer [Page 26 ]4 . 
If the net book value is zero, you first need to Reverse the Asset Posting [Page 253]. 

1. 

2. For the intracompany transfer, you require a new asset with new assignments. In this 
scenario, we have changed the assignment to the asset class. The other entries, such as the 
depreciation parameters, remain the same. You can therefore Create the Asset with 
Reference [Page 214]. 

3. Until this point, you have only processed master data. To switch the asset values from one 
asset to another, you Execute the Intracompany Transfer [Page 215]. 

4. To analyze the value changes for both assets, you Display the Asset in the Asset Explorer 
[Page 264]. A retirement has been posted for the original asset. The new asset records the 
planned values and the corresponding depreciation for the asset that is to be retired. 

5. To ensure that this process can be repeated, you should Reverse the Asset Posting [Page 
]. 253
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 Data Used During This Process 
Field Europe North America Description 

Asset class 3200 3200 Personal computers 

Company code 1000 3000 IDES AG 

Asset number 2157 2157 Sample asset 
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Creating an Asset Using a Reference 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → 
Asset 

Transaction Code AS01 

2. Enter the following data: 

Field Europe North America 

Asset class 3200 Personal computer 3200 

Company code 

Reference asset 

1000 3000 

2157 2157 

In the dialog box, the system informs you whether the reference asset has a different 
asset class. 

4. Choose . 

5. Enter a suitable description for the new asset, for example, PC (transfer posting). 

6. Choose the Time-dependent tab page. 

7. Enter the following data: 

Field 

Jurisdiction code NY0011000 

8. Choose . 

9. The system informs you that the asset has been created. Make a note of this asset number. 

10. Choose . 

 

3. Choose . 

If you are working with company code 1000, continue with step 8. 

North America 

214  April 2001 



 SAP AG Financial Accounting (FI) 

  Executing Intracompany Transfers 

Executing Intracompany Transfers 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Transfer → Transfer Within Company Code 

Transaction Code ABUMN 

2. Enter the following data: 

Field Europe North America 

Asset 2157 2157 

Document date Today‘s date Today‘s date 

Posting date Today‘s date Today‘s date 

Reference date 1st July of the current year 1st July of the current year 

Transfer to existing asset Your asset number Your asset number 

3. Choose . 

4. Choose . 

Result 
The values of asset 2157 have now been transferred to your new asset. 
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Displaying the Asset in the Asset Explorer 
13. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

14. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

15. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

16. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

17. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

18. Choose . 
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Reversing the Asset Posting 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Reverse Document → Other Asset Document 

Transaction Code AB08 

2. Enter the following data: 

Field Europe North America 

Asset The asset, for which you may want to 
reverse a posting 

The asset, for which you may want to 
reverse a posting 

Fiscal year The year in which the intracompany 
transfer is carried out (usually, the 
current fiscal year) 

The year in which the intracompany 
transfer is carried out (usually, the 
current fiscal year) 

3. Choose . 

You see all of the postings for this asset. 

4. Select the first item, then choose Reverse. 

5. In the dialog box, enter the following data: 

Field Europe North America 

Reversal reason RE RE 

6. Choose . 

The Document Overview: Asset Accounting screen appears.  

7. Choose . 

The system informs you that the asset transaction has been posted with document 
number ####. 

8. Choose . 
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 Depreciation Adjustments and Write-Ups 
Purpose 
Write-ups are necessary if you have claimed too much depreciation for a fixed asset in the past. 
Tax authorities generally require that the past depreciation be adjusted by means of a write-up. 
As with post-capitalization, write-ups are most often made as the result of a government tax audit 

In this IDES process you increase the useful life of an existing asset. Since this is a change to 
the depreciation terms, depreciation in fiscal years that are not yet closed must be adjusted. For 
the closed fiscal years you will have to post write-ups. 

You can find more information about this process under  [Page 219]. 

Process Flow 
You can find the data for this process under  [Page 220]. 

First of all, you need to Display the Asset [Page 221] to check its current value. 1. 

2. You then Change the Useful Life of the Asset [Page 222], from 10 to 15 years. This ensures 
that in the current fiscal year, the values of the periods still to be posted to are adjusted 
automatically. In this case, they are reduced. 

To display the exact value changes, you Display the Adjustment [Page 223]. 3. 

To adjust the excessive depreciation posting, you Post the Write-Up [Page 224]. 4. 

5. You then examine the posting, especially the FI document. You Display the Asset in the 
Asset Explorer [Page 264] for asset number 2105. 

To analyze the values of asset 2015, you Display the Asset History Sheet [Page 227]. 6. 

7. To ensure that this process can be repeated, you should Recreate the Starting Situation 
[Page 228]. 
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 Additional Process Information 
Write-ups are necessary if you have claimed too much depreciation for a fixed asset in the past. 
Tax authorities generally require that the past depreciation be adjusted by means of a write-up. 
As with post-capitalization, write-ups are most often made as the result of a government tax audit 
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 Data Used During This Process 
Field Data Description 

Company code 1000 IDES AG Frankfurt 

Asset number 2105 Transformer 
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Displaying the Asset 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Display 
→ Asset 

Transaction Code AS03 

2. Enter the following data: 

Field Data 

Asset 2105 

Sub-number 0 

Company code 1000 

3. Choose . 

You can see that this asset was capitalized on 10.04.1994. 

4. Choose the Deprec. areas tab. 

In area 01 (book depreciation) the asset is depreciated using straight-line depreciation 
over 10 years. 

5. Choose Asset values. 

You can now see the acquisition value and the net book value for fiscal year 1999. The 
asset was acquired for 249,565.22 DEM. The net book value at the end of 1999 is 
99,823.00 DEM. The planned accumulated depreciation for 1999 is 24,957 DEM. 

 
If the net book value is 141,418.00 DEM the process has already been executed. To 
reset the data, choose Recreating the Starting Situation [Page 228]. 

 
To see up to which period depreciations have already been posted (Status: Posted 
to period ##), choose the Posted Values tab page. Make a note of this period. 

6. To see the asset values for 1998, choose . 

7. Choose  twice. 
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Changing the Useful Life of the Asset 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Change 
→ Asset 

Transaction Code AS02 

2. Enter the following data: 

Field Data 

Asset 2105 

Company code 1000 

3. Choose Depreciation Areas. 

4. In the Usfl life column, increase the useful life of the asset for the following depreciation 
areas from 10 to 15 years. 

• 01 (Book deprec.) 

• 02 (Spec.tax dep.) 

• 30 (Grp lc.crDEM) 

Do not change the useful life for cost accounting. 

5. Choose . 

6. To display the changed planned values, choose Asset values. The planned depreciation has 
now changed to 16,638 DEM. 

7. To see the changes to the posted values, choose the Posted values tab page. In the next 
posting period, the system will adjust the depreciation of the already posted periods. In the 
remaining periods, the system posts the appropriate period values. 

8. To display the values of the closed fiscal years, choose . 

The planned depreciation in 1998 is still 24,957.00 DEM, and corresponds to the amount 
posted. You cannot make any adjustment as this year has been closed for Asset 
Accounting. The same applies to the years 1994, 95, 96 and 97. 

You therefore need to post a write-up in 1999 for these 5 years. 

9. Choose  twice. 

Result 
The useful life of the asset has been changed. The depreciation for the current year has 
been changed automatically and will be adjusted by the next depreciation run. 
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Displaying the Adjustment 
If depreciation has already been posted for the current year, you have to make an adjustment to 
the depreciation, since the depreciation terms have changed. You can use the depreciation 
posting program to make this adjustment. This depreciation posting program allows you to repeat 
the posting run if adjustments are required. 

At this point, you only display the adjustment, as the posting occurs automatically during 
the next depreciation run. 

1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Periodic 
Processing → Depreciation Run → Execute 

Transaction Code AFAB 

2. Enter the following data: 

Field Data 

Company code 1000 

Fiscal year 1999 

Posting period Previous posted period 

Repeat run Select 

List assets Select 

Test run Select 

Main asset number 2105 

3. Choose . 

4. In the dialog box, choose Yes. 

The report shows which values have been posted so far, and which values are to be 
planned as new. This results in a difference amount, which is to be posted in an update 
run as an adjustment. 

5. Choose  twice. 
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Posting the Write-Up 
Usage 
The excessive depreciation amount posted in the years 1994-1998 is made up as follows: 

Year Planned depreciation Posted depreciation Difference 

1994 16,638.22 24,957.22 8,319.00 

1995 16,638.00 24,957.00 8,319.00 

1996 16,638.00 24,957.00 8,319.00 

1997 16,638.00 24,957.00 8,319.00 

1998 16,638.00 24,957.00 8,319.00 

  Total 41,595.00 

As this process takes place in 1999, you need post the difference of 41,595.00 DEM as a write-
up at the beginning of the fiscal year. This is because the years 1994, 1995, 1996, 1997 and 
1998 have already been closed in Asset Accounting 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Manual Val. Correction → Write-Up 

Transaction Code ABZU 

2. Enter the following data: 

Field Data 

Company code 1000 

Asset number 2105 

Document date 01.01.1999 

Posting date 01.01.1999 

Period 01 

Transaction type 700 

3. Choose  twice. 

The Create Asset Transaction: Write-Up Ordinary and Special Depreciation screen, 
appears. 

4. Enter the following data: 

Field Data 

Reference date 01.01.1999 

Ordinary depreciation 41595 
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5. Choose . 

6. In the Area: 02 Spec.Tax Dep dialog box, enter the following data: 

Field Data 

Ordinary depreciation 41595 

7. Choose . 

8. In the Area: 20 Cost Acc. dialog box, enter the following data: 

Field Data 

Ordinary depreciation 41595 

9. Choose . 

10. To ensure that the write-up is also considered for the depreciation valuation of the asset in 
the consolidated balance sheet, enter the following data: 

Field Data 

Ordinary depreciation 41595 

11. Choose . 

The Create Asset Transaction: Write-Up Ordinary and Special Depreciation screen, 
appears. 

12. Choose . 

13. Make a note of the write-up document number. 

14. Choose . 
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Displaying the Asset in the Asset Explorer 
19. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

20. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

21. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

22. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

23. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

24. Choose . 
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Displaying the Asset History Sheet 
6. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Info System → 
Reports on Asset Accounting → Balance Sheet Explanations → 
International → Asset History Sheet 

Transaction Code S_ALR_87011990 

7. Enter the following data: 

Field Europe North America 

Company code 1000 3000 

Asset number Your asset number for the 
evaluation 

Your asset number for the 
evaluation 

Report date 31st Dec. of the current year 31st Dec. of the current year 

Sort version 0007 0007 

List assets Select Select 

History sheet version 0001 0001 

8. Choose . 

The system lists your asset with totals row for the asset class and company code. 

9. To see the depreciation values and transactions, double-click on your asset. 

10. Choose . 
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Recreating the Starting Situation 
1. Changing the depreciation terms 

To recreate the starting situation, you first need to change the useful life of the asset 
from 15 to 10 years. 

To do this, choose Changing the Useful Life of the Asset [Page 222]. 

2. Reversing the write-up document 

To cancel the write-up on asset 2105 for the closed fiscal year, choose Reversing the 
Asset Posting [Page 253]. 

3. Choose . 
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 Investment Support 
Purpose 
In some countries, the state may offer subsidies for investments under certain conditions. 
Investment support is a subsidy that is regarded as a reduction or valuation adjustment on the 
liabilities side of the acquisition value of the asset in question. 

Prerequisites 
You can display investment support measures separately from the acquisition costs as fair value 
decreases under assets or as valuation adjustments under liabilities. To do this, you need to 
define the relevant support measures (investment support keys). 

In this process, you enter a manual posting for an investment support measure on the liabilities 
side. In Asset Accounting, you only plan the values. The posting is generated automatically in 
Financial Accounting by the next depreciation run. 

You can find the data for this process under  [Page 230]. 

Process Flow 
1. You first Create an Asset Using an Investment Support Key [Page 231]. 

2. You then Post an Acquisition [Page 232] for this new asset. 

3. To analyze the additional depreciation area for the investment support of the new asset, you 
Display the Asset in the Asset Explorer [Page 264]. 

4. You can schedule the investment support either manually or automatically. Generally, you 
choose one variant. In this process, you first Manually Schedule Investment Support [Page 
234] for a partial amount. 

5. To ensure that the remaining amount of the investment support is scheduled, you 
Automatically Schedule the Investment Support [Page 235]. 
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 Data Used During This Process 
Field Data 

Asset class 2000 

Company code 1000 

Depreciation area 01 

Investment support key 01 
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Creating an Asset Using an Investment Support Key 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → 
Asset 

Transaction Code AS01 

2. Enter the following data: 

Field Data 

Asset class 2000 

Company code 1000 

Number of similar assets 1 

3. Choose . 

4. On the General tab page, enter a description for your asset. 

5. Choose the Time-dependent tab page, then enter cost center 2300. 

6. Choose the Allocations tab page, then enter investment support key 01. 

7. Choose . 

8. Make a note of this asset number. 

9. Choose . 

Result 
When you enter investment support key 01, the system automatically adds depreciation area 51 
to the asset master record. 
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 Posting the Acquisition 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Acquisition → Acquis.W.Autom. Offsetting Entry 

Transaction Code ABZON 

2. Enter the following data: 

Field Data 

Existing Asset Your asset number 

Amount posted 100.000,- 

Document date Today‘s date 

Any date in 1999 

Asset val.date 01.01.1999 

Posting date 

3. Choose . 

4. To ignore the warning message, choose . 

5. Choose . 
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Displaying the Asset in the Asset Explorer 
25. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

26. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

27. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

28. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

29. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

30. Choose . 
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 Manually Scheduling the Investment Support 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Investment Support 

Transaction Code ABIF 

2. Enter the following data: 

Field Data 

Document date Any date in 1999 

Posting date Any date in 1999 

Asset Your asset number 

3. Choose . 

4. To ignore the warning message, choose . 

5. In the Amount posted field, enter 5000. 

6. Choose . 

7. Choose . 

Result 
You have scheduled investment support of 5000 DEM. This will be posted to Financial 
Accounting in the next depreciation run. The write-off is executed just as in the book depreciation 
area. 
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 Automatic Scheduling of Investment Support 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Periodic 
Processing → Investment Grant 

Transaction Code AR11 

2. Enter the following data (delete any entries in other fields): 

Field Data 

Company code 1000 

Report date 31.12.1999 

Depreciation area 01 

List assets Select 

Investment support key 01 

Test run Do not select 

Session name RAINZU 

3. Choose . 

4. The system generates a batch input session RAINZU, which you can use to schedule the 
missing investment support amounts. The investment support may not exceed 12% of the 
acquisition value (100,000 DEM). As you manually scheduled 5000, the system automatically 
schedules a remainder amount of 7000 for your asset. 

5. Choose . 

6. To process the session you have generated, enter the following transaction: 

Transaction Code SM35 

7. Select the RAINZU session, then choose  Process. 

8. In the dialog box, select Process/foreground, then choose Process. 

9. Choose . 

Result 
The missing amounts for investment support key 01 have now been scheduled automatically. 
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 Leasing Processing 

 

Purpose 
Leasing processing is used to administrate and monitor leased assets from the perspective of the 
lessee. 

In comparison to acquired assets, leased assets require the lessee to pay particular attention to 
accounting requirements. This is because during the leasing period these assets remain the legal 
property of the lessor or manufacturer. 

Depending on the legal terms, the leased assets can be capitalized and depreciated (capital 
lease method) or they can flow into the P&L as periodic rental expenses (operating lease 
method). For the purposes of consolidated group accounting, you can record the complex fixed 
asset under book depreciation per trade law using the Operating Lease Method and in the group 
depreciation area with Capital Lease Method (Mixed Method). We describe all of these 
possibilities in this process. 

You can find more information about this process under  [Page 238]. 

You can find the data for this process under  [Page 239]. 

Process Flow 
The Capital Lease Method 
6. You first create an Asset for the Capital Lease Method [Page 240], for which book 

depreciation, costing and group depreciation areas are active. 

7. You then Enter the Opening Entry [Page 246] for your asset, thus capitalizing the present 
value of the future lease installment payments as the acquisition value. 

8. To analyze the posting on your asset, you can Display the Asset in the Asset Explorer [Page 
]. You should note the document number of the financial accounting document. 264

9. To display the payables to the vendor, as well as the corresponding payment installments on 
the due dates, you Display the Vendor [Page 24 ]8 . 

The Mixed Method 
1. You first Create an Asset for the Mixed Method [Page 244], for which only the group areas 

are active. 

2. You then Enter the Opening Entry [Page 246] for your asset. The present value of the future 
lease installment payments is posted only in the group areas. 

3. To analyze the posting on your asset, you can Display the Asset in the Asset Explorer [Page 
]. The system does not generate a financial accounting document, as this posting is only 

relevant for asset accounting. 
264

4. You post the payables to the vendor and corresponding payment installments manually in 
financial accounting. This is best achieved by creating a recurring entry document. (We do 
not demonstrate this here.) 
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The Operating Lease Method 
1. You first Create an Asset for the Operating Lease Method [Page 242], for which no 

depreciation areas are active. 

2. You then Display the Leasing Liabilities [Page 249]. 

 

April 2001  237 



Financial Accounting (FI)  SAP AG 

Leasing Processing 

 Additional Process Information 
Various valuation approaches can applied to leased assets in the system. Depending on the 
legal terms and the conditions of the contract, leased assets can be: 

• Capitalized and depreciated (Capital Lease) or 

• Recorded only for costing or for group accounting in the relevant group depreciation areas. 

• Recorded in asset accounting as statistical assets without values (all depreciation areas are 
deactivated). 
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 Data Used During This Process 
Field Data Description 

Asset class 6001 

6000 

Capital Lease Asset 

Operation Lease Asset 

Company code 1000 IDES Germany 

Vendor account 1000 C.E.B. Berlin 

Leasing company 1000 C.E.B. Berlin 

Contract number 12345 Any 

Type L1 Leasing 

Lease payment cycle 1 Monthly 

Annual rate of interest 7.5  
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 Creating an Asset for the Capital Lease Method 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → Asset 

Transaction AS01 

2. Enter the following data: 

Field Data 

Asset class 6001 

Company code 1000 

Number of similar assets 1 

3. Choose . 

4. On the General tab page, enter a description for your asset. 

5. Choose the Time-dependent tab page, then enter business area 9900. 

6. Choose the Leasing tab page, then enter the following data: 

Field Data 

Leasing company 1000 

Agreement number 12345 

01.01.1999 

Notice date 08.31.2003 

Start 01.01.1999 

Duration 4 

Type L1 

Base value as new 54000 

Purchase price 10000 

No.lease payments 48 

Payment cycle 1 

Lease payment 1000 

Annual rate of interest 7.5 

Agreement date 

7. Choose . The system calculates the present value of the asset and enters this in the 
Present value field. 

8. Choose . 

9. Note the number of your asset. 

10. Choose . 
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 Creating an Asset for the Operating Lease Method 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → Asset 

Transaction AS01 

2. Enter the following data: 

Field Data 

Asset class 6000 

Company code 1000 

Number of similar assets 1 

3. Choose . 

4. On the General tab page, enter a description for your asset. 

5. Choose the Time-dependent tab page, then enter business area 9900. 

6. Choose the Leasing tab page, then enter the following data: 

Field Data 

Leasing company 1000 

Agreement number 12345 

Agreement date 01.01.1999 

Notice date 08.31.2003 

Start 01.01.1999 

Duration 4 

Type L1 

Base value as new 108000 

Purchase price 20000 

No.lease payments 48 

Payment cycle 1 

Lease payment 2000 

Annual rate of interest 7.5 

7. Choose . The system calculates the present value of the asset and enters this in the 
Present value field. 

8. Choose the Deprec. areas tab page, then select the "Deact" field for depreciation areas 30 
and 31. 

9. Choose . 
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10. Note the asset number. 

11. Choose . 
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Creating an Asset for the Mixed Method 
11. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → Asset 

AS01 Transaction 

12. Enter the following data: 

Field Data 

Asset class 6000 

Company code 1000 

Number of similar assets 1 

13. Choose . 

14. On the General tab page, enter a description for your asset. 

15. Choose the Time-dependent tab page, then enter business area 9900. 

16. Choose the Leasing tab page, then enter the following data: 

Field Data 

Leasing company 1000 

Agreement number 12345 

Agreement date 01.01.1999 

Notice date 08.31.2003 

Start 01.01.1999 

Type L1 

Base value as new 32000 

Purchase price 7000 

30 

Payment cycle 1 

Lease payment 850 

Annual rate of interest 7.5 

Duration 3 

No.lease payments 

17. Choose . The system calculates the present value of the asset and enters this in the 
Present value field. 

18. Choose . 

19. Note the number of your asset. 

20. Choose . 

244  April 2001 



 SAP AG Financial Accounting (FI) 

  Creating an Asset for the Mixed Method 

 

April 2001  245 



Financial Accounting (FI)  SAP AG 

Entering the Opening Entry 

 Entering the Opening Entry 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Display → 
Asset 

Transaction AS03 

2. Enter the following data: 

Field Data 

Asset Your asset number 

Sub-number 0 

Company code 1000 

3. Choose . 

4. Choose the Leasing tab page. 

5. Choose Opening Posting. 

6. Choose . 

Result 

 

The Capital Lease Method 
The system capitalizes your asset with the present value. The system also posts the payment 
installments on the relevant due dates to the vendor. The financial accounting documents are 
generated automatically. 

The Mixed Method 
The system capitalizes your asset in the group depreciation areas with the present value. 

The Operating Lease Method 
No opening posting is required for this type of acquisition, because the asset is only recorded 
statistically. 
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Displaying the Asset in the Asset Explorer 
31. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

32. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

33. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

34. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

35. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

36. Choose . 
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 Displaying the Vendor 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/Change Line Items 

Transaction FBL1N 

2. Enter the following data: 

Field Data 

Vendor account 1000 

Company code 1000 

Open items Today‘s date 

3. Choose . 

4. You see a list of all open items for the selected key date. 

5. The document number you noted in the previous process step identifies the open items 
created by the opening entry. 

6. Double-click on any two documents. Note that the baseline date is different in each case. 

7. Choose . 
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Displaying the Leasing Liabilities 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Info System → 
Reports on Asset Accounting → Balance Sheet Explanations → 
International → Liabilities From Leasing Agreements 

Transaction Code S_ALR_87011992 

2. Enter the following data: 

Field Data 

Asset number Your asset number 

Report date 31st Dec. of subsequent year 

3. Choose . 

4. Choose . 
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 Fixed Asset Retirements 
Purpose 
You can post fixed asset retirements integrated with accounts receivable in Financial Accounting. 
In this case, the net book value of the fixed asset is compared to the sales revenue on the key 
date of the retirement. The profit or loss is thus determined and automatically posted to the profit 
and loss statement. 

Prerequisites 
As we are using an “old” fixed asset in this process, it is possible that someone has already 
tested the process and set the fixed asset to zero. You therefore need to check the values of the 
asset, and reverse the asset retirement, if required. 

Process Flow 
You can find the data for this process under  [Page 251]. 

1. To check the net book value of asset 2020 Display the Asset in the Asset Explorer [Page 
]. If the net book value is zero, you first need to Reverse the Asset Posting [Page 25 ]3 . 264

 Post the Asset Retirement [Page 254]. 2. You then

3. To analyze the values of asset, you Display the Asset Explorer [Page 264]. 
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 Data Used During This Process 
Field Europe North America Description 

Company code 1000 3000 IDES AG 

Asset 2020 2020 Asset 

Customer 1000 3000 Customer 

Currency DEM USD  

Tax code AN S1 Domestic output tax 16% 

Revenue account 820000 820000 Revenue from asset retirement 
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Displaying the Asset in the Asset Explorer 
37. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

AW01N Transaction Code 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

38. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

39. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

40. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

41. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

42. Choose . 
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Reversing the Asset Posting 
9. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Reverse Document → Other Asset Document 

Transaction Code AB08 

10. Enter the following data: 

Field Europe North America 

Asset The asset, for which you may want to 
reverse a posting 

The asset, for which you may want to 
reverse a posting 

Fiscal year The year in which the intracompany 
transfer is carried out (usually, the 
current fiscal year) 

The year in which the intracompany 
transfer is carried out (usually, the 
current fiscal year) 

11. Choose . 

You see all of the postings for this asset. 

12. Select the first item, then choose Reverse. 

13. In the dialog box, enter the following data: 

Field Europe North America 

Reversal reason RE RE 

14. Choose . 

The Document Overview: Asset Accounting screen appears.  

15. Choose . 

The system informs you that the asset transaction has been posted with document 
number ####. 

16. Choose . 
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Posting the Asset Retirement 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Retirement → Retirement With Revenues → With Customer 

Transaction Code F-92 

2. Enter the following data: 

Field Europe North America 

Document date Today‘s date Today‘s date 

Document type AA (Asset posting) AA (Asset posting) 

Company code 1000 3000 

Posting date Today‘s date Today‘s date 

Currency / rate DEM USD 

PstKy 01 (Customer, debit posting) 01 (Customer, debit posting) 

Account 1000 (Becker Berlin) 3000 (Thomas Bush) 

3. Choose . 

North America 

4. Enter the following data: 

Field Europe 

Amount 125,000 125,000 

Calculate tax Select Select 

Tax code AN S1 

PstKy 50 (General ledger, credit posting) 50 (General ledger, credit posting) 

820000 (Revenues from asset 
retirement) 

820000 (Revenues from asset 
retirement) 

Account 

5. Choose . 

6. On the Enter Asset Posting: Add G/L Account Item screen, enter the following data: 

Field Europe North America 

Amount * (the amount is taken from the 
customer item) 

* (the amount is taken from the 
customer item) 

Fixed Asset Retirements Select Select 

7. Choose . 

The Enter Asset Posting dialog box appears. 

8. Enter the following data: 

Field Europe North America 
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Asset 2020  2020  

Reference date Today‘s date Today‘s date 

Complete retirement Select Select 

9. Choose Continue. 

10. Choose . 

11. To view the generated document, choose Document → Display. 

The document is structured as follows: 

Debit/Credit Account Description 

Debit 1000 Request to customer 

Credit 820000 Revenue from asset retirement 

Credit 175000 Tax amount 

Credit 11000 Write-off of asset acquisition value 

Debit 11010 Write-off of accumulated asset depreciation 

Debit 825000 Calculation of asset retirement 

Credit 250000 Post the profit/loss (gain/loss) 

12. Choose . 
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 Intercompany Asset Transfers 
Purpose 
Asset transfers involve the transfer of an asset between two companies (company codes) of the 
same corporate group. An intercompany transfer within a corporate group may be due to: 

• A change of physical location that requires the asset to be assigned to a new company code. 

• A change to the organizational structure of the corporate group that requires the existing 
assignment of the asset to be changed. 

In both of these cases, you can not change the assignment of the asset to the company code 
through master record maintenance. For each asset that is to be transferred, you require a new 
asset master record (or an existing one for partial transfers) in the receiving company code. You 
can retain the identity of the asset using the inventory number in the asset master record. 

The system provides you with a method that allows you to automate these activities to a large 
extent. With this method, the transfer is posted only on the sender company code. The posting in 
the target company code is executed automatically by the system. If a new asset needs to be 
created in the target company code, you can specify the asset class and other important master 
data in the relevant dialog box. 

In this IDES process, you execute four transfers between company code 1000 and company 
code 2000, each with a different transfer variant. 

You can find more information about this process under  [Page 257]. 

You can find the data for this process under  [Page 258]. 

Process Flow 
10. You first Create Four Asset Master Records [Page 25 ]9 , one for each transfer variant. 

11. To capitalize these asset master records, you Post the Acquisition to a Clearing Account 
[Page 261]. 

12. 1st Variant: Transfer the Asset "Gross" [Page 265]. 

13. 2nd Variant: Transfer the Asset "Net" [Page 262]. 

14. 3rd Variant: Transfer the Asset Manually With Gains [Page 267]. 

4th Variant: Transfer the Asset Manually With Losses [Page 269]. 15. 

16. To check the effects of these transfers, you can Display the Asset Explorer [Page 264]. 
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 Additional Process Information 
Transfer Methods 
The system controls the valuation of the transferred assets using definable transfer variants: See 
Customizing for Asset Accounting, under Transactions → Intercompany Asset Transfers → 
Automatic Intercompany Asset Transfers → Define Transfer Variants. The following transfer 
methods are possible for a transfer variant: 

• Gross Method 
The system transfers the historical APC, plus the accumulated depreciation of the sender 
asset. 

• Net Method 
The system transfers the net book value of the sender asset, which means that the asset is 
capitalized in the receiver company code with the net book value. During the transfer, you 
can specify the depreciation area to be used to determine the net book value. 

• New Value Method 
You manually enter the transfer price. The system capitalizes the asset in the receiving 
company code with a previously entered manual value. The new valuation method is mainly 
used for transfers between legally independent enterprises. 
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 Data Used During This Process 
Field Data Description 

Asset class 2100 Machines str. line 

Company code (sender) 1000  

Business area 9900 Corporate/other 

Cost center for assets in cost center 1000 

Cost center for assets in cost center 2000 

1000 

 

2-1000 

 

Document type AA (Asset posting)  

Transfer variants 2 (net method) 

1 (gross method) 

3 (new value method) 

 

Receiver company code 2000  
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Creating the Asset Master Records 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Create → 
Asset 

Transaction Code AS01 

2. Enter the following data: 

Field Europe 

Asset class 2100 

Company code 1000 

Number of similar assets 4 

The Number of similar assets function lets you create multiple identical assets in one 
master data transaction. The assets are initially identical, except for the asset numbers 
and asset subnumbers. When you save these assets, you can enter a description and 
inventory number for each record. 

3. Choose . 

4. On the General tab page, enter the following data: 

Field Europe 

Description Any description for your asset 

Capitalized on 01.15.1999 

5. Choose the Time-Dependent tab page, then enter the following data: 

Field Europe 

Business area 9900 

Cost center 1000 

6. Choose the Deprec. areas tab. 

You see a list of the depreciation areas. Select the Deact. field for areas 02 and 10. 

7. To create the assets, choose . 

The Create Multiple Assets dialog box appears. You can still make changes to the new 
assets. 

8. Choose Maintain. 

In the dialog box, you can enter descriptions for the new assets, for example: 

1. Gross transfer 

2. Net transfer 

3. Gain transfer 

4. Loss transfer 
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9. Choose . 

10. Choose  Create. 

11. Make a note of the asset numbers. 

12. Choose . 

 

260  April 2001 



 SAP AG Financial Accounting (FI) 

  Posting the Acquisition to a Clearing Account 

Posting the Acquisition to a Clearing Account 
Usage 
For each of your four new assets, you now post the acquisition to a clearing account in Financial 
Accounting. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Acquisition → Acquis.W.Autom. Offsetting Entry 

Transaction Code ABZON 

2. Enter the following data: 

Field Data 

Existing Asset Your asset number 

Amount posted 100.000 

Document date 02.01.1999 

Posting date 02.01.1999 

Asset val. date 02.01.1999 

3. Choose . 

You can use the data you have entered for the other acquisition postings. If a warning 
message appears, choose . 

4. Choose System → User profile → Hold data. 

5. Repeat the acquisition posting for the other assets. 

6. Choose . 
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Transferring the Net Asset Values 
Usage 
You now post one of your assets from sender company code 1000 to receiver company code 
2000. The transfer is made net, that is, the asset is capitalized with the net book value. 

Menu Path 

Procedure 
1. Call up the transaction as follows: 

Accounting → Financial Accounting → Fixed Assets → Postings → 
Transfer → Intercompany Asset Transfer 

Transaction Code ABT1N 

2. Enter the following data: 

Field Data 

Asset Your asset number 

Document date 12.30.1999 

Posting date 12.30.1999 

Reference date 12.30.1999 

NBV from area Select 

Second field 01 (Book deprec.) 

To company code 2000 

New asset Select 

3. Choose Master Data. 

If a warning message appears, choose . 

4. Enter a description. 

5. In the Cost center field, enter 2-1000, then choose . 

6. Choose the Additional details tab page. In the Transfer variant field, enter 2. 

7. To display the document, choose . 

Debit/Credit Account Description Amount Currency 

Credit 11000 Your asset -100000,- DEM 

Debit 11010 Your asset 10000 DEM 

Debit 825000  90000 DEM 

Debit 11000 INTER-00001 29468.70 GBP 
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Credit 199991  -29468.70 GBP 

8. Choose . 

9. Choose . 

Result 
The system confirms that document number ### has been posted. The system also 
automatically issues an asset number for the new asset in company code 2000. 
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Displaying the Asset in the Asset Explorer 
43. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Asset → Asset 
Explorer 

Transaction Code AW01N 

The system displays the current value and the transactions for your fixed asset. If your 
asset is not displayed, enter the asset number, then choose . 

44. In the center of the screen, you can see information about the planned values, the posted 
values or the parameters of your fixed asset. To switch to an alternative view, choose the 
appropriate tab page. 

45. At the bottom of the screen, you see the transactions for your asset. For example, the goods 
receipt, acquisitions, and retirements. To display the FI document for a transaction, select the 
transaction, then choose . 

46. All of the values displayed refer to one fiscal year and to one depreciation area. To display 
the values of a different fiscal year, choose   or enter the year directly. 

47. To display the values of a different depreciation area, in the navigation area on the left side of 
the screen, choose the area you would like to see. 

Take a closer look at the asset, especially the effects of your posting. 

48. Choose . 
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Transferring the Gross Asset Values 
Usage 
In this process step, you post the gross values from the sender company code to the receiver 
company code. The system capitalizes the asset with the historical APC, plus the accumulated 
depreciation. The procedure is similar to that for the net method. To execute this method, you 
use the second asset. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Transfer → Intercompany Asset Transfer 

Transaction Code ABT1N 

2. Enter the following data: 

Field Data 

Asset Your asset number 

Document date 12.30.1999 

Posting date 12.30.1999 

Reference date 12.30.1999 

NBV from area Select 

Second field 01 (Book deprec.) 

To company code 2000 

New asset Select 

3. Choose Master Data. 

If a warning message appears, choose . 

4. Enter a description. 

5. In the Cost center field, enter 2-1000, then choose . 

6. Choose the Additional details tab page. In the Transfer variant field, enter 1. 

7. To display the document, choose . 

Debit/Credit Account Description Amount Currency 

Credit 11000 Your asset -100000 DEM 

Debit 11010 Your asset 10000 DEM 

Debit 825000  90000 DEM 
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Debit 11000 INTER-00001 32743 GBP 

Credit 199991  32743 GBP 

8. Choose . 

9. Choose . 

Result 
The system confirms that document number ### has been posted. The system also 
automatically issues an asset number for the new asset in company code 2000. 
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Transferring the Asset Manually With Gains 
Usage 
In the new value method, you manually enter a new value for your asset. You can transfer the 
asset either with gains or with losses. You first post your asset with gains. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Transfer → Intercompany Asset Transfer 

Transaction Code ABT1N 

2. Enter the following data: 

Field Data 

Asset Your asset number 

12.30.1999 

Posting date 12.30.1999 

Reference date 12.30.1999 

Manual value Select 

Second field 150000 (gain) 

To company code 2000 

New asset Select 

Document date 

3. Choose Master Data. 

If a warning message appears, choose . 

4. Enter a description. 

5. In the Cost center field, enter 2-1000, then choose . 

6. Choose the Additional details tab page. In the Transfer variant field, enter 3. 

7. To display the document, choose . 

Debit/Credit Account Description Amount Currency 

Credit 11000 Your asset -100000 DEM 

Debit 11010 Your asset 10000 DEM 

Debit 825000  150000 DEM 

Credit 250000   - 60000 DEM 
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Debit 11000 INTER-00001  49114.50 GBP 

Credit 199991  -49114.50 GBP 

8. Choose . 

9. Choose . 

Result 
The system confirms that document number ### has been posted. The system also 
automatically issues an asset number for the new asset in company code 2000. 
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Transferring the Asset Manually With Losses 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Fixed Assets → Postings → 
Transfer → Intercompany Asset Transfer 

Transaction Code ABT1N 

2. Enter the following data: 

Field Data 

Asset Your asset number 

Document date 12.30.1999 

Posting date 12.30.1999 

Reference date 12.30.1999 

Select 

Second field 75000 (loss) 

To company code 2000 

New asset Select 

Manual value 

3. Choose Master Data. 

If a warning message appears, choose . 

4. Enter a description. 

5. In the Cost center field, enter 2-1000, then choose . 

6. Choose the Additional details tab page. In the Transfer variant field, enter 3. 

7. To display the document, choose . 

Debit/Credit Account Description Amount Currency 

Credit 11000 Your asset -100000 DEM 

Debit 11010 Your asset 10000 DEM 

Debit 825000  75000 DEM 

Credit 250000  15000 DEM 

11000 INTER-00001 24557.25 

Credit 199991  -24557.25 GBP 

Debit GBP 

8. Choose . 
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9. Choose . 

Result 
The system confirms that document number ### has been posted. The system also 
automatically issues an asset number for the new asset in company code 2000. 
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General Ledger Accounting (FI-GL) 
General Ledger Information System [Page 272] 

Closing Activities in Accounts Receivable and Accounts Payable [Page 28 ]5  

Closing Activities in General Ledger Accounting [Page 316] 

Cash Journal [Page 360] 
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 Information System G/L Accounts - Germany 
In this process, you open IDES AG’s financial statement/profit and loss and cash flow analysis. 
First of all, you learn how to make the settings necessary for calling the reports. Next you learn 
about financial statement and cash flow analysis and the drilldown possibilities in these reports. 

The formatting of data for report creation occurs online. This means that the system also 
immediately takes into account documents created by you when compiling the reports. 

 
As balance sheet rules differ greatly from country to country, all process data used 
here is valid only for Germany. Where the scenario is used for other another country, 
data and procedures should be changed in accordance with the rules in force in that 
country.  

Process Flow 
You can find the relevant process data under  [Page 273]. 

Data Selection [Page 274] 1.  

2. Balance Sheet/P+L Actual/Actual Comparison [Page 275]  

3. Variable Display [Page 276] 

4. Analyzing the Fixed Assets [Page 278] 

5. Analyzing Payables and Receivables [Page 28 ]0   

6. Cash Flow Analysis (Direct Method) [Page 281]  

7. Cash Flow Analysis (Indirect Method) [Page 283]  
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Process Data 
Fields Germany 

Company code 1000 IDES AG 

Financial statement version INT 

Currency type 10: Company code currency  
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Data Selection 
1. Call up the transaction as follows: 

Menu Path Information Systems → Accounting → Financial Accounting → General 
Ledger → Information System → Balance Sheet/Profit and Loss 
Statement/Cash Flow → General → Actual/Actual Comparisons → 
Actual/Actual Comparison for Year 

Transaction Code S_ALR_87012249 

The system displays the Selection: Actual/actual comparison for year screen. 

2. Enter the following data: 

Field Data 

Company code 1000 

FIS annual rep. Structure INT 

Currency type 10 

Fiscal year Current year 

Classic drilldown report Selected 

3. Choose . 

The system displays the Execute actual/actual comparison for year: Overview screen. 

4. Remain on this screen. 
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Balance Sheet/P+L Actual/Actual Comparison 
 

1. On the Execute actual/actual comparison for year: Overview screen, in the Commercial 
balance sheet, branch to ASSETS and then to Current assets. 

The system displays stock totals, receivables from goods and services, and liquidity 
stocks. 

2. Branch to the Stocks line to divide the stock into Raw materials and supplies, Work in 
process, and Finished goods and merchandise. 

3. Branch to the line Raw materials and supplies to display according to accounts. 

4. To reach the G/L account item Goods Rcvd/Invoice Rcvd - not yet delivered, you branch to 
Supplement → GR/IR Clearing (RM) in the Commercial balance sheet. 

5. Here, you select the field in the previous year column. 

6. Choose Goto → Line Items. 

The system displays the line items for the account.  

7. Choose  to return to the Execute actual/actual comparison for year: Overview screen. 

8. To expand the report completely, place your cursor on Commercial balance sheet, choose 
, and, when prompted by the dialog box, choose Level 8. 

9. The system expands the financial statement version to the individual G/L accounts. 

10. To display the financial statement version in summarized form again, select Commercial 
balance sheet and choose  (collapse). 

11. Remain on this screen. 
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Variable Display 
Use 
In the top left corner of the screen is a list of criteria: Business area, Fiscal year, Company, 
Period, Company code. Use the arrows to scroll up and down this list of criteria. 

Procedure 
1. To analyze the balance sheet items according to business area, expand the report on the 

Execute actual/actual comparison for year: Overview screen. Select the Commercial balance 
sheet field, choose , and then choose  (expand all) in the hierarchy dialog box. In the 
navigation menu, select the Business area field. 

It changes color. The diamond shapes to the left of the individual balance sheet items 
also change color. 

2. Select the diamond to the left of ASSETS. 

The system displays assets according to business area. The presentation type is 
displayed: Balance Sheet/P+L items ASSETS 

3. To the left of ASSETS are two arrows. Select the down arrow. 

The system displays the balance sheet item subordinate to the balance sheet item 
ASSETS and the one you branched to on the previous hierarchy overview screen. 

The purpose of this example is to provide an overview of fixed assets according to 
business area. 

4. Once again, choose the down arrow to display further balance sheet items. 

5. To exit the selection according to the criterion, choose Σ. 

6. Select the criterion Fin.statemt itm in the navigation list. 

It changes color. The diamond shapes to the left of the individual balance sheet items 
also change color. 

7. Select the line between the navigation area and the report (the line displays the report 
definition, in this case business area). 

 
To analyze the balance sheet items according to another criterion (fiscal year, for 
example) proceed in the same manner. 

First expand the Financial statement version down to the detail to be displayed in the 
report. Then choose the characteristic that is to govern how the breakdown is carried 
out. 

Next, choose the diamond to the left of the balance sheet item to be analyzed in the 
report. 

If you wish, you can make several selections at a time. 

8. Remain on this screen. 
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Analyzing the Fixed Assets 
Use 
During analysis of fixed assets, in addition to the balance sheet and line item analysis, you can 
call other reports. We have provided some suggestions. 

Procedure 
1. Branch to Assets. 

The total of fixed and current assets is displayed. 

2. Select Fixed assets, choose , and then in the hierarchy dialog box, choose  Expand to 
level. 

The system displays a dialog box. 

3. Select Level 8 and then choose . 

The fixed assets are now displayed down to the G/L account level. 

4. Select Land and similar rights and then choose .  
The system displays a dialog box. 

5. Select Asset Balance, then choose . 

On the Asset Balance screen, the system displays an overview of the land stock and 
buildings of this company code together with further information about the acquisition 
value, the accumulated depreciation, and the net book value. 

6. Select Buildings and then choose .  

The system displays a list of the buildings belonging to the fixed assets of this company 
code. The list supplies further information about the asset number, the capitalization date 
and the name. You can also see the acquisition values, the accumulated depreciation 
and the net book value of each individual real estate object. 

7. To call up details of a real estate object, simply double-click on the object. 

The system displays the Asset Explorer screen. You see an overview of depreciation 
planned values. 

8. Choose  to return to the Execute actual/actual comparison for year: Overview screen. 

9. To call other reports, select the respective item and choose . 

10. In the Choose report dialog box, select Asset history sheet, then choose . 

The system displays the Asset history sheet screen. The system displays asset history 
according to book depreciation per trade law for the end of the fiscal year. 

The first column displays the acquisition costs and cost of goods manufactured for each 
real estate object, the total depreciation throughout the year, and the remaining value at 
the end of the year. 

11. Select Goto → History. 

The Report calls: History dialog box appears. 
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12. Select Actual/actual comparison for year and choose . The system displays the 
Actual/actual comparison for year: Overview screen. 

13. Remain on this screen. 
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Analyzing Payables and Receivables 
1. On the Execute actual/actual comparison for year: Overview screen, choose Assets → 

Current Assets → Receivables and Other Assets. 

2. Select Receivables and Other Assets. 

3. Choose . 

The Hierarchy dialog box appears. 

4. Choose  Expand to level... 

5. Select Level 8 and then choose . 

The system displays an overview.  

6. In the line Flat-rate individual value adjustment, select the column that represents the 
previous fiscal year, and then choose Goto → Line items. 

The system displays the balance of this account in local currency. 

7. Choose  until the Execute actual/actual comparison for year: Overview screen appears 
and then choose . 

The Select report dialog box appears. 

8. Select Customer information system and then choose . 

You reach the initial screen for customer standard reports from the Accounts Receivable 
Info System - Path (By Evaluation Type) screen.  

It is also possible to evaluate the payables.  

9. Choose  until the overview tree appears. Confirm any dialog boxes with Yes. 
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Cash Flow Analysis (Direct Method) 
Use 
In this procedure, you determine the cash flow total from the main items of the financial 
statement plus the balance sheet changes. This procedure is called a direct method, as the 
balance sheet changes are directly allocated to their appropriate P&L accounts. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Information Systems → Accounting → Financial Accounting → General 
Ledger → Information System → Balance Sheet/Profit and Loss 
Statement/Cash Flow → General → Cash Flow → Cash Flow (Direct 
Method) 

Transaction Code S_ALR_87012271 

2. If you have never used this transaction before, you will need to confirm the two dialog boxes 
with . 

The system displays the Cash Flow (Direct Method) screen. 

3. Choose . 

 
The first time you call this report, you have to determine various settings. Make these 
settings as per the instructions in the first process. 

4. The system displays the Execute Cash Flow (Direct Method) Detail screen. 

A cash flow analysis for the last two years for the complete company code is displayed. 

With this method, you are able to immediately establish the number of payments made 
regarding the obtained revenues into the bank accounts of the company code or how 
much has been paid already for materials. 

On the top left, you see a navigation list. Here, you can choose from the following 
criteria: Business area, Company code, G/L account, and Company. 

5. Select the criterion Business area. 

The report provides a cash flow analysis for the business area Mechanical Engineering. 

6. Select the Magnifying glass. 

The system displays Business area dialog-box with a list of the business areas. 

7. Double-click on the Electronic Products item to display that business area. 

The report now refers to this specific business area. 

8. Select the criterion Period from the navigation list. 

The analysis now refers to the values of Period 001 in business area Electronic products. 
(Previously, the system displayed the total values for the last two fiscal years). 

You can use the two arrows to the left of the selection criteria to scroll through periods 
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and business areas to analyze the figures. 

9. Select the Σ sign to the left of the selection criteria to return to the overall list. 

10. Choose  until the overview tree appears. Confirm any dialog boxes with Yes. 
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Cash Flow Analysis (Indirect Method) 
Use 
The cash flow total in this example results from the annual net profit (or loss) plus the 
extraordinary revenues, minus the decrease in value in balance sheet items, plus the increase in 
value in the balance sheet items. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Information Systems → Accounting → Financial Accounting → General 
Ledger → Information System → Balance Sheet/Profit and Loss 
Statement/Cash Flow → General → Cash Flow → Cash Flow (Indirect 
Method) Variant 1 

Transaction Code S_ALR_87012272 

2. If you have never used this transaction before, you will need to confirm the two dialog boxes 
with . 

The system displays the Cash Flow (Indirect Method) Variant 1 screen. 

3. Choose . 

 
When calling this report for the first time, you are required to make certain settings. 
To do this, follow the instructions given in the first process. 

The system displays the Execute Cash Flow (Indirect Method) Variant 1: Detail screen. 
This provides a cash flow analysis for the last two years for the entire company code. 

The first part of the report displays a summarized profit and loss statement for company 
code 1000 including the annual net profit (or loss). The second part contains all 
corrections necessary for the determination of the cash flow total. The corrections are 
displayed as a decrease or increase in value of fixed and current assets, provisions, and 
as an increase or decrease in cash holdings of activities not affecting the net income. 

4. There is a navigation list on the top left of the screen with the criteria: Business area, G/L 
account, Company code, Company, Fiscal year, Period, Period/year. 

5. Select the criterion Business area. 

The report supplies a cash flow analysis for the business area Mechanical Engineering. 

6. Select the Magnifying glass symbol. 

The system displays the Business area dialog-box containing a list of business areas. 

7. Double-click on the Electronic Products business area. 

8. Select the criterion Period from the navigation list. 

The analysis now refers to the values of period 001 in business area Electronic products. 

You can use the two arrows to the left of the selection criteria to scroll through periods 
and business areas to analyze the numbers. 
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9. Choose the Σ sign to the left of the selection criteria to return to the overall list. 

10. Choose  until the overview tree appears. Confirm the dialog box with Yes. 
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 Closing Operations in Accounts Receivable and 
Accounts Payable Accounting 
Purpose 
In this process you will carry out year-end closing in Accounts Receivable and Accounts Payable.  

You will go through the following steps: 

• Generation of account statements: To check posted documents within a period. 

• Generation of balance confirmations: To check the number of receivables and payables. 

• 

• Individual value adjustments using the special general ledger technique. 

• Valuation of open items in foreign currency with expense postings or revenue from exchange 
rate fluctuations. 

Sorted lists of open items with regrouping of items for changed reconciliation account, 
vendors with a debit balance and customers with a credit balance according to remaining life. 

You can find more information about this process under  [Page 287]. 

 
To avoid output errors, check your print settings before starting this process chain. 

i. To do this, select System → User Profile → Own Data. 

j. In the Maintain User Profile screen, select the tab page Defaults, and make the following 
settings: 

Field Data 

Output device Name of printer you wish to use 

k. Choose . 

l. Choose  until the overview tree appears. 

Process Flow 
You can find the data for this process under  [Page 288]. 

25. Correspondence: Entering an Invoice [Page 28 ]9  

26. Correspondence: Generating Account Statements [Page 29 ]1  

27. Correspondence: Generating Balance Confirmations [Page 294] 

28. Individual Value Adjustments: Entering the Invoice [Page 29 ]7  

29. Making Individual Value Adjustments for Doubtful Receivables [Page 299]  

Individual Value Adjustment: Display Customer Line Items [Page 30 ]2  30.  

31. Valuating Open Items in Foreign Currency: Entering an Invoice in Foreign Currency [Page 
]  303
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32. Valuating Open Items in Foreign Currency: Posting Exchange Rate Differences [Page 305]  

33. Valuation of Open Items in Foreign Currency: Display Document [Page 309]  

34. Allocation of Receivables and Payables According to Remaining Life: Enter Invoice [Page 
]  310

35. Allocation of Receivables and Payables According to remaining Life: Execute Program [Page 
]  312

36. Allocation of Receivables and Payables According to Remaining Life: Generate Postings 
[Page 314]  
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 Additional Process Information 
Open items are required for most of these transactions. In order to ensure that there will be open 
items available in the system, you should execute some simple invoices in Accounts Receivable 
or Accounts Payable Accounting before starting the closing program. 

To do this, you will have to enter the following kinds of documents: 

• Customer invoice in local currency for generating account statements and balance 
confirmations 

• Customer invoice in local currency for individual value adjustment 

• Customer invoice in foreign currency for valuation in foreign currency 

• Vendor invoice in foreign currency for valuation in foreign currency 

• Invoice with a remaining life of more than one year for allocation of receivables and 
payables according to remaining life. 

If other open items already exist in the system, they will also be evaluated and possibly transfer 
posted if they meet the selection criteria. 

You create customer and vendor invoices in a single-screen Enjoy transaction. 

For the customer invoice, the system automatically suggests tax code AN (16%) for company 
code 1000 and tax code S1 for company code 3000. 

For the vendor invoice, the system automatically suggests tax code VN for company code 1000 
and tax code I1 for company code 3000. 

In addition, the screen variants (transaction variants) are entered with business area and cost 
center. Relevant here is the G/L account, posting key, document currency amount, cost center or 
business area. 
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 Data Used During This Process 
Fields Europe North America Description 

Company code 1000 3000 Company code 

Chart of accounts INT INT Demo chart of accounts 

Currency DEM USD Local currency 

Reporting year 2000 2000 Demo reporting year (fiscal year) 

Comparison year 1999 1999 Previous year 
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Correspondence: Entering an Invoice 
Use 
It is now easier to post invoices thanks to the new Enjoy functions. This simplification consists of 
a single-screen transaction. This means that you can now post customers, vendors and G/L 
accounts on one screen rather than individual screens.  

In this process step you post an invoice for a customer. Afterwards, in the next transaction, you 
can generate account statements. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Procedure 
19. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70;FBL5 

The Customer Invoice Enter screen appears. 

20. Choose Environment → Set Company Code. In the dialog box, enter company code 1000 or 
3000, then choose . 

21. Choose  Tree on. 

22. On the Basic data tab page, enter the following data: 

Field Europe North America 

Customer 1000 3000 

Invoice date Today’s date - 1 month Today’s date - 1 month 

Posting date Today’s date - 1 month Today’s date - 1 month 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate (defaulted) DEM USD 

Calculate tax Select Select 

Tax code (defaulted) AN S1 

Table   

800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 12.000 12.000 

Business area 1000 1000 

G/L account 
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To simplify this process, we have not defined a cost element for account 800200. 
You do not therefore need an additional account assignment. The system does not 
transfer the data to Profit Center Accounting. 

23. Choose . 

Choose  if the system outputs any warning messages concerning the date. 

 
24. The system displays the address of the customer. To display the open items for this 

customer, choose  OIs. 

25. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

26. Choose . 

27. Choose  until the overview tree appears. 
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Correspondence: Generating Account Statements 
Use 
In this process step you generate account statements for IDES customers. The system only 
supplies account statements for those customers whose master data is maintained accordingly.  

You can find more information about this process under  [Page 293]. 

Procedure 
29. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Print Correspondence → Periodic Account Statements 

Transaction Code F0,27;SP01 

30. On the Periodic Account Statements screen, enter the following data: 

Fields Europe North America 

Company code 1000 3000 

Indicator in master record 2 2 

Key dates for acct statement 1st to last day of the current 
month 

1st to last day of the current 
month 

Correspondence SAP06 (correspondence 
reference) 

SAP06 (correspondence 
reference) 

Delete if finished 8 days 8 days 

Log to printer Name of your printer Name of your printer 

31. Choose . 

The system creates a correspondence request for all customers where the field “Account 
statement” is filled in the customer’s master record, and matches the desired account 
statement (in our example it was a monthly account statement with indicator “2”). 

The system tells you that n periodic account statements were requested.  

32. Confirm this message with . 

33. The system tells you that n correspondence requests were selected. Confirm this message 
with Yes. 

The system generates your print requests and displays the spool number under which 
they are stored. 

34. To see and then print the generated account statements, choose 

System → Services → Output Controller.  

The system supplies your user name and today’s date. 

35. Choose . 

36. In the Output Controller: List of Spool Requests screen, select the spool request that you 

April 2001  291 



Financial Accounting (FI)  SAP AG 

Correspondence: Generating Account Statements 

generated in step 6 (Title “SAP06 .....”). 

37. Choose . 

The first page of the generated account statement is formatted for viewing.  

38. Choose Goto → List Display. 

All invoices for the customer that were posted in the selected period are listed on the 
Print Preview for XXX screen. Payments made in the period are listed as well. The 
balance is calculated at the end of the list. 

39. Choose  until you reach the Output Controller: List of Spool Requests screen again. 

40. Select your spool request, then choose . 

The account statements are then output on your printer. 

41. To update the screen display, choose . When printout is completed, the print file has 
“Compl.” status. 

42. Choose  until the overview tree appears. 
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 Additional Information for Creation of Account 
Statements 
Programs used for correspondence between your accounting department and your customers 
and vendors as well as for purely internal communication all fall into the category of automatic 
correspondence. 

While internal messages and payment notices for a customer are part of day-to-day activities, 
account statements and balance confirmations are typical examples of closing operations. 
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Correspondence: Generating Balance Confirmations 
Use 
In this transaction, you will generate balance confirmations. The system will also automatically 
generate forms for entering a reply for a customer/vendor as well as forms for entering return 
flow to your company.  

You can find more information about this process under  [Page 296]. 

Procedure 
31. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Print Correspondence → Balance Confirmation → Print 
Letters 

Transaction Code F.17;SP01 

32. On the Customer Balance Confirmation screen, enter the following data: 

Fields Europe North America 

Customer 1000 3000 

Company code 1000 3000 

Reconciliation key date Last day of current period Last day of current period 

Individual customers Select Select 

Select Select 

K2 (by account number) K2 (by account number) 

Line item sorting P3 (by document date, document 
number) 

P3 (by document date, document 
number) 

Date of issue 5th of the next period 5th of the next period 

Date for reply 30th of the next period 30th of the next period 

Reply to 00001 00001 

Print control Enter your printer settings here 

Zero balances 

Correspondence sorting 

Enter your printer settings here 

33. Choose . 

The system creates a balance confirmation for exactly one customer as specified on the 
selection screen. 

Although a balance confirmation is several pages long, only the first page is displayed. 

34. To display the remaining pages, choose Goto → List Display. 

Along with the printout of this balance confirmation, you send your customer a list of their 
open items up to the key date and a reply form. 

35. Choose . 
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36. Choose  twice. 

A check list of accounts for which balance confirmations were generated is displayed. 

37. Choose . 

38. Choose . 

To make the return flow to the balance confirmations just generated more transparent, a 
summarized results table is also displayed at this point. 

39. Choose . 

40. Choose  again. 

On the Customer Balance Confirmation screen, the parameters you selected for the 
program are displayed. 

41. Choose  until the overview tree appears. 

42. Choose System → Services → Output Controller. 

The system supplies your user name and today’s date. 

43. Choose . 

The spool requests you created are displayed on the Output Controller: List of Spool 
Requests screen. 

44. Flag the spool requests, then choose . 

On the Spool: Output Request screen, check the name of the printer and select  until 
all requests have been printed. 

45. Choose  until the overview tree appears. 

 
You can create balance confirmations for vendors using the same procedure. The 
procedure is the same as for customer balances. 
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 Additional Information: Generating Balance 
Confirmations 
Balance confirmations can be generated from the debit or from the credit side. In both cases, for 
form structure type, we make a distinction between balance notification (negative inquiry), 
balance request (open method, request procedure), and balance confirmation (positive inquiry). 

For other situations that may arise, you can undertake a sample selection of customers/vendors 
who need to be informed in addition to selecting particular customers/vendors directly.  The 
scope of the sample is up to you. You may include aspects of external auditing or sample tests of 
your own accounts receivable/payable accounting. 
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Individual Value Adjustments: Entering the Invoice 
Use 
In the following process step, you will post overdue items for a customer so that you can make an 
individual value adjustment in the next transaction. 

Procedure 
19. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70 

The Customer Invoice Enter screen appears. 

20. Choose Environment → Set Company Code.  

21. Enter company code 1000 or 3000, then choose . 

 
(As this is an Enjoy transaction, the system suggests a company code for you). Make 
sure that the correct company code is specified when entering the invoice. If 
necessary, change the company code via Environment → Set Company Code. 
(Europe 1000, North America 3000). 

22. Choose  Tree on. 

23. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer 1320 3140 

Invoice date Today’s date - 6 months Today’s date - 6 months 

Posting date Today’s date - 6 months Today’s date - 6 months 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

DEM USD 

Calculate tax Select Select 

Tax code (defaulted) AN S1 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 12.000 12.000 

Business area 1000 1000 

Currency/rate (defaulted) 
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Choose  if the system outputs any warning messages concerning the date. 

 
To simplify this process, we have not defined a cost element for account 800200. 
You do not therefore need an additional account assignment. The system does not 
transfer the data to Profit Center Accounting. 

24. Choose . 

 
The system displays the address of the customer. To display the open items for this customer or 
the bank details, choose  OIs. 

25. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

26. Choose . 

27. Choose  until the overview tree appears. 
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Making Individual Value Adjustments for Doubtful 
Receivables 
Use 
In the previous transaction you entered a customer invoice. We will assume that the customer 
has not paid the invoice by the end of the year. You doubt whether this receivable will ever be 
paid, so you make a transfer posting for the receivable to an account for individual value 
adjustments. 

You can find more information about this process under  [Page 301]. 

Procedure 
19. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
Entry → Other → Internal Transfer Posting → Without Clearing 

Transaction Code F-21 

20. On the Enter Transfer Posting: Header Data screen, enter the following data: 

Field Europe North America 

Document date Last day of current period Last day of current period 

Company code 1000 3000 

Posting date Last day of current period Last day of current period 

Currency DEM USD 

PstKy 19 19 

Account 1320 3140 

Sp.G/L E (Special G/L indicator for individual 
value adjustment) 

E (Special G/L indicator for individual 
value adjustment) 

The E indicator tells the system that this is a special general ledger transaction. In other 
words, the amount will not be posted to the customer’s normal reconciliation account but 
to a special account instead. 

The customer’s reconciliation account is 140000. The item you posted in the last 
transaction is also posted to this account. Using individual value adjustment, you will 
transfer post the item from account 140000 (domestic customer receivables) to account 
142000 (individual value adjustments to customer receivables. 

21. Choose . 

The system tells you that the document date is in the future. 

22. Confirm the message with . 

23. On the Enter Customer Document: Add Customer Item screen, enter the following data: 

Field Europe North America 
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Amount 12.000,00 12.000,00 

Due on 30. of the following month 30. of the following month 

Text Value adjustment Value adjustment 

PstKy (G/L account) 40 (Posting key) 40 (Posting key) 

Account (G/L account) 210100 (Expense from individual 
value adjustment) 

210100 (Expense from individual 
value adjustment) 

24. Choose . 

25. On the Enter Customer Document: Create G/L Account Item screen, enter the following data: 

Field Europe North America 

Amount * * 

Tax code A0 (no tax procedure) S0 (no tax procedure) 

Value date Last day of current period Last day of current period 

26. Choose , and then note the document number. 

27. Choose  until the overview tree appears. 
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 Additional Information on Individual Value 
Adjustment for Doubtful Receivables 
Individual value adjustments are posted using the special G/L technique. You can maintain 
receivables separately in a customer and in a receivables account. You can thus look over 
individual value adjustments separately from receivables and keep the adjustments in a special 
reconciliation account. 
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Individual Value Adjustment: Display Customer Line 
Items 
15. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Account → 
Display/Change Line Items 

Transaction FBL5N 

16. On the Customer Line Item Display screen, enter the following data: 

Field Europe North America 

Customer account 1320 3140 

Company code 1000 3000 

Open items Select Select 

Open at key date Last day of current period Last day of current period 

Special G/L transactions Select Select 

Normal Items Select Select 

17. Choose . 

The Customer Line Item Display screen contains a list of customer line items. 

The receivable remains as an open item (untitled). The individual value adjustment is 
stated separately (titled ...Reserve for bad debt). 

18. Double-click on the receivables document. 

The first item in the document is displayed on the Display Document: Line Item 001 
screen. This is the customer item. 

In this case, the general ledger account is 140000 (domestic customer receivables). It is 
displayed in the G/L field in the upper right-hand corner of the screen. 

19. Choose  until you return to the Customer Line Item Display screen  

20. Double-click on the individual value adjustment document. 

The system displays the first item in the document. This is the customer item. 

The general ledger account in this case is 142000 (value adjustment to customer 
receivables). It is displayed in the G/L field in the upper right-hand corner of the screen. 

21. Choose  until the overview tree appears. 
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Valuating Open Items in Foreign Currency: Enter Invoice 
in Foreign Currency 
Use 
In the following transaction, you will post a vendor invoice in foreign currency so that you can 
valuate open items in foreign currency in the next transaction.  

 
You post the invoice directly in Financial Accounting, there is no integration with MM 
(Materials Management). This makes it easier to post backdated invoices. 

Procedure 
25. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document Entry → 
Invoice 

Transaction FB60 

The Vendor Invoice Enter screen appears. 

 
26. Choose Environment → Set company code. 

27. Enter company code 1000 or 3000, then choose . 

28. Choose  Tree on. 

29. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Vendor 1560 4940 

Invoice date 15.03.1999 15.03.1999 

Posting date 15.03.1999 15.03.1999 

Company code 1000 (IDES AG Frankfurt) 3000 (IDES US INC New York) 

Amount 12,000 (gross amount, 
including sales tax) 

12,000 (gross amount, 
including sales tax) 

Currency/rate USD DEM 

Calculate tax Select Select 

Tax code V9 I0 

Table   

G/L account 415000 415000 

D/C (defaulted) Debit Debit 
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Document currency amount 12.000,- 12.000,- 

Tax code V9 I0 

Cost center 1000 1000 

30. Choose . 

 

The system tells you that your posting is in the past. Confirm with . Business area 
9900 is entered in the table automatically. 

Account 415000 requires an assignment to a CO object, as it is defined as a cost 
element. Therefore you require an additional account assignment, for example cost 
center 1000. 

The system displays the address of the vendor.  

31. Choose  Ols.  

The amount in local currency is displayed in the local currency amount field. Translation 
occurs according to the exchange rate valid at the time of posting. 

Amounts in foreign currency are always translated at the average rate in the IDES 
system. Document currency is the US Dollar. 

32. Choose . 

33. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

34. Choose . 

35. Make a note of the document number. You will need it for the next transaction. 

36. Choose  until the overview tree appears. 
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Valuating Open Items in Foreign Currency: Post 
Exchange Rate Differences 
Use 
In this procedure, you will valuate items in foreign currency at the end of a period in order to post 
expenses or revenues from currency valuation. To simplify the demo, you only run the program 
for an item you have just posted.  That way, other IDES users can also go through the demo with 
their own documents. 

If you ran the program for all open items in foreign currency, then all items posted to accounts 
that have open item management would be valuated. The individual valuation principle 
determines the way valuation is carried out: Only individual items that are still open on the key 
date are considered for valuation. 

Prerequisites 
The demo valuation method that is used for foreign currency valuation of open items functions 
according to the lowest value principle. This means a valuation is only carried out using the 
lowest exchange rate. It might, therefore, be necessary to enter appropriate rates in Customizing 
before you post the vendor invoice. Here is a list of data that we will need for this example: 

Field Europe North America 

Date 15.03.1999 15.03.1999 

Exchange rate type M M 

From DEM DEM 

To USD USD 

Rate 0,54 0,53 

Date Last day of current period Last day of current period 

Exchange rate type M M 

From DEM DEM 

To USD USD 

Rate 0,53 0,54 

You can find more information about this process under  [Page 308]. 

Procedure 
17. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Periodic 
Processing → Closing → Valuate → Open Items in Foreign Currency 

Transaction Code F0,05 

18. On the Open Item Foreign Currency Valuation screen, enter the following data: 

Field Europe North America 

April 2001  305 



Financial Accounting (FI)  SAP AG 

Valuating Open Items in Foreign Currency: Post Exchange Rate Differences 

Company code 1000 3000 

Key date for OI overview Last day of current period Last day of current period 

Bal.sheet preparation valuatn Select Select 

For. curr. valuation method DEMO DEMO 

“Postings” tab page   

Creating postings Select Select 

Posting date Last day of current period Last day of current period 

Name of batch input session User name User name 

“Selections” tab page   

Select vendors Select Select 

Vendor account number 1560 4940 

Document number Document number from 
previous transaction 

Document number from 
previous transaction 

“Other” tab strip   

10 10 Valuation in curr.type 

19. Choose . 

• 3. Valuation of all vendors in a company code (for selected items) 

20. Choose 

On the Open Item Foreign Currency Valuation screen, you see a log listing the postings 
that were made. The log is six pages long: 

• 1. Valuation of items in foreign currency of a selected vendor (for the items selected. 

• 2. Valuation of items in foreign currency from a reconciliation account for domestic vendor 
receivables (for the items selected). 

• 4. Valuation of company code (for selected items). 

• 5. Valuation of all company codes (for selected items) 

• 6. List of postings to be generated and created documents with posting date and document 
number. 

. 

North America 

21. On the Print Screen List screen, enter the following data: 

Field Europe 

Output device Name of your printer Name of your printer 

Print immediately Select Select 

Delete after output Select Select 

22. Choose Continue. The Open Item Foreign Currency Valuation screen appears. 

23. Choose Postings. 

The posting for expense from currency valuation is: 
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Debit → Account 230010 (expense from currency valuation) 

Credit → Account 161099 (foreign vendor receivables (adjustment account). 

 
If you do this procedure in 1998, the exchange rate between DEM and USD changes 
every month, so that a new valuation can be made every month. If you want to see 
this demonstrated, carry out the same procedure again for the same document, but 
this time one month later. 

On the first page of the log, you will notice that the item was valuated again, this time at 
the rate valid on the day of the valuation. 

On the last page, another amount is posted. The system uses the amount posted at the 
last valuation and only posts the difference. 

 
For a valuation that does not affect the balance sheet, all postings are reversed on 
the reversal date. 

24. Choose  until the overview tree appears. 
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 Additional Demo Information 
We entered fictitious exchange rates for 1999 for DEM/USD parity. Proceed as follows to 
maintain the rates yourself: 

21. Call up the transaction as follows: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit Project → SAP Reference 
IMG 

Transaction Code OB08 

22. Choose activity  Enter Exchange Rates. The Display View “Currency Exchange Rates”: 
Overview screen appears. 

23. Choose New Entries. 

24. On the New Entries: Overview of Added Entries screen, enter the following data: 

Field Europe North America 

ExRt M (Multicash) M (Multicash) 

From (currency) DEM DEM 

To (currency) USD USD 

Valid from Any Any 

Rate Any Any 

25. Choose . 

The Prompt for Customizing Request dialog box appears. 

26. Choose . 

27. In the Create Request dialog box, enter the following data: 

Field North America 

Short description Current exchange rate 

28. Choose . 

29. Choose . 

The system informs you that the data was saved. 

30. Choose  until the overview tree appears.  
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Valuation of Open Items in Foreign Currency: Display 
Document 
11. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document → 
Display 

Transaction Code FB03 

12. Enter the document number from page 7 of the log. 

This is the document that was posted after the first foreign currency valuation. 

13. Choose . 

The system displays the document in foreign currency. The amounts have now been 
assigned. 

14. Choose  Choose. 

In the dialog box, choose: 

The amounts are now displayed in the local currency DEM. They correspond to the log 
amount. 

15. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Enter Invoice 
Use 
Invoices can be posted easily. This simplification consists of a single screen transaction. This 
means that you can now post customers, vendors and G/L accounts on one screen.  

In this transaction, you will enter a customer invoice that has a remaining life of more than a year. 
For this reason and also because of EU Guideline 4, the item has to be transfer posted to a 
special account if it is still open at the end of the period. 

 
You post the invoice directly in Financial Accounting, there is no integration with the 
Sales and Distribution application. This makes it easier to post backdated invoices. 

Prerequisites 
Tax code AN (16%) is automatically defaulted for company code 1000 and S1 for company code 
3000. We have also created a screen variant with a business area to be used as a work 
template. The ready-for-input columns are the G/L account, the posting key, the amount, the 
amount currency, and the business area. 

Procedure 
19. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document Entry 
→ Invoice 

Transaction FB70 

The Customer Invoice Enter screen appears. 

20. Choose Environment → Display document flow. 

21. Enter the version 1000, then choose . 

 

22. Choose . 

23. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Customer 1174 3176 

Invoice date Today’s date -1 months Today’s date -1 months 

Posting date Today’s date -1 months Today’s date -1 months 

Amount 100.000 (gross amount, 
including sales tax) 

100.000 (gross amount, 
including sales tax) 

Currency / rate (defaulted) DEM USD 
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Calculate tax Select Select 

Tax code (defaulted) AN S1 

Incoming payment   

Payt terms Empty Empty 

Group (first field) 720 days 720 days 

Days (other fields) Empty Empty 

Table   

G/L account 800200 800200 

D/C (defaulted) Credit Credit 

Document currency amount 100.000 100.000 

Business area 1000 1000 

 
To simplify this process, we have not defined a cost element for account 800200, 
which means that you do not need to assign a CO object, for example, an order 
number. You do not therefore need an additional account assignment. The system 
does not transfer the data to Profit Center Accounting. 

24. Choose . 

 
The system displays the address of the customer. If you wanted to display the open items for this 
customer or the bank details, you could choose  OIs or  Bank Details. 

25. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

26. Choose . 

27. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Execute Program 
9. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Periodic 
Processing → Closing → Regroup → Receivables/payables 

Transaction Code F101 

10. On the Balance Sheet Supplement – OI – Analysis per_ screen, enter the following data: 

Field Europe North America 

Company code 1000 3000 

Balance sheet key date Last day of current period Last day of current period 

“Selections” tab page    

Customer 1174 3176 

“Postings” tab page   

Carry out postings Select Select 

Batch input session name SAPF101 SAPF101 

Document type DR DR 

Posting date Last day of current period Last day of current period 

Posting period Current period Current period 

11. Choose . 

If any warning messages appear, choose . 

The system displays a log listing which postings were carried out. The log is 5 pages 
long: 

• 1. Valuation of domestic receivables with remaining life of more than one year (for selected 
items) 

• 2. Valuation of all receivables with remaining life of more than one year (for  

selected items) 

• 3. Valuation of all receivables in selected company code with 

remaining life of more than one year (for selected items) 

• 4. Valuation of all company codes (for selected items) 

• 5. List of documents to be generated with posting date and document number and 
specification of batch input session 

 
If you just executed the program for receivables, the system would have evaluated 
receivables with remaining lives of more than one and more than five years. 
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12. Choose  until the overview tree appears. 
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Allocation of Receivables and Payables According to 
Remaining Life: Generate Postings 
Use 
The transfer postings to be generated are saved in a batch input session. In the next step you will 
process this session. 

Procedure 
25. Call up the transaction using the menu path as follows: 

Menu Path Choose System → Services → Batch Input → Sessions 

Transaction Code SM35 

26. On the Batch Input: Session Overview screen, choose the  tab page. 

27. Double-click on session SAPF101. 

28. Depending on the status of your session, you can view the session again under the 
appropriate tab page category. 

29. Select your session, then choose . 

30. Choose  Process.  

In the dialog box, select Display errors only, then choose Process.  

The system tells you that processing was completed successfully.  

31. Choose System → Services → Batch Input → Sessions again. 

32. On the Batch Input: Session Overview screen, your session should display the status 
Processed.  

33. Choose  until the overview tree appears. 

34. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
→ Display 

Transaction Code FB03 

The number of the document just posted is entered in the field automatically by the 
system. 

35. Choose . 

The posting appears as follows on the Document Overview screen: 

Credit → Account140020 (domestic customer receivables with remaining life of more 
than one year) 

Debit → Account 140099 (domestic customer receivables) 

36. Choose  until the overview tree appears. 

314  April 2001 



 SAP AG Financial Accounting (FI) 

 Allocation of Receivables and Payables According to Remaining Life: Generate Postings 

 
To see what happens in Accounts Payable, you can now enter an invoice for a 
vendor on the same model where the remaining life is more than one year. 

Execute the program for allocation again, this time for account type K (vendor). 
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 Closing Activities in General Ledger Accounting 
Purpose 
In this process, you first reconcile the debit and credit balances of the posted documents with the 
debit and credit balances of the transactions figures in A/P, A/R, and the general ledger, to check 
the accuracy of the data in the system. 

You then complete various closing activities: foreign currency valuation of assets, prepaid 
expenses and unearned revenue adjustments, analysis of the purchase orders in process, and 
clearing of accounts. 

In the last part of this process, you run a few programs that document the accounting documents 
(document journal, list of G/L account postings) and then create financial statements. 

 
To avoid output errors, check your print settings before starting this process chain. 

a. To do this, select System → User Profile → Own Data. 

b. In the Maintain User Profile screen, select the tabstrip Defaults, and make the following 
settings: 

Field Data 

Output device Name of printer you wish to use 

c. Choose . 

d. Choose  until the overview tree appears. 

You can find more information about this process under  [Page 318]. 

Process Flow 
You can find the data for this process under  [Page 319]. 

1. Reconciliation Documents - Transaction Figures [Page 322] 

2. Accruals/Deferrals: Entering Rent Expense [Page 324] 

3. Accruals/Deferrals: Creating Deferral/Referral Postings [Page 32 ]6  

4. Accruals/Deferrals: Making Reversing Entries [Page 328] 

5. Foreign Currency Valuation of Balances: Enter Bank Postings (Enjoy) [Page 33 ]0  

6. Foreign Currency Valuations of Accounts: Entering Exchange Rates [Page 33 ]2  

7. Foreign Currency Valuation of Accounts: Performing Valuation [Page 334] 

8. Foreign Currency Valuation of Accounts: Running Batch Input Sessions and Displaying 
Posting Documents [Page 336] 

9. GR/IR Clearing Account Analysis: Entering Material Orders [Page 338]  

10. GR/IR Clearing Account Analysis: Entering a Goods Receipt [Page 340] 
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11. GR/IR Clearing Account Analysis: Running the Program [Page 34 ]2   

12. GR/IR Clearing Account Analysis: Start Batch Input Session and Display Documents Posted 
[Page 344]  

13. Automatic Clearing of GR/IR Clearing Accounts [Page 346]  

14. Compact Document Journal [Page 348]  

15. Account Update: Compilation of G/L Account Postings [Page 349]  

16. Creating Business Reports [Page 351]  

17. Sending Business Reports [Page 353]  

18. Receiving Closing Reports [Page 354]  

19. Information on Exchange Rate Types [Page 355]  

20. Lowest Value Principle [Page 356] 

21. Batch Input Session [Page 357]  

22. Analysis Information [Page 358]  

23. Information on Creating Business Reports [Page 359] 
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 Additional Process Information 
Open items are required for most of these transactions. In order to ensure that there will be 
open items available in the system, you should enter some simple invoices in Accounts 
Receivable and Accounts Payable as well as incoming and outgoing payment transactions 
before starting the closing program. 

To do this, you will have to enter the following kinds of documents: 

• Vendor invoice so you can make a posting for prepaid expenses. 

• Bank transaction in a foreign currency in a cash account for the foreign currency valuation of 
accounts. You will also maintain the exchange rates so that exchange rate differences are 
determined during valuation. 

• Purchase orders and goods delivery in MM in order to enter adjustment postings as part of 
the analysis of the GR/IR clearing accounts. 

If other open items already exist in the system, they will also be evaluated and possibly 
transferred if they meet the selection criteria. 

A/P A/R and G/L account postings can be entered in a one-screen transaction as part of 
the Enjoy initiative. 

For the vendor invoice, the system automatically suggests tax code AN (16%) for company 
code 1000 and tax code S1 for company code 3000. 

We have also created a screen variant (transaction variant) with a business area or cost 
center to be used as a work template. Relevant columns are the G/L account, posting key, 
amount, document currency, and cost center or business area. 

The most frequently required input fields are displayed on the first tab page. 
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 Data Used During This Process 
Field Data 

Vendor invoice:  

Company code 1000 

Fiscal year Current fiscal year 

Fiscal period Current period 

Document date 12/01 of current fiscal year 

Company code 1000 

Posting date 12/01 of current fiscal year 

Currency DEM 

Account (Vendor) 1570 

Amount 4,500.00 

Tax code V0 

Text Rent for storage in Hamburg / Dec. to Feb. 

Posting key 40 

Account (G/L account) 470000 

Business area 1000 

Cost center 4220 

Deferral posting:  

Document date 31.12. 12/31 of current fiscal year 

Document type SA 

1000 

Posting date 12/31 of current fiscal year 

Reversal date 01/01 of the following fiscal year 

Posting key 40 

98000 

Amount 3,000.00 

Tax code V0 

Business area 1000 

Text Accrued rent for storage in December 

PstKy 50 

Company code 

Account (accrued income) 
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Account (expense) 470000 

Business area 1000 

Cost center 4220 

Foreign currency  

Document date Today‘s date 

Company code 1000 

Currency USD 

Posting key 40 

Account (D bank USD account) 113150 

Amount 20,000.00 

Business area 9900 

50 

Account (D bank, domestic) 113100 

Exchange rate type M 

Key date The last day of the current month 

Method for company code currency DEMO 

Posting period Current month 

The last day of the current month 

Document date The last day of the current month 

Account (exchange rate difference) 230000 

Purchase order and goods receipt:  

Order type NB 

Purchasing organization 1000 

Purchasing group 001 

Delivery date Today’s date, plus 20 days 

Plant 1000 

Storage location 0001 

Material v10 

PO quantity 1000 

Net price 100 

Document date Today’s date 

Movement type 101 

Posting key 

Posting date 

Vendor 1006 
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Plant 1000 

Storage location 0001 

Date of material document 1999 
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Reconciliation of Documents and Transaction Figures 
Use 
In this process, you check the debit and credit transaction figures of customer, vendor and G/L 
accounts with the debit and credit totals of the posted documents and check the debit and credit 
transaction figures of these accounts with the debit and credit balances of the application indices. 

This reconciliation gives you the assurance that your books are technically correct (comparison 
of individual documents with the totals). 

For quality assurance reasons, this reconciliation report should be a part of each month's closing 
process. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Periodic 
Processing → Closing → Check/count → Comparison 

Transaction code F.03 

2. In the Financial Accounting Comparative Analysis Screen, make the following entries: 

Field Data 

Company code 1000 

Fiscal year Current fiscal year 

Fiscal period Current period 

Fiscal period to Current period 

Documents - transaction figures Select 

Indexes - transaction figures Select 

3. Choose . 

A detailed report is displayed with information about the comparison of the balances in 
A/P,A/R and the general ledger. The differences should always equal zero. 

At the end of the list, the message "No differences have appeared" is displayed. 

4. Choose . 

5. In the Financial Accounting Comparative Analysis screen, keep the same selection criteria 
while additionally selecting the "Display history" field. 

6. Choose .  

The results of all previous analyses are displayed in summarized form.  

If the report has only be executed once, the list will only have one entry. 

7. Position your cursor on a line and choose Totals. 

In the display totals dialog box, the system displays the results of the comparison for the 
period selected (totals per A/R, A/P and general ledger accounts). 
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8. Choose Back. 

9. Choose Accounts. 

If differences occurred, the accounts are displayed in which differences between the total 
of the line items and the transaction figures or indexes occurred. 

Choose Back. 

10. Choose  until the overview tree appears. 
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Accruals/Deferrals: Entering Rent Expense 
Use 
You create the vendor invoices in a single-screen Enjoy transaction. You enter the rent expense 
for a storage hall. The rent is due on the first of March, June, September and December for the 
current and the two following months respectively. 

In the example, the current date is the first of December. The rent thus has to be entered for 
December of the current fiscal year as well as for January and February of the following fiscal 
year. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document Entry → 
Invoice 

Transaction FB60 

The Vendor Invoice Enter screen appears. 

 
Choose Environment → Set Company Code. If the Set Company Code dialog box 
appears, enter 1000 and choose . 

2. Choose  Tree on. 

3. On the Basic Data tab page, enter the following data: 

Field Europe 

Vendor 1570 

Invoice date 12/01of the current fiscal year 

01.12. of the current fiscal year 

Company code 1000 (IDES AG Frankfurt) 

Amount 4500 (gross amount, including sales tax) 

Currency/rate (defaulted) DEM 

Calculate tax X 

Tax code V0 

Text Rent for storage in Frankfurt / Dec. to Feb. 

Table  

G/L account 470000 

D/C (defaulted) Debit 

Amount 4500,- 

Posting date 
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Tax code V0 

Business area 1000 

Cost center 4220 

4. Choose  Simulate. 

The system tells you that the document date is in the future. Choose . 
In the Document Overview screen, the document entered is displayed. The journal 
entry appears as follows: 

• Debit: Account 470000 (Occupancy costs)    
   4,500.00 DEM 

• Credit: Account 1570  Lenzmann Immobilien (accounts payable)
 4,500.00 DEM 

Account 470000 requires an assignment to a CO object, as it is defined as a cost 
element. Therefore you require an additional account assignment, for example cost 
center 1000. 

5. Choose . 

6. Make a note of the document number. You will need it for the next transaction. 

7. Choose  until the overview tree appears. 
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Accruals/Deferrals: Creating Deferral/Accrual Postings 
Use 
From a cash flow point of view, the money is spent in the current fiscal year. However, with 
accrual-based accounting, only a portion of the expense can be posted in this year: a deferral of 
the expense is necessary. The expense for January and February of the next fiscal year is thus 
posted to an account for active prepaid expenses. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Periodic 
Processing → Closing → Valuate → Enter accrual/deferral document 

Transaction Code FBS1 

2. In the Enter Accrual/Deferral Doc.: Header Data screen, enter the following data: 

Field Data 

Document date 12/31of the current fiscal year 

Document type SA 

Company code 1000 

Posting date 12/31of the current fiscal year 

Reversal reason 05 (accrual) 

Reversal date 01/01of the following fiscal year 

PstKy 40 

Account (accrued income) 98000 

 
The reversal date is noted by the system and will automatically be used as the 
posting data in the document when the posting is reversed. 

3. Choose . 

Choose  if the system outputs any warning messages. 

4. In the Enter Accrual/Deferral Doc.: Add G/L account item screen, enter the following data: 

Field Data 

Amount 3,000.00 

Tax code V0 

Calculate tax Select 

Business area 1000 

Text Prepaid rent for storage in December 
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PstKy 50 

Account (expense) 470000 

5. Choose . 

6. In the Enter Accrual/Deferral Doc.: Add G/L account item screen, enter the following data: 

Field Data 

Amount * 

Cost center 4220 

Text Prepaid rent for storage in December 

7. Choose . 

Skip the warnings by choosing . 

The document number is displayed in the status bar. Make a note of the document 
number. You will need it for the next activity. 

8. Choose Document → Display. 

The document you just posted is displayed. The journal entry appears as follows: 

• Debit: Account 98000 (Accrued income) 3,000.00 DEM 

• Credit: Account 470000 (Occupancy costs)  3,000.00 DEM 

The amount of 3,000.00 DEM should be considered an expense in the following year and 
was thus transferred from the expense account for rent to a balance sheet account for 
prepaid expenses. 

9. Choose  until the overview tree appears. 
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Accruals/Deferrals: Making Reversing Entries 

Procedure 
1. Call up the transaction as follows: 

Use 
At the start of the next year, you have to reverse the accrual/deferral postings. This posts the 
amounts to rent expense for the months January and February. In this activity, you complete the 
reversal posting of the 3,000.00 DEM to the expense account for rent. 

Menu Path From the General Ledger node, choose Periodic processing → Closing → 
Valuate → Reverse accrual/deferral document 

Transaction Code F0.81 

2. In the Reverse Accruals: Initial Screen, enter the following data: 

Field Data 

Company code 1000 

Document number of the accrual document from the previous process. 

Test run Select 

Document number 

 
Normally, you would select more than one document. In this example. you only 
reverse the one posting. this ensures that you do not change the data set of other 
users. 

3. Choose . 

The log shows the documents that can be reversed. 

4. Choose Reverse documents. 

The document number of the reversal posting is now displayed under the accrual 
document. 

5. Make a note of this document number. 

6. Choose  until the overview tree appears. 

7. Call up the transaction as follows: 

Menu Path From the General Ledger node, choose Document → Display 

Transaction Code FB03 

8. In the Display Document: Initial Screen, enter the following data: 

Field Data 

Reversal document number from step 5 

Company code 1000 

Document number 
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Fiscal year 2001 

9. Choose . 

The document you just posted is displayed. The journal entry appears as follows: 

• Debit: Account 470000 (Occupancy costs)  3,000.00 DEM 

• Credit: Account 98000 (Accrued income) 3,000.00 DEM 

The reversal transfers the amount from the balance sheet (asset item) to the profit and 
loss statement where it is an expense item. 

The posting date is the date that you entered as the reversal date in the reversal 
document. 

10. Choose  until the overview tree appears. 
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Foreign Currency Valuation: Enter Bank Transactions 
(Enjoy) 
Use 
In this process, you transfer money from one of the house banks of the IDES Company to one of 
the foreign currency accounts. The account in question is kept in US dollars. The transfer is thus 
completed in US dollars. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Document Entry → 
G/L Account Posting 

Transaction FB50 

You reach the G/L account posting screen: 

 

2. Choose Environment → Set company code. Enter 1000 and choose . 

3. Choose  Tree on. 

4. On the Basic Data tab page, enter the following data: 

Field Data 

Document date Today’s date 

Company code (defaulted) 1000 (IDES AG Frankfurt) 

Posting date Today’s date 

Currency USD 

Table  

G/L account (first item) 113150 

D/C (first item) Debit 

Amount (first item) 20,000.- 

Business area (first item) 9900 

G/L account (second item) 113100 

D/C (second item) Credit 

Amount (second item) 20,000.- 

Business area 9900 

Account 113150 is listed in the chart of accounts of the company code as a foreign 
currency account kept in US dollars. 
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Account 113100 is listed in the chart of accounts of the company code as a current cash 
account kept in the local currency. 

5. Choose . 

In the upper right-hand corner of the screen, you see the debit and credit totals. 

6. Choose  Simulate. 

The Document Overview screen appears. The document is displayed. 

The document appears as follows: 

• Debit: Account 113150 (Dbank USD account) 20,000.00 USD 

• Credit: Account 113100 (Dte bank, domestic)  20,000.00 USD 

7. Choose . 

The system informs you that the document has been posted in the company code. Make 
a note of the document number. 

8. Choose  until the overview tree appears. 

9. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Document → Display 

Transaction FB03 

10. In the Display Document: Initial Screen, enter the following data: 

Field Data 

Document number Document number from step 6 

Company code (defaulted) 1000 (IDES AG Frankfurt) 

Fiscal year 2000 

11. Choose . 

The document overview appears. 

12. Select Choose. 

13. In the Display Variant: Choose dialog box, choose the variant 1SAP (amount in document 
and local currencies) by positioning the cursor on the variant. 

The amounts are now displayed in the local currency DEM as well. 

14. Choose  until the overview tree appears. 
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Foreign Currency Valuations of Accounts: Entering 
Exchange Rates 
Use 
You want to valuate the balances at the end of the month. Since the DEM/USD exchange rates 
have changed, you need to enter these changes in the system. There is a table which can be 
accessed from every FI application component using the same menu path. You access this table 
in order to enter the new exchange rate at the end of the month.  

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Environment → 
Current settings → Enter exchange rates 

Transaction Code OB08 

In the Change View "Currency Exchange Rates": Overview screen, a table is displayed. 
The exchange rates are arranged based on exchange rate types. Generally, the amounts 
posted in foreign currencies are translated using exchange rate type M (standard 
translation at the average rate) to the local currency in our IDES model. 

You can find more information about exchange rate types under  [Page 355]. 

2. Choose  Position... 

3. In the Another entry dialog box, enter the following data and then choose . 

Field Data 

Exch. rate type M 

From currency DEM 

To currency USD 

The top line in the screen in now positioned on the DEM/USD exchange rates. 

4. Select the last valid exchange rate and choose . 

5. In the change View "Currency Exchange Rates": Overview of Selected Set" screen, make the 
following entries: 

Field Data 

Valid from Last day of the current month 

Dir. quote Enter a higher exchange rate than the previously valid rate 

 
If for example, the exchange rate from DEM to USD was 0.60000, enter a new rate 
of 0.61000. During the valuation, the system will determined that the balance in the 
foreign currency account has a lower DEM value at the month's end than it did at the 
time of the transaction. 
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6. Choose . 

7. Choose . 

 
If the request management is activated in your system, a prompt for customizing 
request appears in which you are prompted to enter the change request number for 
the table change. If so, complete steps 8 through 11. Otherwise, proceed to step 12 
of this process. 

8. Choose . 

9. In the Create request dialog box, enter the text exchange rate. 

10. Choose . 

This returns you to the Prompt for customizing request dialog box. 

11. Choose . 

Your change is now saved in the system. 

12. Choose  until the overview tree appears. 
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Foreign Currency Valuation of Balances: Performing 
Valuations 
Use 
It is now the end of the month. You want to valuate the balances of the model company in a 
foreign currency and if necessary post the profit or loss from the valuation to the profit and loss 
statement. 

For this reason, there is a report in the system for performing the valuation and automatically 
making the necessary adjustment postings. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Periodic 
Processing → Closing → Valuate → Foreign currency valuation of 
inventory 

Transaction Code F0.06 

2. In the Valuate G/L Accounts Kept in Foreign Currency at Key Date screen, make the 
following entries: 

Field Europe 

Company code 1000 

Key date The last day of the current month 

Valuation in curr.type 10 

Method DEMO 

Create batch input session Select 

Batch input session name Your user name or other identification 

Posting date The last day of the current month 

Document date The last day of the current month 

Posting period Current period 

 
The method DEMO describes a method for valuating balances in foreign currencies. 
We have defined various methods in the IDES System. The DEMO method uses the 
lowest value principle [Page 356] for valuation. The valuation difference is only 
output with this valuation method, if it represents an expense (that is, a loss from the 
exchange rate difference). 

 
If you want to run a valuation without making any postings, select the Batch input 
session not desired field. 
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3. Choose . The Valuate G/L Accounts Kept in Foreign Currency at Key Date screen 
appears. 

The system outputs a log with the valuation of the accounts per business area. You 
should see a valuation difference for business area 9900. No postings have been 
created. 

 
If you enter an exchange rate that is lower than the previous rate, the system does 
not calculate a difference. In this case, the valuation would calculate a profit instead 
of a loss for the exchange rate difference. Since you are using the lower value 
principle, no profit may be posted. 

4. Choose List → Print. 

5. In the Print Screen List screen, enter the following data: 

Field Data 

Output device The printer connected to your computer 

Print immediately Select 

Delete after output Select 

New spool request Do not select 

6. Choose Continue. 

The log is sent to your printer for printing. 

7. Choose  until the overview tree appears. 
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Foreign Currency Valuation: Batch Input Sessions & 
Doc. Display 
Use 
If losses were determined from exchange rate differences, the postings are saved in a batch 
input session [Page 357]. You are to now to post the differences using this session. 

Procedure 
1. Call up the transaction using the menu path as follows: 

Menu Path Choose System → Services → Batch Input → Sessions 

Transaction Code SM35 

2. In the Batch Input: Session Overview screen, enter the following data: 

Field Data 

Session name Name of your batch input session 

If you cannot remember the name, enter a star in the session name field and choose . 

3. Choose . 

4. Select your batch input session in the Batch Input: Session Overview screen. 

5. Choose  Process. 

6. In the Process Session XXXX dialog box, select Display error only. 

7. Choose Process. 

The runtime of the session depends on the number of postings to be made. 

8. An Information dialog box appears, noting that the batch input processing is complete. 
Choose Exit. 

The documents needed have been created. You can now display them. 

9. Call up the transaction as follows: 

Menu Path From the General Ledger node, choose Account → Display balances 

Transaction Code FS10N 

10. In the G/L Account Balance Display screen, enter the following data: 

Field Data 

Account number 113150 

Company code 1000 

1999 Fiscal year 

11. Choose . 
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12. In the G/L Account Balance Display screen, choose Document currency. To display the 
balances in USD, select USD in the dialog box. 

The system lists the monthly debit and credit balances of the foreign currency account in 
the G/L Account Balance Display: Foreign Currency screen. 

13. Display the line items of the current period (or for the period in which the valuation was 
performed) by double-clicking on the amount of the period in the column Balance. 

In the G/L Account Line Item Display screen, the system lists the documents that were 
posted in this period. The amounts are displayed in US dollar. The documents you 
created have a balance of zero 

The exchange rate differences are posted by business area.  

14. Select one of the documents posted for the exchange rate differences. The Display 
document: Line Item XXX appears, displaying one line of the document. 

15. Choose . 

The document appears as follows: 

• Debit: Account 230000 (foreign currency rev) 0.00 USD 

• Credit: Account 113150 (Dbank USD account)  0.00 USD 

16. Select Choose. 

Select variant 1SAP to display the amounts in document and local currencies. The 
amounts are displayed in DEM as well. The DEM balance of the foreign currency 
account has be adjusted based on the exchange rate difference. 

17. Choose  until the overview tree appears. 
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GR/IR Clearing Account Analysis: Entering Material 
Orders 
Use 
As an additional closing procedure, you need to analyze the invoices received and the goods 
received. 

You can find more information about this analysis under  [Page 358]. 

In this process, you create an order in Materials Management for a purchase from a know 
supplier of the IDES Company. You will then enter the goods receipt. We will assume that no 
invoice has yet been received for the delivery at the time you create financial statements. For this 
reason, an adjustment is calculated during the analysis of the GR/IR clearing account for the 
amount not yet delivered and then posted. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistic → Materials Management → Purchasing → Purchase Order → 
Create 

Transaction Code ME21N 

2. Select Supplier/warehouse known. 

3. In the Create Purchase Order screen, enter the following data: 

Field Data 

 
 

Standard purchase order 

Vendor 1006 

Document date Today’s date 

4. Choose . 

5. If required, you can expand the item data area, by choosing  Header. 

6. On the Org. Data tab of the header data area, use the F4 input help to enter the following 
data: 

Field Data 

Purchasing org. 1000 

Purchasing group 001 

Company code 1000 

7. Choose . 

8. If required, you can expand the item data area, by choosing  Header. 

9. Enter the following data: 
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Field Data 

Material v10 

PO quantity 1000 

Net price 100 

Delivery date Today's date plus 20 days 

Plant 1000 

Storage location 0001 

10. Choose . 

11. Choose . 

 
The system confirms the posting and assigns a purchase order document number. 
Note this number for future reference. 

12. Choose  until the overview tree appears. 
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GR/IR Clearing Account Analysis: Entering a Goods 
Receipt 
1. Call up the transaction as follows: 

Menu Path From the Purchasing node, choose Purchase Order → Follow-on functions 
→ Goods Receipt. 

Transaction Code MB01;MB03;FB03 

2. In the Goods Receipt for Purchase Order: Initial Screen, enter the following data: 

Field Data 

Document date Today’s date 

Movement type 101 

Purchase order Purchase order number from the previous activity 

Plant 1000 

Storage location 0001 

3. Choose . 

The items for this purchase order appear in the Goods Receipt for PO: Selection Screen 
XXXX / XXXX. In this example, there is only one item for the purchase order number. If 
the quantity delivered does not match the quantity ordered, the value in the quantity field 
has to be adjusted accordingly (purchase order amount from the previous step). 

4. Choose Adopt + Details.  

The data from the purchase order item are transferred to the goods receipt. 

5. In the Goods Receipt for Purchase Order: New Item XXXX, choose . 

The document number appears in the status bar. Make a note of the document number. 

6. In the Goods Receipt for Purchase Order: Initial Screen, choose Goods receipt → Display. 

7. Enter the following data: 

Field Data 

Material doc. Document number from step 6 

2000 Mat. doc. year 

8. Choose . The Display Material Document XXXX: Overview screen appears. 

9. Choose Accounting docs... to see the accounting document. 

10. In the List of Documents in Accounting dialog box, choose Accounting document. 

The document appears as follows: 

• Debit: Account 300000 (Inventory: Raw materials) 

• Credit: Account 191100 (Goods recvd / Invoice recvd) 
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This document is an open item that is only cleared once the invoice for the order has 
been received. 

In this example, we will not enter an invoice received. Because of this, you have to make 
an adjustment posting for the quantity received that has not yet been billed. 

11. Choose  until the overview tree appears. 
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GR/IR Clearing Account Analysis: Running the Program 
Use 
In this process, you determine whether all invoices for goods received have been posted as well 
as the goods receipt. For goods received that have not yet been billed and vice versa, 
adjustment postings are made in a batch input session [Page 357]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Periodic 
Processing  → Closing → Regroup → GR/IR Clearing 

Transaction Code F0.19 

2. In the Analyze GR/IR Clearing Accounts and Display Acquisition Tax screen, make the 
following entries: 

Field Europe 

G/L account 191100 to 191199 

Company code 1000 

Key date Last day of current period 

Select 

“Postings” tab page  

Creating postings Select 

Name of batch input session Your user name or other identification 

Last day of current period 

Reverse posting date First day of next period 

Document type C1 

GR/IR clearing 

Posting date 

 
In our example, you only need to make adjustment postings for account 191100 
(GR/IR clearing account - External orders). However, you selected a range of G/L 
accounts. This is a standard selection, which contains account 191100. Leave the 
settings as entered. 

3. Choose . 

After a few minutes you receive a list of adjustment postings that need to be made. The 
postings have not yet been made. 

The open items are sorted by vendor. Each line contains the transaction key in the first 
column. To the right of this is a document number that identifies the goods receipt (GR) 
or the invoice receipt (IR). 
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For the purchase order you created, you have posted a goods receipt that can be seen in 
this list. 

4. Choose List → Print. 

5. Enter the following data: 

Field Data 

Output device a printer connected to your computer 

Print immediately Select 

Delete after output Select 

New spool request Do not select 

6. Choose Continue. 

The log is sent to your printer for printing. 

7. Choose  until the overview tree appears. 
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GR/IR Clearing Acct Analysis: Batch Input Sessions & 
Doc.Display 
Use 
The adjustment postings were saved in a batch input session during the last process. You will 
now post the documents in the batch input session and then display these documents. 

Procedure 
1. Call up the transaction using the menu path as follows: 

Menu Path Choose System → Services → Batch Input → Sessions 

Transaction Code SM35 

2. In the Batch Input: Session Overview screen, make the following settings: 

Field Data 

Session name Name of your batch input session 

3. If you cannot remember the name, enter a star in the session name field and choose . 

4. Choose . 

5. Select your batch input session in the Batch Input: Session Overview screen. 

6. Choose  Process. 

7. In the Process Session XXXX dialog box, select Display errors only. 

8. Choose Process. 

The runtime of the session depends on the number of postings to be made. 

9. An Information dialog box appears, noting that the batch input processing is complete. 
Choose Exit. 

The documents needed have been created. You can now display them. 

10. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Document → 
Display 

Transaction Code FB03 

11. The Display Document: Initial Screen appears. 

12. Choose  List. 

13. In the Document List screen, enter the following data: 

Field Data 

Company code 1000 

Fiscal year Current fiscal year 
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Document type C1 

Entry date Today’s date 

Own documents only  Select 

 
With this selection you ensure that only documents with document type C1 (closing: 
GR/IR accounts) that you created today are displayed. 

14. Choose . 

The number of documents in the list depends on the number of invoices and good 
receipts that have no been cleared against each other in the GR/IR clearing accounts. 

15. Select a document and choose . 

In the case of a delivery that has not been billed, the posting is as follows: 

• Debit: Account 191102 (GR/IR: unbilled deliveries) 

• Credit: Account 191199 (GR/IR: Acquired externally) 

In the case of a bill for which goods have not yet been received, the posting is as follows: 

• Debit: Account 191199 (GR/IR: Acquired externally) 

• Credit: Account 191101 (GR/IR: deliveries outstanding) 

Adjustment postings are made to the accounts 191101 and 191102. 

In financial statement version INT (using for reporting in company code 1000), accounts 
191101 (other assets) and 191102 (other accrued liabilities) are assigned to lines in the 
balance sheet. Accounts 191100 and 191199 are in the notes to the financial statement. 

16. To display other documents, choose , until you are back at the List documents screen, 
where you can select a different document. 

17. Choose  until the overview tree appears. 
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Automatic Clearing of GR/IR Clearing Accounts 
Use 

Menu Path 

Independent of the GR/IR clearing account analysis, you also need to clear these accounts. A 
program automatically clears goods received against the invoices received if the information 
matches. 

Procedure 
1. Call up the transaction as follows: 

Accounting → Financial Accounting → General Ledger → Periodic 
processing → Automatic clearing 

Transaction Code F.13 

2. In the Automatic Clearing screen, enter the following data. 

Field Data 

1000 

Fiscal year Current fiscal year 

GR/IR account special process Select 

G/L accounts Select 

G/L accounts 191100 to 191199 

Clearing date Last day of current period 

Test run Select 

Detail list with error log Select 

Company code 

 
Run the process in test mode only. This allows you and other users of the IDES 
System to repeat this process. 

3. Choose . 

The log list the goods receipts and the invoices received that belong to the same 
transaction. Each item of a good receipt document is assigned to the corresponding item 
of the invoice received document. 

Since internal financial statements can be created for the business area level, the 
cleared items are listed according to business area. 

 
Should the system output a blank log or a log that only lists open transactions, the 
GR/IR clearing accounts were previously cleared. 

In this case, you can create a new purchase order, the corresponding goods receipt 
and invoice receipt and restart the program for automatic clearing. The process 
Invoicing from Materials Management (MM) [Page 31] describes the procedure. 
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If you then start the program, you will determine that the goods receipt document has 
been cleared with the invoice receipt document. 

4. Choose  until the overview tree appears. 
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Compact Document Journal 
Use 
Once you have completed the closing postings, you have a selection of reports for documenting 
the documents created during the period. In this section, you run the compact document journal. 

The compact document journal provides you with a complete list of all FI documents of the period 
selected. For completeness, we recommend you include the parked documents as well, since 
parked documents obtain their final document number when they are parked and their exclusion 
would mean that these numbers would be missing from the document journal if not included. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Periodic 
Processing → Closing → Report → General ledger reports → Document → 
General → Compact document journal → Compact document journal 

Transaction Code SART 

2. In the Compact Document Journal screen, enter the following data: 

Field Data 

Company code 1000 

Fiscal year Current fiscal year 

Posting date From the first day to the last day of the current period 

Standard documents Select 

Parked documents Select 

3. Choose . 

The compact document journal contains the G/L documents including parked 
documents. 

First, the documents that were created in Financial Accounting are listed. In the second 
section, the documents from logistical processes are displayed such as good receipt / 
deliveries (document type WL), goods issue (WA), or good receipt (WE). 

 
One month is the recommended period for the compact document journal. If you run 
the program for a different month, replace the default value with the period you 
desire.  

4. Choose  until the overview tree appears. 
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Account Update: Compilation of G/L Account Postings 
Use 
An additional step is calling up the general ledger from the document file. This report documents 
the G/L account postings in the form of the general ledger. For every G/L account, all posting 
documents in a selected period are displayed as well as how the debit and credit balances were 
created. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Periodic 
Processing → Closing → Document → Balance audit trail → All accounts 
→ General ledger from the document file 

Transaction Code S_P99_41000327 

2. In the General Ledger from Document File screen, make the following entries: 

Field Data 

Company code 1000 

Fiscal year Current fiscal year 

Posting date Last day of current period 

 
So that the report is not to long, we set the time period to the last day of the period in 
which the closing postings for this scenario were created. 

To further limit your selection, you can make entries in the further selections section. 

To do so, choose Edit → Dynamic selections and in the General Ledger from the 
Document File screen, enter your user name in the User name field. Choose . You 
see that a selection criteria is active. 

3. Choose . 

You obtain an account sheet for the selected period in the form of a list. 

 
In a productive system, a different procedure is used for the monthly closing to form 
an account sheet that successively builds on itself over the entire fiscal year. In this 
case, a compilation of the data is made each month for the posting period that is 
closed (similar to the list in the example). The summarized information is not merely 
a monthly list but it combined with the data extracted in previous runs in the fiscal 
year. The result is a new statement that contains all the data of the current fiscal year 
up to the end of the last closed posting period. At the end of the fiscal year, the 
account sheet can be created by pushing a button. 

You can find more information about this in the program documentation. 
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4. Choose . 

5. On the Print Screen List screen, enter the following data: 

Field Data 

Output device The printer connected to your computer 

Print immediately Select 

Select 

New spool request Do not select 

Delete after output 

6. Choose Continue. 

The log is sent to your printer for printing. 

One page is printed out for every G/L account containing at least one transaction in the 
period selected. It contains a list of the documents created and an overview of the debit 
and credit balances with information about the balance carried forward and the new 
balance of the G/L account. 

7. Choose  until the overview tree appears. 
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Creating Business Reports 
Choose  [Page 359] for additional information on creating business reports. 

1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Information 
system → General ledger reports → Balance Sheet /Profit and Loss / Cash 
Flow → General → Actual/Actual comparisons → Balance sheet/Profit and 
Loss 

Transaction Code S_ALR_87012284 

2. Enter the following data in the Balance Sheet/P+L screen: 

Field Data 

Chart of accounts INT 

Company code 1000 

Further selections tab control  

INT 

Reporting year Current fiscal year 

Reporting periods From the first period to the current period 

Comparison year Last fiscal year 

Comparison period From the first period to the current period 

Output control tab page  

Company code summarization 1 

3 

1 

Scaling 0/0 

Special evaluations tab page  

Balance sheet type 1 

Key date for translation Last day of current period 

Exchange rate type for translation M 

Financial statement version 

Business area summarization 

Comparison type 

With this selection criteria, you create a balance sheet and profit and loss statement 
cumulated since the beginning of the year. The balances are totaled per G/L account and 
output using business areas. 

3. Choose . 

4. Choose . 

5. Enter the following data in the Print Screen List screen: 

Field Data 
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Output device The printer connected to your computer 

Print immediately Select 

Delete after output Select 

New spool request Do not select 

6. Choose Continue. 

The reports are sent to your printer for printing. 

7. Remain on this screen. 
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Sending Business Reports 
Use 
You want to send the report to your manager. You can do this using the SAP R/3 System. 

: 

You can use the process described here for any type of list and log that you want to 
send via e-mail. 

Procedure 
1. In the Balance Sheet/P+L screen, choose List → Save/Send → Office. 

In the Create Document and Send screen, enter the name of the person in the Recipient field. 

 
To simplify this step, we suggest you enter yourself as the recipient. You have to 
spell the name out (no search using *). 

2. Enter a short message in the text editor screen. 

You can attach this mail to a document In this manner, you can, for example, include an 
evaluation of the figures or additional information. 

3. On the attachments tab card, you see the type and description of the attachment. 

4. Choose . 

The Open dialog box appears.  

5. In this dialog box, you specify where the file to be attached is stored on your computer. 

6. Once you have found the file, choose is with a double click. 

It will take a few seconds for the system to import the file into your e-mail. 

7. In the Create Document and Send screen, choose . 

The e-mail is sent to you. 

8. Choose  until the overview tree appears. 
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Receiving Closing Reports 
Use 
In this activity, the recipient, in this case you, looks in his/her inbox and opens the e-mail 
received. 

 
This description is also valid for other messages and documents received in the SAP 
R/3 System. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Menu → Workplace → Inbox → Unviewed documents 

Transaction Code SBWP 

2. In the Business Workplace of XXXX (your name) screen, double-click on the mail Balance 
Sheet/P+L. 

The message, which contains various documents sent in the previous step, is displayed. 

3. Choose the Balance Sheet/P+L document using a double-click. 

The list is displayed. The structure is the same as it was when you sent it. 

4. Choose  until the overview tree appears. 
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 Additional Information on Exchange Rate Types 
Exchange rate types 1001 to 2014 are used in the consolidation examples. 
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Lowest Value Principle 
A valuation using the lowest value principle means that the valuation is only completed if the 
valuation difference between the local currency amount and the amount in another currency is 
negative, that is, a loss is realized. 
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Batch Input Session 
A batch input session is a group of transactions that obtain user data via a program.  

This transactions, which contain data, are saved as a stack in a batch input session. This session 
can then be run at a later time in the online system. Changes are made to the database when the 
session is ran. 

With this procedure, large amounts of data can be entered into the SAP System in a short period 
of time. 

 

 

 

April 2001  357 



Financial Accounting (FI)  SAP AG 

Additional Analysis Information 

 Additional Analysis Information 
The purpose of the analysis is to determine prior to the creation of financial statements, whether 
quantities were delivered but not yet billed (no vendor invoice) at the key date, or whether 
invoices were entered for goods not yet received. 

If invoices and/or deliveries exist, which cannot be assigned to each other, an adjustment posting 
has to be made. An SAP R/3 program makes the analysis. If the open items per order number 
and item do not balance to zero, the adjustment postings are made for these items in a batch 
input session. 
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 Additional Information on Creating Business 
Reports 
In this example, you create a balance sheet and profit and loss statement in a list form. This 
means that you cannot access additional analyses from these reports. 

In the G/L Account Information System - Germany [Page ], we explain how to create a 
drilldown report for the balance sheet and profit and loss statement. From these reports, you can 
access other reports as well as the line items. 

272
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 The Cash Journal 
Purpose 
The cash journal is used as a subsidiary ledger in Bank Accounting to manage cash transactions 
within the organization. It can be used independently of other posting transactions. The opening 
and closing balances, as well as the cash receipts and expenditures, are automatically recorded 
and displayed. Multiple cash journals can exist within each company code. 

You can find more information about this process under  [Page 373]. 

Prerequisites 
The cash journal, and the relevant business transactions, have been defined in Customizing for 
Bank Accounting. 

You can find the data for this process under  [Page 374]. 

Process Flow 
1. Posting the Customer Invoice [Page 36 ]1  

2. Entering the Cash Receipts [Page 363] 

3. Manually Clearing the Customer Accounts [Page 36 ]6  

4. Entering the Cash Expenditures [Page 367] 

5. Printing the Cash Journal [Page 370] 
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Posting the Customer Invoice 
Usage 
In this process step, you post an open item for either customer 1175 in Germany or customer 
3350 in North America. The customer is to pay the invoice in cash. You then enter the payment 
in the cash journal.  

 
You post the invoice directly in Financial Accounting, there is no integration with the Sales and 
Distribution application. This makes it easier to post backdated invoices. 

Prerequisites 
Tax code AN (16%) is automatically defaulted for company code 1000 and S1 for company code 
3000. We have also created a screen variant with a business area to be used as a work 
template. The ready-for-input columns are the G/L account, the posting key, the amount, the 
amount currency, and the business area. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Document 
Entry → Invoice 

 

Transaction FB70 

 
If the Set Company Code dialog box appears, enter 1000 (Germany) or 3000 (North 
America) then choose . 

2. If the structure tree has not been activated, choose  Tree on, then double-click on the 
screen variant With business area. 

3. On the Basic Data tab, enter the following data: 

Field Europe North America 

Customer 1000 3350 

Invoice date Today’s date Today’s date 

Posting date Today’s date Today’s date 

Amount 1,000 (gross amount, including 
sales tax) 

1,000 (gross amount, including 
sales tax) 

Currency key DEM USD 

Calculate tax Select Select 
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Tax code (defaulted) AN S1 

G/L account 800200 800200 

D/C Credit Credit 

Document currency amount 1,000 1,000 

Business area 1000 1000 

 
4. To simplify this process, we have not defined a cost element for account 800200, which 

means that you do not need to assign a CO object, for example, an order number. The 
system does not, therefore, transfer the data to Profit Center Accounting. 

5. Choose . 

 
The system displays the address of the customer. If you wanted to display the open 
items for this customer or the bank details, you could choose  OIs or  Bank 
Details. 

6. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items.  

7. Choose . 

Make a note of the document number, as you will need this to clear the customer 
account. 

8. Choose  until the overview tree appears. 
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 Entering the Cash Receipts 
Usage 
In this process step, the customer pays the invoice in cash. The amount is posted directly to the 
cash journal. You also enter a cash transfer from the bank. The cash journal entries are only 
posted to the general ledger when you have posted the saved amounts. 

Prerequisites 
We have defined bank clearing account 113130 for the cash transfer from the bank.  

Procedure 
9. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Document Entry 
→ Cash Journal Posting 

Transaction FBCJ 

The Cash Journal screen appears. 

10. Choose  Change cash journal. Enter either company code 1000 with cash journal 0001 for 
Germany, or company code 3000 with cash journal 0003 for North America. 

11. Enter the following data: 

Field Europe North America 

Data Selection   

Display period Today Today 

Cash journal (defaulted) Petty cash (cash journal) Petty cash (cash journal) 

Company code IDES AG IDES US INC 

Balance display for display period   

Opening balance (defaulted) 1000 1000 

 
The opening balance can vary, if cash receipts or cash payments have already 
occurred. If no opening balance is displayed, change the display period to This week 
or Current period. 

12. Choose the Receipts tab page, then enter the following data: 

 

After each business transaction, choose . 

Field Europe North America 
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1st Business transaction (use the 
F4 input help) 

Payment from customer Payment from customer 

1000 1000 

Customer 1000 3350 

Recpt Recipient Customer name Customer name 

Text Any text Any text 

2. Business transaction (use the 
F4 input help) 

Cash transfer from the bank Cash transfer from the bank 

Amount for example, 5000 for example, 5000 

Text Any text Any text 

Amount 

13. Choose . 

The journal status displays a red traffic light, which means that the cash journal entry has 
only been entered in the system.  

14. Choose  Save. 

The cash journal entries have now been saved locally and the balances recorded. The 
system automatically assigns document numbers to the business transactions. 

 
If required, you could still delete the saved entries if the corresponding receipt has 
not yet been printed. If you wanted to do this, you would select your business 
transaction, then choose . 

15. Select the business transaction Payment from customer, then choose  Print cash journal. 

You see the print preview of the acknowledgement of receipt. 

16. Choose . 

 
The cash journal entries have still not been updated to the general ledger. This 
means that no FI follow-on documents exist yet. 

17. Choose  Post. 

 
In the Document status column you can see the status of the cash journal entry: red 
(entries have been entered), yellow (entries have been saved), green (entries have 
been saved and posted to the general ledger). 

18. Select one of the business transactions, then choose FI follow-on docs. 

19. In the List of Documents in Accounting dialog box, choose Accounting document. 

The document overview appears.  

20. Choose  until the overview tree appears. 
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Result 
You have entered the cash receipts in the cash journal, and entered the postings to the G/L and 
customer accounts. In the balance display for the display period, you can see the number of 
receipts. The total receipts has been increased by the posted amounts.  
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 Manually Clearing the Customer Accounts 
Usage 
In this process step, you clear the customer account because the customer has paid in cash. 

Procedure 
21. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable → Account → 
Clear 

Transaction F-32 

The Clear Customer: Header Data screen appears. 

22. Enter the following data: 

Field Europe North America 

Account 1000 3350 

Company code 1000 3000 

Clearing date Today’s date Today’s date 

Currency DEM USD 

Open item selection   

Normal OI Select Select 

Additional selections   

Document number Select Select 

23. Choose . 

24. On the Clear Customer: Enter Selection Criteria screen, enter your document number. 

25. Choose Process open items. 

26. Position your cursor on the gross amount, then choose  Items (Deactivate Items). 

27. The amounts have now been assigned. 

28. Choose . 

29. Choose  until the overview tree appears. 

Result 
The customer account has now been cleared. 
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 Entering the Cash Payments 
Usage 
You now make a cash purchase of office materials, and transfer some of the cash to the bank. 
The cash journal entries are only posted to the general ledger when you have posted the saved 
amounts. 

Accounting → Financial Accounting → General Ledger → Document Entry 
→ Cash Journal Posting 

Prerequisites 
For the cash purchase we use account 476000, which requires a cost accounting assignment, 
and for the cash transfer to the bank, we use the bank clearing account 113131. 

Procedure 
30. Call up the transaction as follows: 

Menu Path 

Transaction FBCJ 

The Cash Journal screen appears. 

31. Choose  Change cash journal. Enter either company code 1000 with cash journal 0001 for 
Germany, or company code 3000 with cash journal 0003 for North America. 

32. Enter the following data: 

Field Europe North America 

Data Selection   

Display period Today Today 

Cash journal (defaulted) Petty cash (cash journal) Petty cash (cash journal) 

Company code IDES AG IDES US INC 

 
The opening balance can vary, if cash receipts or cash payments have already 
occurred. If no opening balance is displayed, change the display period to This week 
or Current period. 

33. Choose the Payments tab page, then enter the following data: 

 

After each business transaction, choose . 

Field Europe North America 

1st Business transaction (use 
the F4 input help) 

Cash purchase of office 
materials 

Cash purchase of office 
materials 
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Amount 1000 1000 

Recpt Recipient IDES AG IDES US INC 

Text Any text Any text 

Cost center 1000 1000 

2nd Business transaction (use 
the F4 input help) 

Cash transfer to the bank Cash transfer to the bank 

Amount for example, 2,000 for example, 2,000 

Text Any text Any text 

34. Select the business transaction Cash purchase of office materials, then choose  to copy 
the business transaction. 

35. Choose . 

36. Choose Save. 

The cash journal entries have now been saved locally and the balances recorded. The 
system automatically assigns document numbers to the business transactions. 

 
You can still delete the saved entries if the corresponding receipt has not yet been 
printed. If you wanted to do this, you would select your business transaction, then 
choose . 

37. Select the business transaction Cash Purchase of Office Materials, then choose  Print 
receipt. 

You see the print preview of the acknowledgement of receipt. 

38. Choose . 

 
The cash journal entries have still not been updated to the general ledger. This 
means that no FI follow-on documents exist yet. 

39. Choose  Post. 

 
In the Document status column you can see the status of the cash journal entry: red 
(entries have been entered), yellow (entries have been saved), green (entries have 
been saved and posted to the general ledger). 

40. Select the business transaction Cash Purchase of Office Materials, then choose FI follow-on 
documents. 

41. In the List of Documents in Accounting dialog box, choose Accounting document. 

The document overview appears.  

42. Choose . 
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43. Remain on the Cash Journal screen. 

Result 
You have entered the cash payments in the cash journal, and entered the postings to the G/L 
and customer accounts. In the balance display for the display period, you can see the number of 
receipts. The total payments has been increased by the posted amounts.  
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 Printing the Cash Journal 
Usage 
You now print all of the cash journal entries for the selected period.  

Prerequisites 
In Customizing, we have stored printing program RFCASH00 for the cash journal. 

Procedure 
44. Choose Print cash journal. 

On the Cash Journal screen, you can see your posted incoming and outgoing payments. 

45. Choose . 

46. Enter the following data: 

Field Data 

Output device Your printer 

Spool control  

Print immediately Select 

Delete after print Select 

47. Choose Continue. 

The system informs you that your spool request has been sent to the printer. 

48. Call up the transaction as follows: 

Menu Path System → Services → Output Controller. 

Transaction SP01 

The Output Controller: Spool Request Selection Screen appears. 

49. On the Spool Requests tab page, enter the following data: 

Field Data 

Created by Your name 

Date created Today’s date 

50. Choose . 

On the Output Controller: Overview of Spool Requests screen, you see the status of your 
request. 

51. Select your spool request, then choose . 

52. Choose  until the request has been processed completely. 

53. Choose  until the overview tree appears. 
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 Additional Process Information 
For company code 1000 we have maintained cash journal 0001 with G/L number 100010, and for 
company code 3000 cash journal 0003 with G/L number 100030. 

The following business transactions are possible: 

• Cash transfer from the bank 

• Cash transfer to the bank 

• Cash purchase of office materials 

• Cash purchase 

• Payment to vendor 

• Payment from customer 

The cash transfer from the bank or to the bank occurs via bank clearing account 113130/ 
113131. The bank clearing accounts are cleared later using the account statements. 

For the cash purchase of office materials we post to account 476000, for the cash sale we post to 
account 800000. 

You can print the cash journal. For this purpose, we have set the following print parameters: 

• Print program RFCASH00 

• Report variant CASHDE with the entries FI_CASH_BB (beginning balance), FI_CASH_EB 
(closing balance), FI_CASH_CF (Carry forward), FI_CASH_SI (signature). 
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 Data Used During This Process 
Field Europe North America 

Company code 1000 (IDES AG) 3000 (IDES US INC) 

Customer 1000 3350 

G/L account 800200 (revenue account) 800200 (revenue account) 
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Special Ledger (FI-SL) 
Settings for Cost-of-Sales Reporting [Page 376] 
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 Settings for Cost-of-Sales Reporting 
Purpose 
In this process, you learn how to create profit and loss statements using the cost-of-sales method 
in the Special Purpose Ledger. You were also learn about how data is posted and what 
prerequisites have to be met for reporting. 

If you want to see comprehensive examples of the effects that postings from production, Sales 
and Distribution, Financial Accounting (FI) and Controlling (CO) have on your profit and loss 
statement, see the processes Examples of Postings for Cost of Sales Accounting. These 
processes include examples of postings from series production and Sales and Distribution as 
well as examples from other FI components and Controlling: 

• Posting example for cost-of-sales accounting: repetitive manufacturing 

• Posting example for cost-of-sales accounting: Sales order processing 

• Posting example for cost-of-sales accounting: FI/CO 

You can find more information about this process under  [Page 377]. 

Process Flow 
You can find the data for this process under  [Page 378]. 

Defining Functional Areas [Page 379] 1. 

Defining Substitution Rules [Page 380] 2. 

3. Defining Profit and Loss Statements [Page 384] 

Posting to Functional Areas [Page 385] 4. 

5. Creating Profit and Loss Statements in FI-SL [Page 387] 

6. Drilling Down to Functional Areas from the Profit and Loss Statement [Page 388] 
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 Additional Process Information 
With cost of sales accounting, the expenses for completed goods or services provided and 
subtracted from the sales revenue in order to determine the gross profit. From this total, the 
expenses that cannot be directly assigned to the revenue are posted to the functional area, such 
as sales and marketing, administration, or research and development. 

This profit and loss statement, which is typical in North America, the indirect expenses and 
grouped and arranged based on functions. It is not important whether the expenses are for 
external or internal purposes. In the following example, the items in bold are classified as the 
functional areas of the IDES System. 

• Gross revenue 

• Sales deductions 

• Net sales revenue 

• Direct costs 

• Production variances 

• Over/under production 

• Total CoGS 

• Gross profit 

• Sales and marketing costs 

• Administrative expenses 

• Research and development 

• Total other expenses 

• Net pre-tax profit 
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 Data Used During This Process 
Field Europe North America 

Company code 1000 3000 

Period Current period Current period 

Fiscal year Current year Current year 

Cost element 474100 474100 

Document type KR KR 

Vendor 1000 3000 

Functional area 0100 0100 

Functional area 0300 0300 

Functional area 0400 0400 

Functional area 0500 0500 

Substitution rule ID-COGS NA-COGS 

Ledger 0F 0F 

Report Writer Library 0F1 0F1 

Report Writer Library 0F-GUV1 0F-GUV1 
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 Defining Functional Areas 
Use 
The functional area field appears in the documents of the applications FI, CO, Profit Center 
Accounting (PCA), and Special Purpose Ledger (SL). Combined with the G/L account, the 
functional area determines the position of the value in the profit and loss statement. Functional 
areas allow you to create financial statements to meet US GAAP requirements. 

In the R/3 System, the G/L account totals records do not contain cost center or other cost 
element information. Totals records are kept per account (such as salaries). The salaries can 
appear in the cost of goods sold as labor or for example as sales and marketing expenses. As 
additional identification at the line item level, the functional area specifies the position to which 
the salary expenses are posted in the profit and loss statement. 

If you post a document, you can enter the functional area in addition to the cost element. The 
IDES System, however, is set up so that the functional area is entered automatically using 
substitutions. These substitutions are defined in substitution rules [Page 380]. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit Project 

Transaction Code SPRO 

2. Choose  SAP Reference IMG. 

3. Choose Enterprise Structure → Definition → Financial Accounting → Define Functional 
Area. 

In the Change View "Functional Areas": Overview screen, the following functional areas, 
as well as others, have been set up. 

Description Functional area Europe/ North America 

Manufacturing 0100 

Sales and Marketing 0300 

Administration 0400 

Research & Development 0500 

4. Choose  until the overview tree appears. 
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 Defining Substitution Rules 
Use 
When you post a document, you do not have to enter the functional area. The system can 
determined the functional area using substitution rules. If you post the salary of a market 
researcher, this expense will appear under sales costs in the profit and loss statement. The 
reason for this is the configuration of a substitution rule that reads the cost element category and 
derived the functional area for this information. 

Two substitution rules are defined in the IDES System: ID-COGS (for Europe) and NA-COGS (for  
North America). 

The deriving of the functional area can be dependent on various parameters such as cost 
element category, order type, or project number. 

You can find additional information about substitutions in the Substitutions process. 

Procedure 
5. Call up the transaction as follows: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit Project 

Transaction Code SPRO 

6. Choose  SAP Reference IMG. 

7. Choose Financial Accounting → Financial Accounting → Company Code → Cost of Sales 
Accounting → Set Up Substitution for Cost of Sales Accounting → Activate Substitution. 

The following substitutions are displayed: ID-COGS is assigned to company code 1000 
(Europe) and NA-COGS to company code 3000 (North America). Both substitutions are 
active. This means that every accounting document that results from a business 
transaction is automatically read. The substitution rule assigned to the company code is 
then used to derive the functional area. 

8. In the Change View "Substitution in Accounting Documents": Overview screen, select the 
following substitution with a double-click. 

Field Europe North America 

Substitution ID-COGS NA-COGS 

9. In the Information dialog box, choose . 

The Change Substitution: ID-COGS or NA-COGS (Header data) screen appears. You 
see information about the application area of the substitution (FI) and the callup point 
when the substitution is executed (cost of sales accounting). 

10. Open the ID-COGS structure. 

The system displays the steps of the substitution. 
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Currently, the steps 01, 02, 03 and 04 are completely configured for substitution rule 
ID-COGS. Other steps are included for reserves and clearing accounts. 

11. Select the first substitution step (001). 

The system displays an overview of the substitution prerequisites. 

If you post a document, the system checks whether the prerequisites of the first step are 
met. If they are met, the functional area is derived. If the prerequisite is not met, the 
system reads the next substitution step. 

12. Call up the following steps in order. 

The substitution prerequisites for the European data of the IDES system appear as 
follows: 

Step Description Prerequisite (Boolean statement) 

001 Functional area 0100 Manufacturing Functional area 0100 is derived if the 
following is true: 

• Cost center element 1 
(manufacturing) or 2 (manufacturing 
services), the order number is statistical or 
not specified 

• The internal order is a 
manufacturing order. 

• The document is posted to account 
893000 (WIP) or 239000 (WIP unrealized 
costs) 

• The expense is posted directly to a 
cost element or customer order (profitability 
segment) 

002 Functional area 0300 Sales and Marketing Functional area 0300 is derived if the 
following is true: 

• Cost center category is 3 (Sales), 
the order number is statistical or not 
specified. 

• The internal order is an internal 
order for sales 

003 Functional area 0400 Administration Functional area 0400 is derived if the 
following is true: 

• Cost center element 4 
(administration) or 5 (management), the 
order number is statistical or not specified 

• The internal order is an internal 
order for administration or management 

April 2001  381 



Financial Accounting (FI)  SAP AG 

Defining Substitution Rules 

004 Functional area 0500 Research & 
Development 

Functional area 0500 is derived if the 
following is true: 

• Cost center category is 6 (research 
and development), the order number is 
statistical or not specified. 

• The internal order is an internal 
order for research and development 

005 Functional area 0600 reserves (only for 
Germany) 

Functional area 0600 is derived if the 
following is true: 

The document is posted to an account 
contained in the interval 480000 to 489999 

The following is an overview of the substitutions as defined for the North American data 
in the IDES System. 

Step Description Prerequisite (Boolean statement) 

006 Functional area 0100: Manufacturing The G/L account is either 893000 or 
239000 

007 Functional area 0100: Manufacturing The manufacturing category is 04, 05, 06, 
10, 20, 30, 40, or 50 

008 Functional area 0100: Manufacturing Order type is 0200, 0300, 0801, 0850, or 
0870 

009 Functional area 0100: Manufacturing The cost center category is 01 or 02 and 
the order field is empty or contains a 
statistical order 

010 Functional area 0100: Manufacturing The cost element field contains an entry 

011 Functional area 0100: Manufacturing The customer order field contains an entry 

003 Functional area 0300: Sales and 
Marketing 

The order type is 0400 or 0451 

005 Functional area 0300: Sales and 
Marketing 

The cost center category is 03 and the 
order field is empty or contains a statistical 
order 

002 Functional area 0400 Administration The cost center category is 04 or 05 and 
the order field is empty or contains a 
statistical order 

013 Functional area 0400 Administration Order type is 9A00 

001 Functional area 0500: Research & 
Development 

The cost center category is 06 and the 
order field is empty or contains a statistical 
order 

004 Functional area 0500: Research & 
Development 

The order type is 0101 or 0151 
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012 Various functional areas are derived from 
WBS elements 

This step uses user exit U901 in ABAP 
program ZGGBS800 to determine which 
functional area is derived from the WBS 
elements 

13. Choose  until the overview tree appears. 

 

 

April 2001  383 



Financial Accounting (FI)  SAP AG 

Defining the Profit and Loss Statement 

 Defining the Profit and Loss Statement 
Use 
In this process, you learn about the report definitions and characteristics that are used for the 
individual items of the profit and loss statement. If you select the report using the European data, 
you do not have authorization to change the report definition, since this is a standard SAP report 
that begins with a zero (0). Since the North American report is simply an IDES copy of the SAP 
report, it can be changed. 

You can not make any changes to the North American report, so that the process and related 
process function properly. If you want to use the report for other purposes, create a new report by 
copying one of the aforementioned reports. 

Menu Path 

Procedure 
1. Call up the transaction as follows: 

Accounting → Financial Accounting → Special Purpose Ledger → Tools 
→ Report Painter → Report → Display 

GRR3 Transaction Code 

2. On the Report Painter: Display Report screen, enter the following data. 

Field Europe North America 

Library 0F1 0F1 

Report 0F-GUV1 0F-GUV1 

3. Choose  Display. 

The report structure is displayed. 

4. Double click on the sales costs to display the amounts contained in this line. 

In the Element Definition: Sales Costs dialog box, you see that the item has an entry of 
functional area and account number. 

5. Choose Extras → Overview. 

The system displays the selected characteristics for each report item in the Formula 
Overview screen. You see the accounts that have been selected. 

 
In your report, the defined sales revenue is directly transferred to the P&L and not by 
revenue type. Revenues are not assigned to functional areas. 

6. Choose  until the overview tree appears. 
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 Posting to Functional Areas 
Use 
In this process, you enter a vendor invoice using an Enjoy transaction. The posting is made in 
one screen. 

The expense is charged to cost center 1000, which is assigned to cost center category 4 for 
administrative costs. The substitution rule reads the cost element category and automatically 
inserts functional area 0400 (Administration) as the default value for your document. 

This is a simple example that shows how a substitution can determine the functional area when 
posting a document. If you need the process-oriented examples for cost of sales accounting in 
which the functional area is not explained, see the processes listed in the introduction. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Document Entry → 
Invoice 

Transaction FB60 

The Vendor Invoice Enter screen appears. 

2. Choose Environment → Set Company Code. In the dialog box, enter company code 1000 for 
Europe and 3000 for the North American example. Choose . 

3. Choose  Work templates and select the creation variant with cost center. 

4. On the Basic Data tab page, enter the following data: 

Field Europe North America 

Vendor 1000 3000 

Invoice date Today‘s date Today‘s date 

Posting date Today‘s date Today‘s date 

Amount 100 100 

Currency/rate (defaulted) DEM USD 

Calculate tax X X 

Tax code (defaulted) R1 I0 

G/L account 474100 474100 

D/C (defaulted) Debit Debit 

Amount 100 100 

Tax code R1 I0 

Cost center 1000 1000 
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Account 474100 requires an assignment to a CO object, as it is defined as a cost 
element. Therefore you require an additional account assignment, in this case cost 
center 1000. 

5. Choose . 

The system displays the address of the vendor. You can also view the open items and 
bank details of the vendor. 

6. Choose  Simulate. 

On the Document Overview screen, you can see your posting with the document items. 

7. Choose . 

8. Choose  until the overview tree appears. 
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 Creating Profit and Loss Statements in FI-SL 
Use 
In this process, you create a profit and loss statement for your independent organization. This 
report uses functional areas to enable cost of sales accounting. 

Procedure 
1. Call up the transaction as follows: 

Menu Path IDES → IDES Reports → Financial Accounting → IDES Cost of Sales 
P&L 

Transaction Code Y_ID3_68000031 

2. In this screen, make the following entries: 

Field Europe North America 

Period from  001 001 

012 012 

Fiscal year Current year Current year 

Company code 1000 3000 

Ledger 0F 0F 

Version 001 001 

Period to 

3. Choose . 

The system output a profit and loss statement in summarized form. 

4. Choose View → Row hierarchy → Expand all, to drilldown to the cost element level. 

5. Remain on this screen. 

 
You can scroll through the individual cost elements. To see the report in 
compromised form again, choose View → Row hierarchy → Collapse all. 

6. To check the role of the functional area when creating this report, proceed with the next step. 
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 Drilling Down to Functional Areas from the P&L 
Statement 
Use 
In the report created in the process Creating a P&L Report in FI-SL, a document was obviously 
posted to a functional area. In this process, you drilldown in this report to the document level, in 
order to determine if the functional area was actually entered. You start in the screen in which the 
P&L statement is output in summarized form. 

Procedure 
1. In the IDES Cost of Sales P&L: Selection screen, select the line cost element 474100 Travel 

costs by double-clicking it. It is above the administrative costs. 

A dialog box appears. 

2. Select Period breakdown and choose . 

3. In the Period breakdown: Selection screen, choose the column Act. Lcurr. with a double-
click. 

In the Actual line items for table GLFUNCT screen (old, replace: RGUGLFUNCA), you 
see all items posted for this account. For each item, the functional area is also specified. 

4. To display the functional area in the FI-SL document, position your cursor on the line. 

5. Choose FI-SL document. 

In the Display FI-SL local actual documents screen, you see the document number in the 
reference field of the previously posted document. 

6. Choose  until you arrive at the Actual Line items for table GLFUNCT screen. 

7. To display the functional area in the FI original document, position your cursor on the item. 

8. Choose Document. 

9. In the Display document: Overview screen, choose the second line item (expand line) with a 
double click. 

10. In the Display Document: Item xxx screen, choose the More button. 

In the coding block dialog box, the field Funct.area has an entry. 

11. Choose . 

12. Choose  until the overview tree appears. 

13. In the Exit Report dialog box, choose Yes. 
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